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Welcome
Welcome to iView MediaPro, the fast and easy 
way to view, organize and present the growing 
number of images, movies, sounds, fonts and 
other media files on your disks.

MediaPro helps you get organized. Whether 
you are a student, journalist, multimedia enthu-
siast or professional photographer, it’s important 
to be able to organize and browse your images, 
movies and documents in an application that’s 
easy to set up and use.

MediaPro works by creating catalogs, consist-
ing of thumbnails and descriptions of all your 
media files. Store your images with digital cam-
era information, captions, labels and annotations  
—  then search and browse the catalog, even if 
your original files are misplaced or offline. 

You can edit images, correct colors, print con-
tact sheets and change file formats — even create 
a slide show of your favorite images and save it as 
a QuickTime movie.

Installation 
Windows: When you insert the iView MediaPro 

CD, an install menu appears. Choose Install iView 
MediaPro and follow the instructions. 

If this menu does not appear, your PC may not 
support autostart. In this case, open the CD and run 
install_iview_mediapro.exe. 

Mac: Insert the iView MediaPro CD. Double-click 
on the Install MediaPro 3 icon and follow the instruc-
tions. If you have an existing copy of MediaPro, 
remove it from your Applications folder and place it 
on removable media or a mounted volume before 
installing the new version. 

Entering your license key 
After you have installed iView MediaPro, launch 
the application. Go to the License menu and enter 
your name, organization and the license number 
from the inside back cover of the manual.  

If you purchased a digital download version 

Installing and setting up iView MediaPro
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Installation 

Step 1: Windows CD - This menu appears when you 
insert the iView MediaPro CD.  Choose Install iView 
MediaPro. If this menu does not appear your PC may not 
support autostart. In this case, open the CD and run the 
installer program named install_iview_mediapro.exe. This 
will create an application shortcut icon and a shortcut 
to the iView web site on the desktop.

Step �: If you did not enter your license during the 
installation wizard, then launch MediaPro and go to the 
License menu and select Enter License.

Step �: Enter the license number from the inside back 
cover of the manual, or the one that was emailed to you.

Step 1: Mac CD - Insert the iView MediaPro CD. 
Double-click on the Install MediaPro 3 icon. Follow the 
instructions.
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of iView MediaPro online, then enter the license 
number that was emailed to you. If you have lost 
your license key, please contact support at: 
http://www.iview-multimedia.com/support/

Plug-ins
The installation will create a Plug-ins folder con-
taining files that are important to the application’s 
functionality.  Knowing the location of this folder 
is important so that you can customize or install 
additional functionality, such as HTML templates, 
print templates, importers and scripts.

Windows: The user-defined Plug-ins folder is 
located in one of two locations:

• C:\Documents and Settings\username\Appli-
cation Data\iView\Plug-ins

• C:\Documents and Settings\All Users\Appli-
cation Data\iView\Plug-ins
On some Windows operating systems the 

Application Data folder may be hidden. 
To display hidden folders on Windows XP:

1. Click Start, and then click Control Panel.
2. Click Appearance and Themes, and then click 

Folder Options.
3. On the View tab, under Hidden files and folders, 

click Show hidden files and folders. 
Hidden files and folders will appear dimmed to 

indicate they are not typical items. If you know the 
name of a hidden file or folder, you can search for it. 

When installing custom HTML templates, print 
templates, favorites lists, scripts or importers, place 
them inside the user-defined plug-ins folder, and 
not the application plug-ins folder. This way, you 
will not lose your custom settings when upgrad-
ing to future versions of MediaPro.

Mac: In previous versions, there was a Plug-ins 
folder inside the MediaPro application folder. This 
folder has now been split between built-in plug-
ins, which are located inside the application pack-
age, and user-installed plug-ins, which go in any 
of the three locations

• ~User/Library/Application Support/iView/
Plug-ins

• /Library/Application Support/iView/Plug-ins

• Network/Library/Application Support/iView/
Plug-ins
When installing custom HTML templates, print 

templates, favorites lists, scripts or importers, place 
them inside the user-defined Plug-ins folder, and 
not the application package. This way, you will 
not lose your custom settings when upgrading 
to future versions of MediaPro.

System requirements 
This section lists the minimum system require-
ments, with the recommended ones in parenthe-
ses. It is important to have the most recent version 
of QuickTime. This will improve iView MediaPro’s 
performance and functionality.

Windows
• Pentium III 500 MHz processor or equivalent  
(Pentium 4)

• 128 MB of RAM (256 MB)
• 1024 x 768 display with 16-bit color
• 20 MB of hard disk space for installation  
(200 MB of free disk space ideal)

• Windows 2000 or XP (XP SP2)
• QuickTime 6.4 or higher
• Internet Explorer 5.5 (6.x)
• DirectX 9.0 for Windows Media format support
• Adobe Reader 7.0 for PDF file support

Macintosh
• PowerPC or newer, such as iMac G3, G4.
• Mac OS X (10.2.8)
• QuickTime 6.4 (7.x)
• Monitor set to Millions of Colors
• 13 MB of hard disk space for installation

Language support
MediaPro can be viewed in: English (US),  French, 
German, Italian and Japanese. By default, MediaPro 
uses the language of the operating system or 
remembers the last language used. 

See figures on the next page for information 
about how to change the language used by iView 
MediaPro.

In
stallation
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Web resources
You can access additional resources for learning 
iView MediaPro on the iView web site. Tutorials, 
customer support, forums and application updates 
are available online. To go to the web site: 

• Type this URL into your web browser: 
www.iview-multimedia.com

• Mac: Select the AppleScript menu, and 
choose iView Online from the Web submenu. 

Software updates
Windows: You can check for updates to iView 
MediaPro by selecting Check for Updates in the 
Help menu. If an update is available, a link will be 
provided for you to download it. Mac: Check for 
Updates is located in iView MediaPro application 
menu > About iView MediaPro dialog.

Adding media importers 
Any QuickTime-based media importer can be 
used by MediaPro: simply download and install 
the importer. Additional importers can be down-
loaded from 3rd-party sources on the Internet.

Example: To catalog PDF and EPS files on Mac 
OS 10.2.x, download and install the Ghostscript sys-
tem extension from iView’s download page at: 
http://www.iview-multimedia.com/downloads/
This extension is not required for 10.3 and higher. 

Scripting 
MediaPro is scriptable and can be easily integrated 
with 3rd-party applications or database systems to 
perform workflow automation. 

Windows: MediaPro supports Visual Basic Script 
and JavaScript automation on Windows. Once you 
create scripts, you can attach them to the appli-
cation for access through the Scripts menu. For 
instructions on creating scripts, refer to the script-
ing documentation included with iView (see Docu-
mentation folder).

Mac: MediaPro supports AppleScript, and the 
scripts are attachable to the application (acces-
sible via the AppleScript menu). To get started 
with scripting MediaPro, look at the application’s 

dictionary, and refer to the AppleScript examples 
included (see Documentation folder). Test your 
existing scripts to ensure proper functionality 
before using them.

Windows:  Choosing MediaPro’s language is the first 
step in the installation process on Windows. To changes 
languages, install MediaPro again, while selecting an 
alternate language from this drop-down menu.

In
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Mac OS X:  To change languages, select the MediaPro 
icon and choose Get Info from the File menu. Choose 
Languages in the drop-down menu. MediaPro will default 
to the operating system language. If you want MediaPro 
to run in a different language, uncheck all languages 
except the one you want. 



MediaPro Basics 7

How MediaPro works
MediaPro stores information about your media 
files in catalogs. A catalog is a searchable and 
organizable visual database that contains: 

• Information about each file relevant to the 
media type (attributes).

• Tags(also called annotations or metadata) 
that help you organize and classify media.

iView MediaPro basics

• A thumbnail of each media file.
• A full screen preview of each media file (if this 
option is turned on).

• The location (path) of the original file on a 
hard drive, CD-ROM, or other kind of volume.
You can create as many catalogs as you want, it 

just depends on how you want to organize your 
media. For example, you can have a catalog for 

M
ed

iaPro Basics

iView MediaPro Catalog

IMPORT

Camera Media Card

JPEG

• File properties
• EXIF digital camera annnotations
• IPTC/XMP annotations
• QuickTime annotations
• A voice (audio) annotation
• Custom (user-defined) annotations
• ICC color profile; color sample
• Color label; star rating 

METADATA

Each item will be assigned either:
• An embedded thumbnail created by 

a digital camera or software program
• A thumbnail created by MediaPro
• A generic media icon

THUMBNAIL PREVIEW 

If this option is turned on, MediaPro 
will create and store a large JPEG 
image that will be displayed in Media 
View when originals are not available.

FULL SCREEN PREVIEW

The location of the original file on a 
local or removable storage media.

PATH

Synchronize: For each file, the metadata information can be 
edited in the MediaPro catalog. To export these changes and 
write the information back into the file, use the Sync Annotations
command in the Action menu.

What’s inside each
iView MediaPro catalog

A catalog does not store the 
actual media files. When each 
media item is imported into a 
catalog, MediaPro extracts and 
stores information about the 
file (shown at right).
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Catalogs stored hierarchically by subject, date and 
project. The catalogs are stored in proximity to 
the media files.

0205_Job315_FordF150_Catalog.ivc
0205_Job316_MazdaMX5_Catalog.ivc

0205_Job314_ChevyTahoe_Catalog.ivc
0105_Job313_WSJ_CPowell_Catalog.ivc
0105_Job312_EW_JStewart_Catalog.ivc
0105_Job311_CBS_Fall_Catalog.ivc

0205_Feb_Catalog.ivc
0105_Jan_Catalog.ivc
•2005_Best_All_Portfolio.ivc

2005_Index_Catalogs

2005_Assignment_Catalogs

•2005_Master_Catalog.ivc
•2005_Best_Cars_Portfolio.ivc
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2005_Master_Catalog.ivc

2005_Best_All_Portfolio.ivc
2005_Best_Cars_Portfolio.ivc
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01_Jan_2005
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2005 Car Photography
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Job316_MazdaMX5_ToPrint.ivc

Job316_MazdaMX5_Raw.ivc

050205_Mazda_Job316_03.CR2
050205_Mazda_Job316_04.CR2

050205_Mazda_Job316_02.CR2

Date ProjectSubject
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Example A

Example B
File Type Process

Catalogs organized by file type and process in the 
workflow. Process catalogs work particularly well 
for workgroup workflow.

each media type: photos, videos and music. Or 
you could create one catalog of all media. Each 
catalog can contain up to 128,000 files.

Understanding catalogs
When you add files to a catalog, MediaPro stores 
a thumbnail of each file, as well as information 
about the file and its location on your disk. 

This way you can search and organize iView 
MediaPro catalogs, even when your original files 
are not present. For example, they may be stored 
on a CD-ROM that is not in the computer. But you 
can still view thumbnails of those files and infor-
mation about the media in the catalog. 

Because media files are not embedded in the 
catalog, iView MediaPro will need access to media 
files in order to display them in larger sizes, such 
as Media View, Lightbox mode and Slide Shows.

If you delete a media file on the desktop or a 
disk, it cannot be recovered through a MediaPro 
catalog. A catalog only contains information 
about the file, not the file itself.

Adding files to an iView MediaPro catalog does 
not move or modify the original media.

MediaPro � Catalog Icon 
on the Desktop

Cataloging strategies
A common question in digital asset management 
is: “Should I put all my media into one big catalog; 
or into several smaller catalogs?”

The number of catalogs that you create will 
vary depending upon your workflow and the 
types of media being tracked in catalogs.

iView MediaPro catalogs are designed to con-
tain up to 128,000 media items. It is possible that 
a single catalog will be sufficient for your needs. 
That being said, grouping files into separate cata-
logs creates a higher level of organization, and can 
help you have a higher degree of success quickly 
finding the appropriate media.

There are many strategies for grouping items in 
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catalogs, but anything that is logical and fits well 
into your specific workflow needs is acceptable.  
Here are some ways to organize your catalogs:

By Project: In Example A (previous page), each 
assignment has a dedicated catalog. This will facil-
itate easily working with files dedicated to a client 
or project. It also is good method for supporting 
short-term deadlines and goals.

Chronology: Creating an additional set of 
date-based catalogs is a good monthly habit. It 
will help you build a searchable archive as you go, 
instead of doing it all at once. 

Annual and monthly chronological catalogs 
are simple to create using MediaPro’s Import Items 
From Catalog File function (File menu). Simply cre-
ate a catalog for a particular time frame (month) 
and import each job or project catalog from that 
time frame. This ensures that all annotations, 
groups, sets and user-defined fields are imported 
into the new date catalog. 

By Subject: Any logical subjects that aren’t 
likely to overlap are a good way to divide your 
media into multiple catalogs.

For example, you may store your images by 
high-level subjects that describe the types of your 
photo assignments: travel, fashion, portraits, etc.

Alternatively, each time you create a catalog, 
you might mark files that you think should be-
long in a “Best Of” collection. Creating a catalog 
dedicated to building a portfolio or best media 
of the year is a good practice as well.

By Process/Task: Sometimes there are clearly 
definable states for files in a workflow. Separating 
items by their state or task in your workflow can 
help direct users to the media item at the correct 
stage in the workflow. 

For example, if photographers want to track 
files through a raw workflow, they might create 
catalogs for the original raw files, client selections, 
processed TIFFs, color corrected images and those 
that have been touched up (see Example B on pre-
vious page).

By File Type: You may wish to group files into 
catalogs based on file type, such a music, movies, 

Project catalogs are named chronologically 
to maintain proper order on the desktop and 
are stored in a single folder for cross-catalog 
searchability.
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2005 Car Photography
•Car_Photo_Portfolio.ivc

•2005_Stock_Media.ivc
•PDF_Car_Photo_Research.ivc

0205_Job316_MazdaMX5

0205_Job316_MazdaMX5

0205_Job315_FordF150

0205_Job314_ChevyTahoe

050205_Mazda_Job316_01.CR2

Job316_MazdaMX5_ToStock.ivc

Job316_MazdaMX5_Tiff.ivc
Job316_MazdaMX5_ToPrint.ivc

Job316_MazdaMX5_Raw.ivc

050205_Mazda_Job316_03.CR2
050205_Mazda_Job316_04.CR2

050205_Mazda_Job316_02.CR2

Search this catalog or 
this folder of catalogs

Example C

fonts, illustrations or PDFs.
For example, you may want to create a catalog 

of all your fonts, creating a searchable inventory 
of typefaces available for your design projects.

Searchability: MediaPro has a special search 
criteria that enables searching across all catalogs 
in a particular folder (Find menu).

Thus, if you store all your job catalogs in a de-
fined folder (see Example C above), files will be easy 
to locate. Higher level chronological catalogs will 
also be good for locating media files.
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Getting started
The first time you launch iView MediaPro, a Getting 
Started dialog appears to help you get acquaint-
ed with MediaPro features and to assist you with 
import options for creating new catalogs. 

Let iView MediaPro create your first catalog for 
you, by checking one of the three options: Import 
from a folder you choose, Import Pictures/Movies 
folders (see page 13), Import iPhoto library (see 
page 14).

If you want to access this dialog later, it can be 
found in the Help menu on Windows, and in the 
MediaPro application menu on the Mac.

Creating catalogs
There are several ways to import or add media to 
a MediaPro catalog. These methods are explained 
on the following pages. One basic method is to 
create a catalog from a folder you choose.

1. Launch application: Double-click the iView 
MediaPro icon to start the application. An 
empty catalog will appear.

�. Add media files: In the File menu, select 
Import Items from Files and Folders. This will 
bring up a dialog box where you navigate to 
and choose a folder or file to import into your 

catalog. This can also be done by checking 
Import from a folder you choose in the Getting 
Started dialog. 

�. Progress indicator: While your media is 
being imported, MediaPro will temporarily 
display a progress indicator panel. Depend-
ing on the import type, you may see several 
progress bars. To stop an import, click on the 
Cancel icon next to the progress bar (see figure 
above). To hide or show the progress indicator 
panel, click this icon   located in the lower 
right corner of the catalog window. 

4. View and organize your media.
�. Save catalog.

Before importing media
There are a few options that you may wish to set 
before creating your catalog. These options help 
you save time and improve the quality and ac-
curacy of your imports.  

Define Thumbnail creation options
On import, each media item is assigned a thumb-
nail image. This image visually represents the 
media item and is stored in the catalog. Depend-
ing on your preferences and the media type, 
MediaPro will assign each media item either: 

• An embedded thumbnail created by a 
digital camera or software program. Some 
applications, such as Photoshop, embed a 
thumbnail into the media file. Digital cameras 
do this as well. These thumbnails are typically 
low quality. During import, MediaPro extracts 
and assigns that embedded thumbnail if the 
Use built-in thumbnails box is checked (see 
Edit menu > Preferences > Media Rendering > 
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Getting Started: Check one of these options to let 
iView MediaPro create your first catalog for you.

Click this icon to show/hide the progress indicator panel.

Click the Cancel icon to stop an import at any time.
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�. Click the OK button. Import your media items 
and save your catalog.
Please be aware that the file size of catalogs 

with Full Screen Previews will be considerably 
larger than catalogs with only thumbnails. 

Filter imports by media type
Import options control what media files are added 
to a catalog. Most import options are conditional 
to the type of import (From Folders, Camera, etc.)

However, there is a global option to limit import-
ing just those files that belong to a certain media 
type. To define a media type filter, select Catalog 
Importers in the File menu. Check the box for each 
media group you want to allow MediaPro to import 
into future catalogs.

For example, when Importing from Files/Folders, 
you might turn on only the Images option in order 
to import images such as JPEG, TIFFs, etc. and skip 
all other files in the same folder.

If you are not familiar with what types of media 
files belong to each group, you can check the box 
for a particular media group to see a comprehen-
sive list of all media types supported. 

Supported file formats
You can catalog more than 100  media file formats. 
MediaPro’s capacity to import certain file types is 
dependent on having the most current version 
of Apple’s QuickTime installed on your computer. 

Images). On a Mac, this preference is found in 
the MediaPro application menu.

• A thumbnail created by MediaPro:  Turning 
Use built-in thumbnails option off will instruct 
MediaPro to create its own thumbnails, which 
are generally higher in quality, at the cost of a 
slower import process. For the highest quality 
thumbnails, iView recommends this option.

• A generic media icon: Non-image based files, 
such as audio files, will have a generic media 
icon assigned as a thumbnail.

A note on thumbnail size
In previous versions of MediaPro, if you had in-
structed MediaPro to create thumbnails, you also 
needed to define the thumbnail size prior to im-
porting items. 

As of version 3, MediaPro now automatically 
creates 320x320 pixel thumbnails regardless 
of the size determined by your View Options. 
Larger size thumbnails cannot be created. How-
ever, at any time, you can dynamically increase 
or decrease the size of thumbnails (between the 
range of 120 px and 320 px) in Thumbnail View 
using the +/- buttons in the Header bar. 

Full Screen Previews
You can now choose to have MediaPro create Full 
Screen Previews to be stored with your catalogs. 
Full Screen Previews are large JPEG proxy images 
that will be displayed in Media View when original 
media files are not available for display. 

Full Screen Previews are particularly useful if the 
majority of your media is stored on offline storage 
volumes, such as CD or DVD.  These previews are 
also useful for distributing catalogs without hav-
ing to include the original media files. 

To create a catalog with Full Screen Previews:
1. Create a new catalog.
�. In the Edit menu, select Full Screen Previews.
�. Choose the size of previews to be created.
4. Choose the JPEG compression quality to be 

applied to the preview images.
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Catalog Importers: Use to filter media types on import. 
Press the Set as Default button to set the media types 
filter for future catalog imports.
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Import items from Files/Folders
1. Open your catalog  or create a new one. 
�. Choose a file or folder: Select Import Items 

from Files/Folders in the File menu. Navigate 
to and select a file, group of files or a folder of 
media to import into your catalog. Files and 
folders can be located anywhere: on your hard 
drive, media cards, removable storage media 
or a local area network hard drive.

�. Define Import Criteria:  These filters limit the 
range of imported media based on file-related 
criteria, such as filename, file size, or the date 
last used. For example, to only import files 
smaller than 1 MB, choose to enable the Size 
option as:  “Size is less than 1 MB.” Checking 
the Flat folder search option will constrain 
folder imports to only the folder level selected 
and ignore all sub-folders.

4. Import: Click the Choose button and 
MediaPro will import all files and folders se-
lected.

QuickTime can be downloaded for free online at:
http://www.apple.com/quicktime/

There are variations of file format support be-
tween the Windows and Mac platforms. For a com-
plete list of supported formats, see page 137.

Cataloging unsupported formats 
MediaPro allows you to add basic cataloging 
support for other media file types by modifying 
the Custom importer list. Thumbnail and media 
rendering of these files is not supported. Instead, 
these files will be represented by a generic icon 
corresponding to the file type group.

Video DTP Image

To add a file type to the Custom importer list
1. Locate the user-defined Plug-ins > Importers 

folder. Open the Custom file with a text editor.
�. Add your own types at the bottom of the file. 

For example, to add FileMaker files, type 
FMP3|6|FileMaker Pro 
The first four characters are the file type. The 
next is the Media ID, which are listed at the 
top of the list. If you choose the wrong ID, 
MediaPro will not catalog the file. The remain-
ing segment is the name of the program.  You 
must follow the exact format in order for the 
new file importer to work properly.

�. Save the text file and launch MediaPro.

Finding file types
On Windows, the file type is always the same as 
the file extension, with spaces appended to make 
up four characters. 

On the Mac, finding the file type is more com-
plicated. In Mac OS X, there is no utility in the oper-
ating system that can identify file types. However, 
there is a shareware utility that can assist you, XRay.  
Drag-and-drop the file on the to the XRay window 
as directed by the application. Under the Show pull-
down menu, select Type, Creator and Extension. This 
will display the file type information.
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Import Items from Files/Folders



MediaPro Basics   1�

Import items via drag-and-drop
You can drag-and-drop any file, folder, hard disk, 
CD, or volume onto an open MediaPro catalog 
to add media. You can also drop files onto the 
MediaPro icon or shortcut icon. In either case, 
your media files will appear in a catalog.

You can also drag-and-drop a folder that con-
tains some files already cataloged and a few new 
files. MediaPro will skip files already cataloged and 
add only the new files to the catalog. 

Import items from 
Pictures/Movies folders
In the Getting Started dialog, check Import Pic-
tures/Movies Folders. MediaPro will automatically 
find the Pictures and Movies folders for the active 
operating system user and import all media into 
a new catalog. 

MediaPro will ignore media in folders dedicat-
ed to certain applications such as Apple’s iPhoto.  
This importing feature only works on the Mac OS X 
and Windows XP operating systems.

Import items from Spotlight Query
MediaPro can now import items from your com-
puter using Mac OS X Tiger’s advanced search 
technology called Spotlight. 

When you search via Spotlight, you’re accessing 
a comprehensive, constantly updated index that 
sees all the metadata inside supported files on 
your hard drive, including the kind of content, the 
author, edit history, format, size and many more 
details. 

Most documents, including Microsoft Word 
documents, Adobe PDF documents, MP3 audio 
files and digital camera images, already contain 
rich metadata. And because Spotlight indexes 
contents of the file as well, your search results 
include what appears inside a file or document, 
not just its title.

To use this function, choose Import Items from 
Spotlight Query. Type a word or phrase to search for 
and MediaPro will import all related media files. 

Alternatively, you can type a full Spotlight 
Query, using special Spotlight syntax, to specify 
complex search criteria.

By default, Spotlight imports are appended 
to the open catalog. Checking the Add results in 
new catalog will place all imported items in a new 
catalog.

Import items from desktop 
contextual menu
The MediaPro Contextual Menu plug-in is a sys-
tem level plug-in that allows you to add items to 
a MediaPro catalog simply by selecting a menu 
item directly from the computer’s desktop. Simply 
right-click (Mac: Ctrl-click) on a file or folder and 
select iView MediaPro Import from the contextual 
menu. Items will be added to the open catalog or 
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Add files through drag-and-drop: Files are added to a 
catalog in the exact position of the cursor highlight, the 
long bar that is separating the two items above.

Import from Spotlight Query
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a new catalog, if one is not currently open.
This plug-in is automatically installed with the 

application. To uninstall it on the Mac, simply run 
the AppleScript Install MediaProCM plug-in (see 
the MediaPro Documentation folder) and follow 
the prompts. 

Import items from iPhoto
Mac: In the Getting Started dialog, check Import 
iPhoto Library. MediaPro will automatically find 
the iPhoto library for the active operating system 
user, launch iPhoto in the background and import 
all original photos into a new catalog. This feature 
only works with versions 2, 4 and 5 of iPhoto.

The new catalog contains references to your 
photo files that are still inside the iPhoto library 
folders.  If you wish to move these files out of the 
iPhoto library, you can select all the images in the 
catalog and select Transfer to Folder in the Ac-
tion menu. Choose Move files, reset paths, delete 
originals. This will move your original images to 
a folder of your choice, sets the paths to the new 
location and delete the images from your iPhoto 
library. 

To free up additional hard drive space, you could 
delete all the proxy images (thumbnails) created 
by iPhoto. To do this, simply trash the iPhoto Library 
folder from the Pictures folder. Make sure you do 
this after you have transferred all original images 
to a new location on your hard drive. Or you could 
leave the original images where they are and have 
media in both iPhoto and iView MediaPro.

The new MediaPro catalog will also contains your 
iPhoto albums as MediaPro Catalog Sets (in the Orga-
nize Panel). Your catalog also contains any metadata 
(such as EXIF digital camera data, comments or key-
words) that were assigned to your images in iPhoto. 
The chart above details how iPhoto annotations 
map to iView MediaPro annotation fields.

Import from Photoshop Album
Windows: In the Scripts menu, select Import 
from Adobe Photoshop Album from the Import 
sub-menu. MediaPro will automatically find the 

Photoshop Album collection for the active op-
erating system user, launch Photoshop Album in 
the background and import all images into a new 
catalog. This import script works with versions 1, 2 
and 3 of Photoshop Album.

This catalog will contain metadata such as EXIF 
digital camera data and captions that were assigned 
to your images in Photoshop Album. Any tags, key-
words or additional IPTC annotations cannot be 
imported at this time.
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Annotation mapping for iPhoto import

Annotation mapping for Photoshop Album import

* iPhoto 4, 5

iPhoto MediaPro

Filename Filename

Title Title

Keyword Keyword

Checkmark (keyword) Does not map at this time

Star Ratings* Do not map at this time

Albums Catalog Sets

Smart Albums* Catalog Sets 

Comments Caption/Description

Date Event Date

Date (modified in iPhoto) Event Date

Photoshop Album MediaPro

Caption Caption/Description

Tags Do not map at this time

Import from desktop 
Contextual Menu



MediaPro Basics   1�

If you hold down the Ctrl key (Mac: Cmd key) 
while dragging-and-dropping, MediaPro will 
remove a file from a catalog and add it to another.

If the open catalog already contains files that 
are part of the selection of files that are being 
dragged-and-dropped, MediaPro will ignore 
these files and will not replicate them.

Matching thumbnail size when merging
If the item’s thumbnail in an older catalog is 
smaller than the catalog being appended, then 
the thumbnail will have to be rebuilt to match the 
new size. 

For example, an older catalog might have 128 
pixels thumbnails. The new catalog it is being 
merged into has 320 pixel thumbnails, then the 
previous thumbnails will appear smaller. To fix 
this, select the appended files and choose Rebuild 
Item in the Action menu.

Import from catalog file
iView MediaPro can combine the contents of one 
catalog with the contents of another.  The Import 
Items From Catalog File command (File menu) 
appends a selected catalog to the currently open 
catalog. 

How to merge catalogs
1. Open an existing catalog.
�. Choose Import Items From Catalog File from 

the File menu.
�. Navigate to and select a catalog created by 

an iView product (including previous versions 
of MediaPro, or iView Media or MediaLE).  This 
function will not work with catalogs created 
by other programs.

4. New media items will be appended to the 
end of the existing catalog. Each item’s related 
annotations, label and thumbnail are added 
as well. Catalog Sets are now merged into the 
open catalog.
If the open catalog already contains files that 

are part of the selection of files that are being 
merged, MediaPro will ignore these files and will 
not replicate them.

Merging catalogs using drag-and-drop
An alternative way to add items from one catalog 
to another is using the drag-and-drop method. 

To do this, open two catalogs. Select one ore 
more items, and drag them from one catalog to 
the other. Unlike Import From Catalog File, where 
files are appended to the bottom of the catalog, 
dropped files are added at the specific position 
in the catalog defined by your cursor placement 
(applies to List and Thumbnail Views). 

If you drag-and-drop items into a catalog that is 
currently in Media View, then the dropped items 
will appear at the end of the catalog.

Using drag-and-drop does not remove a file 
from a catalog and add it to another. This function 
copies a media item’s reference from one catalog 
to another. As such, each item’s related annota-
tions, label and thumbnail are added. 
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Import from Catalog File: Navigate to and choose an 
iView MediaPro catalog file on the desktop.
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Import from a digital camera 
Windows XP instructions
Depending on the USB transfer settings of your 
camera, there are two ways to import images from 
digital cameras. 

Some digital cameras support a standard called 
Picture Transfer Protocol (PTP). Refer to your digital 
camera’s documentation to find out if it supports 
PTP and how to properly define PTP settings for 
the camera. 

A. Using Picture Transfer Protocol
If your camera supports PTP: 
1. Plug your camera into your computer. 
�. When the dialog for your camera appears, 

click the Cancel button.  
�. Launch iView MediaPro and open an ex-

isting catalog, or create a new catalog, into 
which to import the new images. Select Im-
port Items From Camera in the File menu. 

Download settings
4. Choose a Source: In the Source drop-down 

menu, select the camera or media card you 
want to import media from. 

�. Choose a Destination folder: Click the Desti-
nation folder icon. In the dialog, choose or cre-
ate a folder to place files that are downloaded 
from your camera.

Options
6. Place in: Download folder will place down-

loaded files in the destination folder.  Today’s 
folder will place downloaded files in a folder 
named after today’s date in the destination 
folder.  Original folder hierarchy will place 
downloaded files in copy of the folder direc-
tory hierarchy on the camera hard drive in the 
destination folder.

7. Rename: Enter a text string (such as the date 
or subject) in this field, and MediaPro will 
rename all downloaded files with sequential 
numbers following this string. Leave this field 
blank to maintain the existing filenames.  

8. Actions: Skip files with same name prevents 
you from writing over existing files with the 
same name. Set file creation date to capture 
date sets the image file’s creation date to 
match the date you took the picture (Capture 
Date). This is useful because some applications, 
as well as the operating system, cannot read 
the Capture Date. This way your media will be 
better organized on the desktop. Delete origi-
nals after downloading delete originals files 
off your camera’s media card after they have 
been downloaded to the destination folder.  

9. Annotate: Choose a metadata template from 
this drop-down menu to apply a group of pre-
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Import Items from Camera

Click the folder icon to choose a destination folder on 
the desktop where downloaded images will be placed.

Import Items from Camera: Options panel
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Import from a digital camera 
Mac OS X instructions
The OS X Image Capture application allows Mac 
users to automatically download images when 
a camera is attached to the computer. MediaPro 
has integrated this functionality to make catalog-
ing images during download from your camera as 
easy as possible.

1. Launch the Image Capture appli-
cation. It is located in the OS X 
Applications folder. 

�. Set Image Capture preferences:  
OS 10.� - Open the Image Capture Prefer-
ences. Choose Other in Camera Preferences 
pop-up menu. Navigate to and choose iView 
MediaPro. Quit the Image Capture application. 
OS 10.�, 10.4 - In the Image Capture General 
panel, navigate to and choose iView MediaPro 
in the When a camera is connected, open pop-
up menu.

�. Plug your camera into your computer. From 
this point, whenever you plug a camera into 
your computer, Image Capture will launch 
MediaPro. To import images, select Import 
Items From Camera in the File menu. If iView 
MediaPro is already running when you plug 
in your camera, the Import Items From Camera 
dialog box will automatically appear. 

Download settings
4. Choose a Source: In the Source drop-down 

menu, select the camera or media card you 
want to import media from. 

�. Choose a Destination folder: Click the Desti-
nation folder icon. In the dialog, choose or cre-
ate a folder to place files that are downloaded 
from your camera.

defined annotations to all downloaded files. If 
there are no templates available, you can cre-
ate one by selecting New Metadata Template. 
Clicking the text button next to the menu will 
display the template content and some addi-
tional options for applying metadata.

10. Download: Once options have been set, click 
the Download button. MediaPro will import 
each image into the open catalog after it has 
been downloaded from the camera to the 
destination folder you defined. After import 
is complete, dismount the camera from the 
desktop (eject), then you can safely unplug your 
camera.

B. Without Picture Transfer Protocol 
These instructions also apply to digital media 
card readers that do not support PTP: 
1. Plug your camera into your computer, 

using a USB or serial connection. Or insert 
your digital media card (Compact Flash card, 
Memory Stick, etc.) into your card reader.

�. When the Device Action dialog appears, choose 
Copy pictures to a folder on my computer using 
Microsoft Scanner and Camera Wizard. 

�. Follow the directions of the Camera Wizard 
to locate an existing folder or to create a new 
folder for your pictures. On the last screen of 
the Wizard, choose Nothing. I’m finished work-
ing with these pictures.

4. Launch iView MediaPro and open an ex-
isting catalog, or create a new catalog,  into 
which to import the new images. Select Im-
port From Files/Folders in the File menu. Navi-
gate to and select the folder on your desktop 
where your images were placed with the 
Camera Wizard. 

�. Import images: iView MediaPro will import 
each image into an existing catalog, or a new 
catalog that you created.
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Mac OS X: Image Capture preferences dialog in Tiger.
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Options
6. Place in: Download folder will place down-

loaded files in the destination folder.  Today’s 
folder will place downloaded files in a folder 
named after today’s date in the destination 
folder.  Original folder hierarchy will place 
downloaded files in copy of the folder direc-
tory hierarchy on the camera hard drive in the 
destination folder.

7. Rename: Enter a text string (such as the date 
or subject) in this field, and MediaPro will 
rename all downloaded files with sequential 
numbers following this string. Leave this field 
blank to maintain the existing filenames.  

8. Actions: Skip files with same name prevents 
you from writing over existing files with the 
same name. Lock downloaded files turns on 
the desktop’s Lock status for all downloaded 
files.  Set file creation date to capture date sets 
the image file’s creation date to match the 
date you took the picture (Capture Date). This 
is useful because some applications, as well as 
the operating system, cannot read the Cap-
ture Date. This way your media will be better 
organized on the desktop. Delete originals after 
downloading delete originals files off your 
camera’s media card after they have been 
downloaded to the destination folder.  

9. Annotate: Choose a metadata template from 
this drop-down menu to apply a group of pre-
defined annotations to all downloaded files. If 
there are no templates available, you can cre-
ate one by selecting New Metadata Template. 
Clicking the text button next to the menu will 
display the template content and some addi-
tional options for applying metadata.

10. Download: Once options have been set, click 
the Download button. MediaPro will import 
each image into the open catalog after it has 
been downloaded from the camera to the 
destination folder you defined. After import 
is complete, dismount the camera from the 
desktop (eject), then you can safely unplug your 
camera.
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The Import from Camera dialog shows thumbnail 
previews of all images to be downloaded.

Annotate on import: 
Choose a metadata 
template from this 
drop-down menu to 
apply a group of pre-
defined annotations 
to all downloaded 
files. If there are no 
templates available, 
you can create one 
by selecting New 
Metadata Template. 

Click the folder icon to choose a destination folder on 
the desktop where downloaded images will be placed.
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Import from disk
Download settings
1. Open your catalog  or create a new one. 
�. Choose a Source disk: In the Source drop-

down menu, select the disk you want to 
import media from. MediaPro will import 
media from removable storage media such as 
CD or DVD.

�. Choose a Destination folder: Click the Des-
tination folder icon. In the dialog, choose or 
create a folder for files that are downloaded 
from the disk.

4. Optional - Filter media types: To constrain 
an import to only image file formats, click on 
the Media Importers button and check only 
the Images box. This will prevent non-image 
files from being imported into the catalog. 
Imports can be filtered by any of eight differ-
ent media file type groups.

Options
�. Place in: Download folder will place down-

loaded files in the destination folder.  Today’s 
folder will place downloaded files in a folder 
named after today’s date in the destination 
folder.  Original folder hierarchy will place 
downloaded files in copy of the folder direc-
tory hierarchy on the disk in the destination 
folder.

6. Rename: Enter a text string (such as the date 
or subject) in this field, and MediaPro will 
rename all downloaded files with sequential 
numbers following this string. Leave this field 
blank to maintain the existing filenames.  

7. Actions: Skip files with same name prevents 
you from writing over existing files with the 
same name. Lock downloaded files turns on the 
desktop’s Lock status for all downloaded files.  
Delete originals after downloading move origi-
nals files to the recycle bin (trash) after they 
have been downloaded to the destination 
folder. This option will only work on rewritable 
storage media. 

8. Annotate: Choose a metadata template from 

this drop-down menu to apply a group of pre-
defined annotations to all downloaded files. If 
there are no templates available, you can cre-
ate one by selecting New Metadata Template. 
Clicking the text button next to the menu will 
display the template content and some addi-
tional options for applying metadata.

9. Download: Click the Download button and 
MediaPro will download all files from the disk, 
and store it in the destination you defined. 

Import Items from Disk: Example of downloading 
media from a CD-ROM. To constrain this import to only 
image file formats, click on the Media Importers button 
and check only the Images box. This will prevent non-
image media files from being imported into the catalog.
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Import Items from Disk: Options panel.
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Import from the Internet
Download settings
1. Open your catalog  or create a new one. 
�. Choose a Destination folder: Click the Des-

tination folder icon. In the dialog, choose or 
create a folder for files that are downloaded 
from the Internet.

�. Enter URL: Enter a web address in the text 
field at the top of the dialog. It must be a com-
pletely formed URL, such as: 
http://www.photo.com/img1.jpg

4. cURL syntax: MediaPro now support cURL 
commands for downloading files from the 
Internet. cURL is a special syntax for transfer-
ring files online (see example figure right).  To 
learn more about cURL, see the official site at:  
http://curl.haxx.se/

Options
�. Place in: Download folder will place down-

loaded files in the destination folder.  Today’s 
folder will place downloaded files in a folder 
named after today’s date in the destination 
folder.  Original folder hierarchy will place 
downloaded files in copy of the folder direc-
tory hierarchy on the web server in the desti-
nation folder.

6. Rename: Enter a text string (such as the date 
or subject) in this field, and MediaPro will 
rename all downloaded files with sequential 
numbers following this string. Leave this field 
blank to maintain the existing filenames.  

7. Actions: Skip files with same name prevents 
you from writing over existing files with the 
same name. Lock downloaded files turns on the 
desktop’s Lock status for all downloaded files.   

8. Annotate: Choose a metadata template from 
this drop-down menu to apply a group of pre-
defined annotations to all downloaded files. If 
there are no templates available, you can cre-
ate one by selecting New Metadata Template. 
Clicking the text button next to the menu will 
display the template content and some addi-
tional options for applying metadata.

9. Download: Click the Download button and 

MediaPro will download all files from the 
Internet, and store it in the destination you 
defined. MediaPro will also store the file’s web 
address in the Source URL annotation field.
Drag-and-drop option: You can also drag-and-

drop files from a web browser onto your catalog. 
This will launch the Download from URL dialog.
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Import from URL: Example of using cURL syntax to 
download a range of sequentially numbered files. 

Import from URL: Options panel

Place in: Choose Original folder hierarchy to download 
items to folders matching the web directory structure.
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Import with folder watching
MediaPro offers advanced folder watching to 
monitor all folders on a hard drive and local net-
work which contain cataloged media. When new 
media appears in a watched folder, it can be man-
ually or automatically imported to the catalog.

This is useful for a workflow in which:
• Images are being batch scanned and saved to 
a particular folder.

• A folder action is automatically downloading 
images off other computers or the Internet.

• Several users are contributing images to a 
shared network folder.

To turn on folder watching
1. Show Organize Panel by clicking the Orga-

nize toolbar button, or choose Window > 
Display > Organize Panel. This will reveal the 
Catalog Folders panel (see figure above). 

�. To enable folder watching, select an option 
from the catalog Folder Watching menu 
— either Update Folders: Every minute or Every 
5 minutes. 

�. Update folder: MediaPro will alert you when 
new images have been added to any folder 
by showing by a blue arrow on the folder icon. 
To import these new images directly to your 
catalog, select Update Folder Now from the 
individual folder’s drop-down menu.

4. Auto-update takes folder watching to the 
next level by automatically importing from 
selected folders when new images are added. 
To enable this feature, select Switch Auto-
Update On in the menu of the individual folder 
that you want to be auto-updated. When new 
images are added to that folder, MediaPro will 
automatically import those images into to 
your catalog. New images will be added to the 
end of the catalog. Auto-update folders are 
shown in green. Select Switch Auto-Update Off 
to turn off the auto-update feature, but main-
tain folder watching.

�. To turn off catalog-wide folder watching, 
select Never from the catalog Folder Watching 
menu. 
For more information, see page 80.
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Folder Watching menu

Green folders 
indicate auto-
update is on.

Blue arrows 
indicate 
that new, 
uncataloged 
images are 
in this folder. 
Select Update 
Folder Now to 
import these 
new items.

To expand  
all folders, 
Alt+Click (Mac: 
Option+Click) 
on the volume 
arrow.

Green indicates Folder Watching is on

Catalog Folders: Click the Organize toolbar button to show/hide the Catalog Folders panel (Window menu).

Individual folder menu : Reveal this 
menu by right-clicking (Mac: Option-
Clicking on the folder name.

Click the dot next to any folder to 
show only items in that folder in the 
media viewing area.
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Catalog information 
The Catalog Info dialog (File menu) contains infor-
mation about your catalog, as well as giving you a 
place to make comments about the catalog. The 
Comments field can be exported with HTML web 
galleries.

Protecting catalogs 
Once you have created a catalog, you might want 
to prevent others from viewing or accessing it. To 
set password protection for a catalog:
1.  Select Catalog Info from the File menu.
�.  Click the Set Password button. This button is 

only available if you have saved your catalog.
�.  Type the password. Then save the catalog. 
4.  When opening the catalog in the future, you 

will be asked to provide the password before 
you can view the catalog’s contents. MediaPro 
does not provide a way to recover catalog 
passwords. 

�.  To remove password protection, click the Set 
Password button and delete the password in 
the field. Then save your catalog, and pass-
word protection will be removed. 
MediaPro catalogs does not use strong encryp-

tion for password protection. For additional levels 
of security, try these options below.

Other options for protecting catalogs
Set read-only attribute (Windows): On the 

Finding catalogs
The Catalog Finder lets you to quickly locate and 
preview all iView catalogs on a storage volume 
(hard drive, CD, DVD, etc.).  This function is located 
in the Open Recent sub-menu of the File menu. 

1.  Select a storage volume from the pop-up 
menu, and MediaPro will locate all catalogs on 
that volume. 

�. Click the Find button to refresh the search. 
�. Click a catalog name in the search results list 

to preview the found catalog. 
4. Click Open to launch the catalog.

Catalog Finder:  Locate and preview catalogs. 
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Catalog Info dialog (File menu).



MediaPro Basics   ��

desktop, select your catalog file and select Prop-
erties in the File menu. In the dialog, check the 
box Read-only under the Attributes section. This 
will prevent the file being altered. In the Advanced 
Attributes section, select Encrypt contents to secure 
data to increase protection.

You can also increase your catalog file’s security 
by setting user permissions for the catalog in the 
Security panel of this dialog. This would prevent 
other users from opening the catalog.

Set file lock properties (Mac): On the desktop, 
select your catalog file and select Get Info in the 
File menu. In the dialog, check the box Locked. This 
will prevent the file being altered.

While this option doesn’t prevent you or oth-
ers from altering catalogs (all you have to do is 
uncheck the box to unlock the catalog), it can serve 
as a useful reminder to prevent saving over a cata-
log that you do not want changed.

You can also increase security by setting user 
permissions for the catalog in the Ownership & 
Permissions section of this dialog. This would pre-
vent other users from opening the catalog.
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Set read-only attribute in the File Properties dialog. Set file lock status in the File Info dialog.

You can also increase security by setting user 
permissions for the catalog in the Ownership & 
Permissions section of this dialog. This would prevent 
other users from opening the catalog.

Encryption: Keep your catalogs and media on 
an encrypted disk image, such as one made by 
PGPdisk, which is available on both platforms.
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iView MediaPro preferences
Additional setup options can be defined in the 
Preferences dialog box by choosing Preferences 
under Edit menu (Windows) or the iView MediaPro 
application menu (Mac OS X).

General
At Startup: Select whether you want to open a 
new catalog, open the last catalog you used or do 
nothing every time you launch the application.
Double-Click: Select how MediaPro interprets 
double-clicking on a media item in a catalog. 
Alt+double-click (Mac: Option+double-click) will 
always launch the selected media file with its cre-
ator application.
Options: Display a useful description under the 
toolbar buttons; Sort media based on natural 
numerical order (i.e. 1,2,3..., 10,11); show warning 
dialogs appear when batching items or when re-
moving items from a catalog or set; and Auto-save 
catalogs on timed schedule.
Field Names: Define which field names to use for 
describing IPTC annotations: official IPTC Core 
names, those names used in iView MediaPro 2 or 
names used in Adobe Photoshop CS. 
Dimensions: Define the unit of measure: pixels, 
inches, centimeters, points or picas.
Resolution: Change the default resolution from  
Pixels/Inch to Pixels/cm (centimeter).
Date: Change the display of the date in various 
fields. Options include:

• Long:  Friday,  April 16, 2004
• Short:  4/16/04
• Abbreviated: Fri, Apr 16, 2004

Inspector Key: Place your cursor over any media 
item or Organize Panel term and press the key 
defined here to get more information. 

Labels
Color labels provide a method of a visual identi-
fication and classification of media files in your 
catalogs. The Preferences dialog enables you to 
globally customize the colors and names of color 
labels. For more on labels, see page 63.
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Preferences: General panel

Preferences: Labels panel

Example of Inspector key in action
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Media Rendering
Images Panel
Use built-in thumbnails: Some applications, such 
as Adobe Photoshop, embed a thumbnail into the 
media file. Digital cameras do this as well. These 
thumbnails are typically low quality. 

During import, MediaPro extracts and displays 
that embedded thumbnail if the box is checked. 
Turning this option off will instruct MediaPro to 
create its own thumbnails, which are generally 
higher in quality, at the cost of a slower import 
process. If you wish to improve the quality of the 
thumbnails at any time, choose Rebuild Item in the 
Action menu. See page 37, for more information 
improving the quality of thumbnails.

Rendering: This pop-up menu gives you three 
options for the way MediaPro resamples images 
to display them at various sizes: Nearest Neighbor 
(faster but less precise), Bilinear (a medium-quality 
method) and Bicubic (slower, but better quality).  

Color Match: Turning this option on enables 
color profile matching in all views. If an image has 
an embedded ICC color profile, MediaPro uses it 
to create thumbnails and display images. Other-
wise, MediaPro uses default document profiles 
chosen in the system’s control panel. 

Use alpha channel: Alpha channels are grayscale 
images used to hide/show certain portions of an 
image. In Adobe Photoshop, masks are stored in 
alpha channels. Turning this option on enables 
MediaPro to render thumbnails and media 
images using the alpha channel as a mask.

Skip images...: Allows you to place a limit on the 
size of images that the application will display in 
Media View and Slide Show mode. If an image is 
over the limit defined, MediaPro will not render it. 
This option will accelerate importing large images 
when viewed in Media View. Available range: 1 to 
100 megabytes.

Transparency: Choose the background color 
used for transparent spaces in various image file 
types, such as GIF and Adobe Photoshop.

Lightbox warnings: You may want to adjust the 
sensitivity of exposure warnings in the Lightbox. 

Click the up or down arrows to adjust the under 
and over exposure values that trigger red and blue 
onscreen warnings.

Camera Raw panel
Digital Camera Raw Rendering: Canon, Kodak and 
Nikon raw image files may contain a large preview 
that is suitable for viewing and renders much fast-
er than decoding the raw data. If you check Use 
embedded preview, this will speed up import and 
media rendering of Raw files.

Photo CD Size: Kodak Photo CDs contain imag-
es with a variety of dimensions and file sizes. This 
option tells MediaPro which size to catalog: Small, 
Normal or Large options. Smaller sizes will import 
much faster into MediaPro.

DCR Look profile: The Look profile pop-up menu 
adjusts the color tone of Kodak DCR images when 
rendered by MediaPro.
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Preferences: Media Rendering > Images panel

Preferences: Media Rendering > Camera Raw panel
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Fonts Panel
Media View: Fonts can be displayed as a standard 
character set, a full character set, or as sample text 
that you define. The Font Size option only applies 
to TrueType fonts. Bitmap fonts are displayed at 
the size defined by the font. These options also 
apply to the display of fonts in Slide Shows.

If you change the font display preference for 
Media View while your catalog is currently dis-
playing Media View, you will have to switch to 
Thumbnail View and go back to Media View in 
order for the new preferences to be displayed.

Thumbnail View: Thumbnails of fonts can be 
displayed as the font name or as two characters  
of sample text that you define.  If you change this 
option after importing fonts into a catalog, you 
will need to select all thumbnails, and choose 
Rebuild Item in the Action menu in order to have 
iView MediaPro recreate the font thumbnail with 
the new settings. Thumbnail View settings also 
apply to List View.

M
ed

ia
Pr

o 
Ba

si
cs

Preferences: Media Rendering > Fonts panel

Sample text font displayed in Thumbnail View.

Helper applications
When browsing or viewing files in a MediaPro 
catalog, it’s likely that you may want to act upon 
a file in some way outside of the feature set that 
MediaPro provides – such as file editing or com-
pression. To assist you, there is a function called 
Open With Helper Application. 

Helpers are defined in Preferences > Helper 
Applications (see figure above). This panel will let 
you choose media editors, utilities or viewers so 
that you may quickly access them via the pull-
down menu in the  application toolbar or through 
a contextual menu. 

To add a Helper:  Go to the Helper Applications 
dialog and click the Add button. Navigate to the 
application through the desktop and select it.  
When first launched, iView MediaPro will auto-
matically scan your computer for Helpers, but you 
may want to add or remove some later.

Accessing Helper Applications: After select-
ing an item in your catalog, you can execute an 
Open With command two ways: In the toolbar’s 
icon pull-down menu (top), or through a contex-
tual menu. Right-click (Mac: Ctrl-Click) to access a 
contextual menu.

The possibilities are limitless for using Helper 
applications in your workflow.  For more informa-
tion on using Helper apps, see page 110.

Define Helper Applications: To access this dialog, 
choose Preferences > Helper Applications.
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Vocabulary Editor
In MediaPro, a vocabulary is a set of annotations.  
When you annotate a media item in the Info or 
Organize panel, there is a list of available anno-
tation terms that appear as a drop-down list. A 
vocabulary, then, is a collection of all those lists of 
known terms for each field. For example, one list 
for keywords, one list for people, etc.

The Vocabulary Editor enables you to edit this 
list; to set up annotation terms that are associated 
with each other; create multiple sets of annota-
tions (vocabularies) for different purposes and 
also lock the vocabulary so that only annotation 
terms in a vocabulary can be used.

The Vocabulary Editor can be found in Edit > 
Preferences (Windows) or iView MediaPro appli-
cation menu > Preferences (Mac OS X).

Editing a vocabulary
Choose the vocabulary you want to edit from the 
top drop-down menu. For most users, one vocab-
ulary will be all you need to use., so Default will be 

the only option in this menu.  
Choose the annotation field that you want to 

edit using the Field drop-down menu.  Use the 
plus and minus buttons at the bottom of the win-
dow to add or remove an annotation term.

This way you can build up a list of annotation 
terms you know that you may use. You can also 
remove entries that may be mistakes or you can 
double-click a term to correct any mistake.

Set up annotation associations
For a field that can contain more than one anno-
tation term per field (Keywords, Categories, People, 
Scenes and Subject Codes) you can save time by 
associating multiple annotation terms. This way 
when you enter one of the terms you have the 
option of applying all the associated annotation 
terms at the same time.  

Enter all the annotations, separated by a comma, 
in the terms section of the Vocabulary Editor.  You 
will get a message asking if you wish to treat this 
as one annotation or multiple annotations when 
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Constrain 
editing to 
defined terms: 
This option locks 
the addition 
of terms to a 
particular field 
outside of the 
Vocabulary 
Editor. To lock the 
entire vocabulary,  
you must check 
this box for 
every field in a 
vocabulary.

Reveal 
vocabulary files 
on the desktop.

Choose a 
vocabulary

Choose a field 
to view or add 
terms

Add/remove a 
vocabulary

Add/remove 
terms from a 
field.

Double-click to 
edit any term
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this entry is used to annotate a media item (see 
figure right). An example of this would be a stock 
photographer who wants to use many keywords 
in an image so that it can be found easily.  For a 
photographer who regularly shoots landscapes 
it might be worth setting up the associations sea, 
blue, water, and landscape. When sea is entered as 
a keyword, you can optionally apply all four key-
words at the same time (see figure left).

Terms descriptions
You can enter a description of an annotation term 
or group of associated annotations in the Vocabu-
lary Editor.  When you select a term in the Info or 
Organize panel, this description will appear to the 
right of the annotation in grey.  This is useful when 
the actual annotation that is to be entered may 
need clarification.  

For example, scientific Latin names could be 
described by their modern language equivalent.  
Another example is an annotation term which 
could contain a code instead of readable text.  The 
IPTC Scene Codes are number strings that repre-
sent specific types of scene.  For instance 010100 
is the code for a Headshot.  You could enter all the 
codes as terms and use the Terms description as a 
readable explanation of that code. 

Create multiple vocabularies
The majority of MediaPro users will only need to 
use one vocabulary. Default is the vocabulary that 
is created when MediaPro is first launched. 

MediaPro can have multiple vocabularies. 
This is useful if you have many different uses for 
MediaPro. You might regularly take photos for cli-
ents in the fashion industry, stock travel agencies 
and also take personal photos. 

You could create a vocabulary called Personal 
and this would contain, among other annotations, 
the names of your family and friends in your pho-
tos.  You can choose this vocabulary when anno-
tating personal photos and switch to another 
vocabulary for the photos for your clients.  This 
way by switching between the two vocabularies 
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Add terms: Click the plus (+) sign in the lower left corner 
to add a term. Terms can be a set of comma separated 
words. This way, when you apply a term containing four 
words, MediaPro will split them into four keywords. This 
makes add multiple keywords faster.

Entering terms: In the Info Panel, double-click to add 
keyword. Begin typing the term, and MediaPro’s auto-
complete function will automatically type the nearest 
available term in the vocabulary.

Separate keywords: When you are done entering a 
string of terms, press the Return or Enter key. MediaPro 
will automatically split multiple terms in separate 
keywords. This is handy if you cut and paste a comma 
separated string of terms into one field. MediaPro 
automatically converts the string into single keywords.

Term descriptions: When you select a term in the Info or 
Organize panel, the term description will appear to the 
right of the annotation in grey.
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you will be see annotation terms appropriate to 
the catalog at hand.

A vocabulary may contain a very large number 
of terms, taken a long time to create or may need 
to be backed up or copied from one computer 
to another.  

Each vocabulary is created in it’s own folder. 
The name of the folder is the name of the vocab-
ulary.  You can show the location of these folders 
using desktop icon in the upper right corner.  So 
to back up the Default vocabulary, click this but-
ton and make a copy of the Default folder on the 
desktop.

Locking a vocabulary
By choosing the Constrain editing to defined terms 
means that only terms in that annotation field in a 
vocabulary can be used to annotate media items.  
When this option is selected, you cannot enter 
annotations in any part of MediaPro (such as the 
Info or Organize Panels) other than the Vocabu-
lary Editor. 

To lock an entire vocabulary, you must check 

Constrain editing to defined terms for every anno-
tation field. 

An example of when this might prove useful is 
if a photographer hires an assistant to help enter 
annotations. By requiring the assistant  to choose 
from existing annotation terms the photographer 
ensures the annotations will match existing ones 
and would result in a much more accurately 
annotated catalog.

A locked vocabulary is also called a controlled 
vocabulary.  According to David Riecks, an expert 
on metadata vocabularies, a controlled vocabu-
lary makes a database easier to search. 

“Since we have many different ways of describ-
ing concepts, drawing all of these terms togeth-
er under a single word or phrase in a database 
makes searching the database more efficient as 
it eliminates guess work,” says Riecks. “However, 
arriving at this efficiency requires consistency on 
the part of the individual indexing the database 
and the use of pre-determined terms.”

To learn more about controlled vocabularies, 
see David Riecks’ web site:
http://www.controlledvocabulary.com/
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Info Panel

The iView MediaPro workspace
ToolbarView TabsCatalog Name

Header bar (contextual to view)

Media Viewing Area

Size Menu

Show/Hide progress 
indicator panel

Zoom

Rotate

Catalog Information bar

Info and Organize 
Panels: Click button to 
hide/show panels

Invert sort 
order

Drag bar to 
adjust width 
of panel.

Drag bar to 
adjust height 
of panel.

Search Box

Organize Panel

Use this menu 
to show/hide 
fields in the 
Info Panel.

Use this menu 
to show/hide 
fields in the 
Organize 
Panel’s Catalog 
Field index.

Drag bar to 
adjust height 
of panel.

Turn Folder 
Watching On 
or Off.

Metadata templates menu Add/Remove field terms

Pull corner to enlarge
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Header bar

Toolbar functions

Open With launches the selected media items 
with a Helper application that can view, edit or 
mail media files.

Show Media File reveals the location of 
the selected media items on the desktop or 
mounted storage volume.

Move to Recycle Bin removes the selected 
items from the catalog and moves the original 
files to the Recycle Bin (Trash on Mac). 

Assign Label will assign one of nine color 
labels to the selected media items. Also 
provides the option to remove a label. 

Voice Annotation allows you to record, listen, 
remove or import audio annotations attached 
to media items.

Media Info/Organize Panels - click either of 
these buttons to show or hide the Media Info 
and Organize Panels.

Show All Items restores the view of a catalog 
to show all items. Available after search, sort 
and organize functions. 

Rotation sets the viewing angle of an item in 
all views.  This does not change the rotation of 
the original file. 

Zoom increases or reduces the size of 
thumbnails and media in all views (List, 
Thumbnail and Media).

Play Media contains options to play a movie, 
animation or sound. The spacebar will start/
stop the playback of media, as well. 

Slide Show launches a presentation in a full 
screen slide show, beginning with the selected 
media item.

Sort will reorder items in your catalog by 
more than 25 criteria such as color label, file 
name, capture date and dimensions.

Print displays options for printing lists,  
contact sheets and single images from your 
catalog.

Image Editor shows a palette to crop or 
resize photos, as well as adjust color, tone or 
sharpness and make other enhancements.

State navigation lets your step back and 
forward between your catalog selections in 
the Organize Panel. 

Send Email will convert and attach selected 
media items, then add them as an attachment 
to a new email in a designated email client. 

Rate media will assign one of five star ratings 
to the selected media items. Also provides the 
option to remove a star rating. 

View Options will display a palette that 
controls which fields are displayed, as well as 
the font and colors for each view.

List View

Thumbnail View

Media View

Lightbox - select up to four images then click 
this icon to launch the full screen viewing and 
comparison tool.

Search Box: Type the word or words in this 
field and press the Return or Enter key. Results 
are presented in the active catalog view. 

Click filed label to sort media by that field. 

Displays the path (location) of the selected item

Use Pager tool to flip through alternate frames or pagesPath of selected item

Media properties
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The MediaPro interface displays information in 
three different views: List, Thumbnail and Media. 
To switch views, click the appropriate tab.

All three views offer features that resemble the 
way you work with your files in the desktop:

• To find a file, type the first letters of its name.
• To change a file name, click the name, wait a 
moment, and then start typing.

• To use functions in the contextual menu,  
right-click a media item’s thumbnail  
(Mac: Ctrl-click), or anywhere inside the iView 
MediaPro window.

• To rearrange items, drag them to where you 
want them and drop them. You can drag 
single items or multiple selections.

• To copy or move items to another catalog,  
drag them from one catalog to the other.

• To move the original files, drag the relevant 
catalog items to a folder or to the desktop. 
This will move the file from its current loca-
tion to the desktop.

• To copy files from the catalog to the desktop, 
hold the Ctrl key (Mac: Option key) while 
dragging them to the desktop.

• To launch items with another drag-and-drop 
application, drag them onto the application 
shortcut (Mac: alias).

• To invert the order of media any catalog view, 
click the invert button (  ) in the upper left 
corner of the media viewing area. 

Viewing files in catalogs
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Hide  Toolbar: To increase the size of the media viewing area, use the Hide/Show Toolbar option in the Window menu. 

Contextual menu: 
Right-click to get 
quick access to 
many of MediaPro’s 
functions (Mac: Ctrl-
click). This menu will 
help you minimize 
cursor movement. 
The contextual 
menu has the same 
functions in all views.

View tabs in Mac OS X. Use Command-1, 2, and 3 
respectively to change view.  On Windows XP. Use Ctrl-1, 
2, and 3 respectively to change view.
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Making selections
To batch items, you must begin by making a selec-
tion of more than one item. There are several ways 
to select a group of items: 

1. Selection commands: Choose Edit > Select 
All, Deselect All or Invert Selection.

�. A continuous block of items: Select the first 
item and, holding down the Shift key, select the 
last item for your selection.

�.  A selection of non-adjacent items: Hold 
down the Ctrl key (Mac: Cmd key) while select-
ing individual items.

4. A selection of non-adjacent blocks:  
For example, to select items 1-10 and 20-30: 
click 1, Shift-click 10, Ctrl-click 20 (Mac: Cmd-
click), Shift-click 30.

�. Expanding a selection: Select an item or 
block of items and expand the selection by 
pressing the Shift key and one of the arrow 
keys. The left and right arrows increase the 
selection by one item; the up and down arrows 
increase the selection by a row of items.

6. Selection scripts (Scripts > Select):  All Land-
scape will select all items in the catalog that 
are horizontal. All Portrait will select all items 
that are vertical. Perfectly square items will 
not be selected by either script.

7. Selecting based on criteria: To select items 
that match a particular attribute (Capture 
Date, File Type, Label) or annotation (Event, 
Location, People, Keyword, etc.), click on dot 
next to a field term in the Organize Panel’s 
Catalog Fields index and the corresponding 
items appear in the active view. This will hide 
all images that do not match that annotation 
or attribute. Once the appropriate images 
are showing in the active view, choose Edit 
> Select All. Now you are ready to perform 
a batch process. An alternative option is to 
choose Select Media Items from the individual 
field drop-down menu (see figure). This will 
select all items associated with that attribute 
in the active view. 

Individual field term menus offer the option 
to select images associated with that field in 
the active view.

Click the dot next to any field term 
and the corresponding items will 

appear in the active view.
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List View 
In this view of a catalog, your media appear in 
a list of small icons beside information fields of 
your choice, such as file name, size, type, duration, 
etc. To change the fields displayed, use the View 
Options palette in the Window menu. 

To sort the list according to a field, click the cor-
responding field label in the Header bar above the 
list area. Notice that some information is depen-
dent on the file type. For example, the Duration 
field applies only to movies and sounds. 

To change the size of thumbnails in this view, 
use the Size menu and select Small or Large. 

To rename a file, click its name and start typing, 
the same way as you would do on the desktop. 
MediaPro will not rename the item if the original 
file is offline, locked or set to read-only.  Similarly, 
to edit annotations, click the field and start typing 
in the space provided.

By default, the width and height fields are dis-
played in pixels. You can change the unit of mea-
sure in the Dimensions setting of the Preferences 
dialog. 

Though the icons are small, movies and music 
will play in List View. Simply select a file and press 
the spacebar. You can also change views while the 
file is playing.
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Sort list by criteria: 
Click a field name in 
the Header bar to sort 
the list by that field.

List View: Click the List tab to choose this view.

Size menu: Change 
the icons in List View 
to small or large 
(shown left). 

Rename media: Click the name and start typing, the 
same way you would do on the desktop. Similarly, 
annotations can be also be directly edited in List View.

Move media: Click the file’s icon, then drag it to any 
location. A line will mark the new placement.

To change fields 
displayed, select Show 
View Options in the 
Window menu or click 
the toolbar icon.

Header bar: To rearrange the order of header fields, 
click and drag the field name to a new location. 

To resize the width of each column, click and drag the 
dividers in the Header bar.
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Thumbnail View 
This view displays the catalog as a table of thumb-
nails in adjustable sizes. When you select an item 
in the table, the Header bar (see figure above) pres-
ents data about the item. 

Whether the file is available or not, the path 
name for the location of the file and a media-relat-
ed description will appear in the Header. When a 
file is not available, the Header text is colored red. 

To change the position of items in the catalog, 
select one or more items and drag them to the 
desired location. Or, after you made your selection, 
choose any of the Move Items options in the View 
menu. If you choose the Move to Location option, a 
special mouse cursor appears, indicating that you 
can now choose the destination by clicking some-
where in the catalog (you can scroll if you wish). To 
cancel this mode, press the Escape (Esc) key.

Thumbnail size: To define the display size of your 
thumbnails, choose the size you want from the Size 
menu in the far right side of the Header bar. 

If an imported image appears much smaller than 
the thumbnail box containing it, MediaPro has read 

an existing thumbnail rather than create its own 
(this is common with digital camera files). If you 
want MediaPro to create its own thumbnails for 
every file imported, make sure Use Built-in Thumb-
nails is not checked in the Preferences > Media Ren-
dering > Images panel.  

If MediaPro creates its own thumbnail, the size of 
the thumbnail stored will be 320 pixels. 

Altering thumbnails: If a thumbnail of an 
animation or movie file is black or not what you 
want, select the item and play it to a frame you 
like. Then pause the playback and choose Rebuild 
Item from the Action menu. 

For multi-page or multi-layer files, switch to 
Media View and use the Pager tool to advance to 
the page or layer you want to be the thumbnail. 
Then choose Rebuild Item from the Action menu. 
When you return to Thumbnail View, the thumb-
nail is updated to the new layer or page. 

To update the thumbnail of a media file that 
has been modified since it was cataloged, select 
the item and choose Rebuild Item from the Action 
menu.
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Thumbnail View: Click the Thumbnail tab to choose to this view

Header bar: The path 
for the location of the 
file and a media-related 
description will appear 
in the header. For 
unmounted files, this 
text is colored red.

Size menu: Choose 
the size of thumbnail 
to be displayed. 
Regardless of the size 
chosen, MediaPro will 
always create 320 pixel 
thumbnails on import.

Movie thumbnails have 
a small video icon to 
help differentiate them 
from still images.
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Rotating thumbnails
Some images will not appear in the proper orienta-
tion when imported into MediaPro. This is often the 
case with portrait (vertical) film images that have 
been scanned, or portrait images taken with digital 
cameras that do not record the camera’s Orienta-
tion in the EXIF metadata. 

Some newer digital cameras record the EXIF 
image orientation at the time of capture. MediaPro 
respects this orientation setting and automatically 
rotates the image thumbnail accordingly during 
the importing process.

For those files that need to be rotated, MediaPro 
offers three methods of rotating your files to the 
proper viewing orientation. 

1. Rotating thumbnails or “soft rotation”:  
A soft rotation means that the viewing angle 
of an item is rotated, but not the file itself. To 
soft rotate an item, select the thumbnail and 
use the Rotate buttons in the far right side of 
the Header bar (see figure). Each rotation repre-
sents 90 degrees. A soft rotation applies to how 
MediaPro will display the file in all views (List, 
Thumbnail, Media View., Lightbox mode and 
Slide Shows) and how it will export the media, 
such as file conversions, HTML galleries, and 
QuickTime movies. However, if you open the 
file with an external application, such as Adobe 
Photoshop, the media may appear with its origi-
nal orientation.

�. Lossless JPEG rotation: Lossless rotation 
means that the original image is rotated and 
saved without a recompression of the JPEG 
image data. Using this method will prevent 
images from getting more JPEG compression 
artifacts. MediaPro’s JPEG Rotate command 
(Action menu) will perform lossless rotations 
of 90, -90 and 180 degrees. Before applying a 
batch lossless JPEG rotation, be sure that all 
images selected are JPEGs and need the same 
orientation correction. All original annotations 
are maintained with this function.

�. Precision rotation: The Rotate tool in Media-

Pro’s Image Editor is used to adjust the angle 
of images in increments as small as 1/10th of a 
degree. To rotate an image 90 degrees clockwise, 
just type 90 into the Angle field. To rotate counter 
clockwise, place a negative sign (-) in front of the 
number in the Angle field. When you are done, 
click the Save button in the Image Editor palette. 
Depending on your saving options (particularly 
format), some metadata might be lost. See page 
121 for instructions on how to rotate files with 
the Image Editor.

Soft rotation: Some images will not appear in the 
proper orientation when imported into MediaPro (A). 
This can be corrected with a “soft rotation.” Select your 
images in Thumbnail View, then click the appropriate 
Rotate button in the far right side of the Header bar (B). 
Each click will rotate the image 90 degrees. Changing 
the rotation of the thumbnail in MediaPro sets the 
viewing angle of an item in all views. This does not 
change the rotation of the original file.  

A

B

Rotate 90° clockwiseHeader bar
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Improving thumbnail quality
Some applications, such as Adobe Photoshop, 
embed a small, low-quality thumbnail into the 
media file. Digital cameras do this as well. During 
import, MediaPro renders that pre-existing “built-
in” thumbnail and stores it in the catalog file. Main-
taining this default setting makes importing fast, 
but it also makes low-quality thumbnails.

To improve the thumbnail quality, set MediaPro 
to render its own thumbnails on import. Alterna-
tively, you can rebuild thumbnails individually. 
These thumbnails will be superior in quality and 
take up much less catalog space than the built-in 
thumbnails.

Rebuild thumbnails on import: One option is 
to have MediaPro render new thumbnails during 
the import process. This is achieved by leaving the 
Use Built-in Thumbnails option unchecked in the 
Preferences > Media Rendering > Images dialog. 

Keeping this option off will instruct MediaPro to 
create a 320 pixel thumbnail for each media item. 
However, this will slow down the import process, 
because MediaPro needs to render the entire 
image to create a thumbnail. 

Rebuilding thumbnails individually: If you 
have an existing catalog that was created with 
built-in thumbnails, then select the thumbnails 
and choose Rebuild Item in the Action menu to 
have MediaPro recreate all media thumbnails. 
This function is also accessible from the contex-
tual menu.

Changing thumbnail size: The display size 
of thumbnails can be changed in the Size menu, 
located in the far right side of the Header bar. 

Should you increase the thumbnail size beyond 
the size of thumbnails stored in the catalog (as may 
be the case if you are using built-in thumbnails), you 
need to perform a Rebuild Item command on all the 
files in the catalog to render the thumbnails at sizes 
up to 320 pixels.

Digital camera files: Digital cameras, regardless 
of manufacturer, are notorious for creating poor 
quality thumbnails in image files. They appear pix-
elated and fuzzy. Using MediaPro’s Rebuild Item 

command will significantly improve the quality 
of the item’s thumbnail.

Some digital cameras allow photographers to 
shoot pictures with the 3:2 ratio. When the cam-
era creates a thumbnail for this type of image, it 
puts black bars above and below the image to 
make the thumbnail size conform to the standard 
4:3 ratio. To remove these bars and improve the 
thumbnail quality, choose one or more images 
and perform a Rebuild Item command. 

The following pages cover methods of improv-
ing thumbnail quality based on the program that 
created the files.
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A. Built-in thumbnail = 3:2 ratio, black bars, pixelated
B. Rebuilt by MediaPro = smooth, no black bars

A B

A. Built-in thumbnail from digital camera = pixelated
B. Thumbnail created by MediaPro = smooth

A B

Movie file thumbnails: If a thumbnail of an animation 
or movie file is black or not what you want (A), select 
the item and play the file to a frame you like. Then pause 
the playback and choose Rebuild Item from the Action 
menu (B). 

A B

Rebuilding digital camera thumbnails
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Adobe Photoshop
Covers v. 7, CS, CS2
Adobe’s image editing program, Photoshop, 
embeds sharpened thumbnails it saves files. This 
option is controlled in Photoshop’s Preferences: File 
Handling dialog box. When Macintosh or Windows 
Thumbnail is checked, Photoshop CS2 will create 
thumbnails at 160 pixels. There are no options for 
controlling the size of thumbnails.

If you have the Use built-in thumbnails option 
checked, thumbnails for Photoshop files may 
appear smaller than the thumbnail cell container. 
When you rebuild it, the thumbnail size will match 
the rest of your catalog.

In the event that a Photoshop file does not have 
a built-in thumbnail, MediaPro will automatically 
create its own at 320 pixels. The default thumbnail 
size for Adobe Photoshop 7.0 files is 128 pixels; for 
6.0 files it is 112 pixels. 

Adobe Illustrator
Covers versions 6, 7, 8, 9, 10 , CS, CS2
Illustrator does not offer any options for modify-
ing thumbnails in its native format (.ai). By default, 
Illustrator CS2 makes Bitmap PICT thumbnails at 
160 pixels. 

With Illustrator 10 & CS on Mac OS X, however, 
there are some important options. For the best cat-
alogs, iView recommends that you should save files 
with the Create PDF Compatible File option turned 
on. This option makes the file you save a PDF file. 
This option is in the Illustrator Options dialog box,  
which appears when saving an Illustrator file using 
the Save As command.

On Mac OS 10.�.x: If you save Illustrator files 
without this box checked, or as Illustrator EPS, you 
will need to install the Ghostscript extension into 
the MediaPro Importers folder, in order for iView 
to catalog these file types. This extension can be 
found on the download page of iView’s web site.
http://www.iview-multimedia.com/download/

Adobe ImageReady
Adobe’s optimization program, ImageReady, 
does not embed thumbnails in optimized files. 
MediaPro will automatically create its own thumb-
nail for these files. 
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A. Thumbnail created by Photoshop 7.0
B. Thumbnail rebuilt by iView MediaPro

A B

A. Illustrator Bitmap PICT thumbnail - v. 6,7,8,9
B. Thumbnail in Illustrator on Mac OS X, PDF Compatible

A B

Check Create PDF Compatible File for better thumbnails.
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Macromedia FreeHand
Covers v. 9.0, 10 and MX (11)
Macromedia’s illustration program, FreeHand, em-
beds a small thumbnail when it saves files. These 
thumbnails are 112x112 pixels, in the color Bit-
map PICT format. 

Some FreeHand files may have been saved 
without a thumbnail or preview. As a result, these 
Freehand files will have a generic icon.

However, FreeHand has Export Preferences that 
will allow you to make sure a thumbnail is added. 
You can find these options under Preferences in 
the Edit menu (in the Application Menu on Mac).

To get the best thumbnails, iView recommends 
checking the following options:

1. FreeHand file preview: When checked, Free-
Hand documents are saved with a preview embed-
ded. The default is a 112x112 JPEG thumbnail. You 
can increase the width and height of this preview 
to ensure a larger image to display in Media View.

�. Include Portfolio preview: When checked,  
FreeHand documents include a thumbnail bitmap 
preview used by Extensis Portfolio for browsing. 

iView MediaPro will use this preview for display 
in Thumbnail View.

�: Checking the Bitmap PICT preview box may 
cause a color shift and gradient banding to occur 
on CMYK documents. The benefit of checking this 
option is you are able to scale the size of your pre-
view, which is valuable for very large documents.

MediaPro’s Rebuild Item command will not im-
prove the quality of these thumbnails. For more 
information on these Export options, refer to the 
FreeHand Help documentation. 

Adobe InDesign
Covers v. 2.0, CS, CS2
Files created with Adobe’s page layout program, 
InDesign CS2, will have thumbnails if you check the 
Save Document Preview Image option in InDesign’s 
Preferences > File Handling dialog.

This dialog also enables you to define the 
size of preview images which are used to create 
thumbnails in MediaPro. The size chosen here 
limits the size of thumbnails that can be created 
by MediaPro.  Also, MediaPro will fully display this 
preview in Media View. 

In versions 2.0 and CS, InDesign files contain a 
128x128 pixel, color Bitmap PICT thumbnail of the 
first page of InDesign documents. 

Quark XPress 6.0
iView provides you with a special XTension for 
saving Quark XPress documents with previews. 
See MediaPro’s Documentation for information 
and installation instructions.
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A. FreeHand file preview
B. Thumbnail with Bitmap PICT preview
C. Generic Freehand file icon

A B

Choose a preview size for InDesign files in the 
Preferences > File Handling dialog.

C

Macromedia Freehand’s Preferences dialog.
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Media View 
This view displays media files at full size, one at a 
time. Unlike other views, Media View is a real-time 
presentation of the original media files on screen. 
This means that MediaPro needs to have access to 
the file. If the file is not accessible, you will get an 
error message such as “File Not Found”. 

In Media View, you can play animations, movies, 
and sounds, or navigate inside a QTVR image in 
this view. Use the onscreen QuickTime controls 
to interact with movies, music and QTVR.  You 
can also flip through the pages of a PDF or view the 
various layers of a Photoshop document using the 
Pager tool that appears in the Header bar.

When an image doesn’t fit entirely inside the 
window, the cursor changes to a hand. Use it to 
drag the image around. 

You can use the Zoom buttons in the upper right 
side of the Header Bar to zoom in and out. To adjust 
the size of media display in this view, you can use 
the Size menu. Options include: Actual Size, Scale to 
Fit, Fit Width, Fit Height, Pin Larger Side, Pin Smaller 
Side, Tile, and a selection of percentages.

For large media files (above 30 megabytes), there 
can be a slight  delay before the media appears on 

screen. The more powerful the computer, the less 
likelihood there is of a delay.

To print a particular layer or page within a 
composite file, go to the page or layer you wish 
to print and select Rebuild Item from the Action 
menu before printing. For movies and multi-page 
items, MediaPro only prints the frame assigned as 
an item’s thumbnail.
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Media View: Click Media tab to choose to this view

The Scroll bar in this 
view scrolls the catalog, 
not the image. If the 
image is larger than 
your viewing area, your 
mouse will turn into 
a hand ( ) which can 
move the image. 

The Size menu 
modifies the display of 
the image in the Media 
View window. 

The Zoom tools let you 
to increase or reduce 
the size of the image. 

Playback media: Use the onscreen QuickTime 
controls to interact with movies, music and QTVR. 

Pager Tool: When multi-layer or multi-page files are 
presented in this view, the Pager tool will appear in the 
Header bar, so that you may look at different layers or pages. 

Histogram
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Full Screen Previews
You can now choose to have MediaPro create Full 
Screen Previews to be stored with your catalogs. 
Full Screen Previews are large JPEG proxy images 
that will be displayed in Media View when original 
media files are not available for display. 

Full Screen Previews are particularly useful if the 
majority of your media is stored on offline storage 
volumes, such as CD or DVD.  These previews are 
also useful for distributing catalogs without hav-
ing to include the original media files. 

To create a catalog with Full Screen Previews:
1. Create a new catalog.
�. In the Edit menu, select Full Screen Previews.
�. Choose the size of previews to be created.
4. Choose the JPEG compression quality to be 

applied to the preview images.
�. Click the OK button. Import your media items 

and save your catalog.

To create Full Screen Previews  
for older catalogs:
1. Open an existing catalog.
�. In the Edit menu, select Full Screen Previews.
�. Choose the size of previews to be created.
4. Choose the JPEG compression quality to be 

applied to the preview images.
�. Click the OK button. 
6. Choose Select All in the Edit menu or select 

the items that you wish to create Full Screen 
Previews for.

7. Choose Rebuild Item in the Action menu.
MediaPro will need to be able to access the 

original media files in order to create and store 
Full Screen Previews. As such, if your media is 
stored on a CD, DVD or removable storage vol-
ume, you will need to insert or attach that respec-
tive volume before rebuilding items. 

Full Screen Previews and catalog file size
Please be aware that the file size of catalogs with 
Full Screen Previews can be considerably larger 
than catalogs with only thumbnails. 

The size and compression quality of full screen 
previews will also greatly impact the file size of 
MediaPro catalogs (see figure above).

Because MediaPro needs to render the entire 
image in order to create a full screen preview, this 
can slow down the import process. 

The time taken to catalog media will vary based 
on your computer’s operating system and overall 
speed. It will also vary depending on the size of 
the original media file. 
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Without Full Screen Previews
• 1,000 media items
• Storing thumbnails at 320 pixels
• Catalog file size: ��MB

Choosing this option will enable MediaPro to store and 
display full screen previews in Media View when original 
media files are not available for display.

With Full Screen Previews
• 1,000 media items
• Preview size: 800 px | Quality: Normal
• Catalog file size: 6�MB

With Full Screen Previews
• 1,000 media items
• Preview size: 1280 px | Quality: Best
• Catalog file size: �48MB

Catalog file size
The effect of the size and quality of Full Screen 
Previews on the file size of MediaPro catalogs.
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Playback of media
MediaPro can play a wealth of music, video and 
multimedia files. They can be played in any view, 
even slide shows. 

To start playback, select the file you wish to play, 
and press the Play icon in the toolbar. Or, you can 
press the spacebar. To stop the playback, press the 
toolbar’s Play icon or the spacebar.

In Media View, media files such as video, music, 
Flash and QTVR are displayed with QuickTime con-
trols. You can use these controls to regulate play-
back and control volume. Or you can still use the 
toolbar’s Play icon and the spacebar to start and 
stop playback.

One unique feature of MediaPro is that you 
can switch between List, Thumbnail and Media 
view while playing a file, without altering play-
back quality. Simply click the view tab to change 
views.

If MediaPro cannot play your file, define a 
media player application that is capable of play-
ing the file and use it as a Helper Application. To 
learn more about defining Helpers and launching 
files with them, see page 110.

Playlist Mode
Playlist Mode enables you to play the files of a 
catalog in a continuous sequence. This is feature 
is turned off by default. To turn it on or off, select 
Playlist Mode in the Play menu.

This feature is useful when you have a cata-
log of MP3 files that you want to listen to, or a 
sequence of video or still images that you want to 
watch. MediaPro will continuously play the files in 
your catalog in a loop until you tell it to stop. 

To start a playlist, select the file you wish to begin 
with, and press the Play icon in the toolbar. Or, you 
can press the spacebar. To stop the playback, press 
the toolbar’s Play icon or the spacebar.

Playlist Mode will also automatically advance 
through a catalog of images, which is particu-
larly useful in Media View. This feature simulates 
a slide show, while allowing you to see infor-
mation panels open alongside the images. You 

can adjust the delay (short, medium and long) 
between images in Stills Pause section of the 
Play menu.

When Playlist Mode is turned off, media can still 
be played, however MediaPro will not advance to 
the next media item upon playback completion 
of a selected item.
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Playlist Mode: During playback, files being played are 
highlighted with black corners. 

Media View playback: You can use the onscreen 
QuickTime controls to interact with movies, music, 
Flash and QTVR files. 

Toolbar controls: Press the toolbar’s Play 
icon to start or stop Playlist Mode, or to start 
and stop media playback in any view.

List View playback:  Though the icons are small, 
movies and music will play just fine in List View. Simply 
select a file and press the spacebar to start or stop the 
playback of any a file. You can also change views while 
the file is playing by clicking any of the view tabs.
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A good way to increase your efficiency and pro-
ductivity with MediaPro is to customize the work-
space and tailor it to your workflow needs.

Themes - View appearance 
Each view of MediaPro (List, Thumbnail and Media) 
can be customized by using the View Options pal-
ette. You can choose which metadata to display, 
the background color, as well as the font, size, and 
color of display text. The View Options palette can 
be accessed by choosing Window > Show View 
Options or clicking on the View Options icon in 
the toolbar.

In addition to the display, View Options also apply 
to some export functions, such as printing, contact 
sheets and the default HTML gallery theme. 

Each view has its own options. For example, 
changing the text and display options in List View 
will not change the options in Media View.  Visual 
preferences for all three views can now be stored 
as a theme, using the Save function of the View 
Options toolbar icon.

Adjust font and color options
In the first section of the View Options palette:

• Font and Size: Use the drop-down menus to 
select a font and preset point size. 

• Background defines the background color of 
the media viewing area.

• Text Foreground defines the color of text, field 
labels and the media frame.

• Text Background defines the color bar that 
appears behind text. To make this bar appear 
transparent, make this color the same as the 
background color in order.

Set display options: List View
• Frame media adds a one pixel border around 
thumbnails. The color of this frame is defined 
by the Text Foreground color option.

• Use generic icons will change a rendered icon 
to a generic icon.

Customizing the MediaPro workspace

Set display options: Thumbnail View
• Field labels puts the name of the field next to 
the displayed text of that field.

• Frame media adds a one pixel border around 
thumbnails. The color of this frame is defined 
by the Text Foreground color option.

• Center text aligns field text centered. 
• Show scale displays the thumbnail size as a 
percentage of the original media size. 

• Aspect ratio adjusts the proportion of all 
thumbnail containers. These options are valu-
able for saving space in the media viewing 
area, depending on the shape of most media 
in your catalog (Normal [Square], 3:4 Land-
scape, 4:3 Portrait). 

• Margin offers options for a stylized border around 
all thumbnails. Blank adds a small amount of 
white space around thumbnails; Shadow adds 
a drop-shadow to thumbnails; Frame adds a re-
cessed frame around thumbnails.

Set display options: Media View
• Field labels puts the name of the field next to 
the displayed text of that field.

• Center text aligns field text centered. 
• Histogram will display a graph showing the 
relative distribution of Red, Green and Blue 
pixel densities in an image. It shows the num-
ber of pixels with high density on the left 
(darker colors) and low density on the right 
(lighter colors). 

Size menuZoom
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To adjust the number 
of lines used to display 
a field, click the up and 
down arrows. 

Displays number of 
fields shown out of the 
maximum (10).

Background

Text 
Foreground

Text 
Background

Field labels

Show scaleFrame media

Display Options Font & Color Options

Use generic icons (List View)

To adjust the style of the 
font display (Bold, Italic, 
etc.), make a selection from 
the options in the font 
Style menu.

To make a field display in 
a view, click the name to 
place a check mark next 
to the field name. Click 
the name again to hide 
this field and check mark.

To make your current 
settings the default for 
new catalogs, click Save as 
Default.

Save themes: 
For repeat use of your 
settings, save them using 
the Options menu or 
using the View Options 
toolbar icon drop-down 
menu. The settings for 
all three views are stored 
when you save a theme. 

View Options palette

Display the star rating and 
color label assigned to 
each media item.
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Adjust media size in views
To define the display size of previews in List and 
Thumbnail View, select an option from the Size 
menu in the far right side of the Header bar.  Size 
of media can also be defined in the Display Options 
section of the View Options palette.

List View: Choose from Small (16 px) and Large 
(32 px) options. The View Options palette has an 
option to switch from rendered icons to generic.

Thumbnail View: Choose from a range of 
thumbnail sizes from 120 to 320 pixels. 

Media View: Options include: Actual Size, Scale 
to Fit, Fit Width, Fit Height, Pin Larger Side, Pin Small-
er Side, Tile, and a selection of percentages. When 
an image doesn’t fit entirely inside the window, 
the cursor changes to a hand. Use the hand to 
drag the image around in the viewing area.  

In all views, the Zoom buttons (plus and minus 
icons next to the Size menu) increase or reduce the 
size of the thumbnails or media.

Add or remove displayed fields
Located in the third section of the View Options 
palette. A maximum of 10 fields can be displayed 
in each view. 
1. To add a field to a view, click its name in the 

field list area. This will make a check mark ap-
pear by the name. To remove a field, click it 
again and the check mark will disappear.

�. The order in which fields are displayed is 
determined by the order in which they are 
turned on in the View Options palette.

�. Change the number of lines displayed for each 
field by clicking the up/down arrows on any 
active field. This is useful for fields with longer 
amounts of text, such as Caption or Paths.

4. Font styles, such as Bold, Italic, and Underline, 
are optional for each field and can be selected 
in the Style menu for each field name. Multiple 
styles can be applied at the same time.
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Thumbnail View displaying image properties, custom colors, fonts, 3:4 aspect ratio, and a frame margin.
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Info Panel and Catalog Index lists
Some images in your catalogs will have large 
amounts of metadata displayed in the Info Panel. 
To view all of this information, you can scroll up 
and down the Info Panel. However, this task may 
become too cumbersome or repetitive, especially 
when scrolling past empty fields or metadata 
groups that are irrelevant to your workflow.

The same can be said of the Catalog Index in 
the Organize Panel, which is used for sorting and 
annotating images.

As a solution, you can selectively display the 
most relevant fields or groups of metadata in the 
Info Panel and Catalog Index using the List Con-
figuration menu (see figure). 

The state of the Info Panel and Catalog Field 
index lists is unique for each catalog and is main-
tained when saving and closing a catalog.

The List Configuration menu also has the option 
of storing a default state of hidden and shown 
fields, which you can define. 

This default can be useful for workflows that 
focus on a specific subset of metadata. For exam-
ple, your annotation workflow may only require 
data entry in eight of the IPTC annotation fields, 
as well as Keywords. In this case, you can choose to 
store a default that shows only these fields in the 
Info Panel.

Set List Configuration default
1. Define shown/hidden fields: Select Show/

Hide Fields in the list configuration menu. 
Check the box next to the field to show it; 
unchecked fields are hidden.

�. Save configuration: Choose Save as Default 
in the List Configuration menu to store the  
current configuration as the default which  
can be loaded into existing or new catalog. 
This configuration is automatically applied to 
new catalogs. 

�. Load configuration:  Open an existing 
catalog or create a new catalog. Select Load 
Default in the List Configuration menu to load 
previously configured settings.

Configure list: Use the List Configuration 
menu to show or hide properties, annotations 
or groups. Save as Default stores the current 
Info Panel configuration as the default which 
can be loaded into existing or new catalogs.

Catalog Field index - List Configuration menu
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The Info Panel
When a media file is created by a computer or digi-
tal device, information is embedded into the file to 
describe it. This information is called metadata, and 
is used by software programs to accurately under-
stand the media file. 

MediaPro uses the Info Panel to provide an 
instant look at the aggregate properties and 
metadata of a media file, such as file type, size, 
dimensions, resolution, caption, capture date and 
duration. Naturally, this information will change 
based on the media type.

You can edit and check the accuracy of informa-
tion within this single user-configurable list with no 
need to remember to open multiple dialogs.  The 
data inside the Info Panel is split into various sec-
tions. To show the data from one of these groups, 
click the arrow next to the section name. 

Some files will have large amounts of informa-
tion. To view all metadata, you can scroll down the 
panel, or you can hide various sections using the 
List Configuration menu (see figure right). 

Media properties
Media Info: This section displays non-editable 
embedded media-related metadata. Some fields 
your computer assigns to a file, such as type, size, 
creation date and modification date.  

Other fields display information based on the 
media type.  For example, image files will display 
dimensions, resolution, bit-depth, color space and 
profile. Audio files display the type of encoding, 
length of the music, audio channels and data 
about the quality of the sound.

MediaPro also displays the size of text annota-
tions, audio annotations and thumbnail associ-
ated with an item in this section.

Special, extended media-related metadata are 
displayed in their own section. They are:

Photo EXIF: For images created by digital cam-
eras, the Info Panel will display special data (EXIF) 
that was captured and embedded in the photo 

file. This metadata includes the date and time a 
photo was taken (Capture Date), as well as cam-
era-related information, such as shutter speed, 
aperture and exposure. GPS (Global Positioning 
System) information is also displayed in this sec-
tion. Different cameras record different amounts 
of EXIF data. Only the EXIF data captured by your 
digital camera will be displayed here.

Cue Points (Audio and Video): Some audio or 
video media files contain markers, or cue points, 
which define special time stamps in the file. For 
example, an audio file might have cue points 
that mark the chorus, bridge and solos of a song. 
MediaPro lists the name and time stamp for all 
cue points of an item in this section.

Media annotations
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To add a group to the annotation groups 
Categories, Keywords and People, double-click the 
empty field and type the name of the new field.

Configure list: Use the List Configuration 
menu to show or hide properties, annotations 
or groups. Save as Default stores the current 
Info Panel configuration as the default which 
can be loaded into existing or new catalogs.
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Info Panel: To show the Info Panel, click this 
button. To hide it, click the button again.

List Configuration menu

Media information depends on the file type. 
The example at left shows a JPEG photo; the one 
below shows info for an MP3. 

Embedded metadata depends on the file 
type. The figure at left shows the info for a JPEG 
photograph. The example below shows the 
Movie Tracks for a QuickTime movie. 

Captions are descriptions of media, useful 
for additional explanation or thoughts. 
Captions embedded into files will 
automatically be shown here.

Resize the Caption/Description window by 
dragging this bar up and down.

Click arrow to expand and collapse data groups.

Use Metadata template to save/apply a group of 
annotation terms to media files.
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People, Keywords, Categories, Scenes, 
Subject Codes are metadata groups useful for 
describing and organizing the content of your 
media. These groups are part of the IPTC and XMP 
annotation standards.

Catalog Sets displays all associated MediaPro 
sets to which an item belongs. Catalog sets are 
a free form, hierarchical method of organizing 
media files. For more information, see page 74.

Movie Tracks (Audio and Video): Movie files 
usually contain two tracks of digital information: 
one for video and one for audio. However, movies 
can contain multiple video and audio tracks.

This section displays the type of encoding, start 
time, duration, data size, data rate and frame rate 
for each video track of the movie file. For audio 
files, which only contain one track, this section dis-
plays the type of encoding, start time, duration, 
data size and data rate.

Annotations
MediaPro supports a set of pre-defined fields for 
annotating your media. This set (also known as 
the IPTC Core) includes fields that enable you to 
define the author, event date, event information, 
copyright, labels, ratings and more.

IPTC stands for the International Press and Tele-
communications Council. Since the late 1970s, the 
ITPC has focused on developing industry stan-
dards for the interchange of news data. The IPTC 
annotation fields used by MediaPro comply with 
the standard set by this organization.

These fields are also part of Adobe’s metadata 
standard called XMP (Extensible Metadata Plat-
form). MediaPro can read XMP metadata in four 
image file types: JPEG, TIFF, PNG and Photoshop.

Creating or editing annotations in a MediaPro 
catalog does not affect the original files, unless 
you choose to synchronize the catalog items with 
the original files (see page 57).

Caption/Description: The Info Panel also pro-
vides an area to write descriptions of media, use-
ful for additional explanation or thoughts. Cap-
tions embedded into files will automatically be 
shown here.

QuickTime equivalent mapping: Some files 
such as MP3s or movies have QuickTime annota-
tions embedded. These are mapped to annota-
tion fields. 

For example, the Author annotation field is 
mapped to the Artist field of an MP3,  Product to 
the Album name and Title to a song’s Full Name. For 
more information on mapping, see page 139.
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Field names: Some software programs use different 
names for the various IPTC/XMP field names. For 
example, Photoshop CS calls the IPTC Job Identifier field, 
Transmission Reference (see below).  MediaPro provides 
you with option of choosing which field names to 
display: The official IPTC Core names; those names used 
in iView MediaPro 2; or those used in Photoshop CS. To 
change the field names displayed, see the Field Names 
drop-down menu of the Edit > Preferences > General 
dialog. Field names do not affect how annotations are 
written (synchronized) into media files. It is merely a 
visual preference designed to help you choose the 
appropriate field when annotating files.
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Annotating your media
The Info Panel allow in-line editing of annotations, 
captions, keywords, and categories. To add infor-
mation or edit a field, double-click the text box 
next to the field label and type in the annotation 
information.

Two icons at the top of the Info Panel assist in 
the editing of annotations:

  Save modifications permanently. This op-
tion is always applied when selecting a differ-
ent media item or closing the catalog. 

  Discard or clear modifications that you 
have made to annotations.
Adding or editing annotations in an MediaPro 

catalog does not affect the original files, unless 
you choose to synchronize the annotations in cat-
alog items with the original files (see page 57). 

MediaPro allows you to assign and edit annota-
tions individually or batch annotate multiple media 
items, providing you with a quick method of orga-
nization. There are five ways to assign annotations: 
during import;  applying Metadata Templates; data 
entry in the Info Panel; data entry directly in any view;  
and drag-and-drop to the Catalog Fields index.

On Import/Ingestion
In the Import Items from Camera, Disk and URL 
options (File menu), you can define a Metadata 
Template to be applied to every media item dur-
ing import (see figure).

Metadata Templates are useful for saving and 
applying a group of frequently used annotations, 
such as creator information (author, copyright, 
contact information, etc.). See more about creat-
ing templates on the next page.

Info Panel
MediaPro uses the Info Panel to provide an easy 
way to quickly review the aggregate properties 
and metadata of an image. You can also use the 
Info Panel to assign annotations to single item or 
to a batch selection of media items. 
1. Select the item(s) to annotate. 
�. Open the Info Panel: Click on the Info toolbar 

button or select Window > Display > Info 
Panel.

�. Enter data: Type your information into the 
desired Annotations fields (e.g. Caption, Event 
Date, Keywords or Categories). 

4. Apply changes: Click the check mark icon at 
the top of the Info Panel to confirm changes (or 
the X icon to discard changes).

�. Batch: In the confirmation dialog, select Apply 
to All items. Now all selected items have the 
annotations you entered.
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Choose a metadata 
template from this 
drop-down menu to 
apply a group of pre-
defined annotations to 
all imported items. If 
there are no templates 
available, you can create 
one by selecting New 
Metadata Template. 

Metadata Templates are useful for saving and applying 
a group of frequently used annotations.

Save edits Discard edits



Annotations   �1

Metadata Templates
MediaPro provides Metadata Templates — a tool 
for saving a set of frequently used annotations 
and applying them to media items. In previous 
versions of MediaPro, templates were called 
AutoFills.

A metadata template applies Annotations, Peo-
ple, Keywords, Scenes, Subject Codes, Categories and 
Descriptions to each item selected in the catalog.

To create a Metadata Template:
1. Select an item and enter information into all 

annotation fields you wish to save.
�. In the drop-down menu at the top of the Info 

Panel (Pencil icon), choose Save Metadata 
Template. Name your template in the dialog. 

�. Tip: Metadata templates can also be created 
during the Import Items from Camera, Disk and 
URL options 

To apply an Metadata Template:
1. Select a group of media items.
�. In the drop-down menu at the top of the Info 

Panel (Pencil icon), choose a Metadata Template 
in the menu. 

�. A dialog will appear showing the metadata that 

will be assigned by the template. You can turn 
some fields on or off to keep them from being 
applied to media items. Click the Apply button.

�. Click the check mark icon to save the annota-
tions. In the confirmation dialog, select Apply to 
All items. Now all selected items have the anno-
tations assigned by the template.

4. Tip: Choosing Remove Metadata Template will 
provide you with a dialog to remove tem-
plates from the drop-down menu. 
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Add a file to an annotation: Select a file, or group of 
files, then drag-and-drop them on to an annotation 
field (above) in the Catalog Fields index. If you switch 
over to the Info Panel (left), you will notice that same 
annotation is represented in the corresponding field 
for that file. Conversely, if you add metadata to an 
annotation in the Info Panel, it will also appear in the 
corresponding group in the Catalog Fields index.

Apply Metadata Template: Provides options to turn 
some fields from your template on or off.
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Annotating in views
You can now edit any displayed IPTC annotation 
directly in List, Thumbnail and Media views. 
1. Launch the View Options palette (Window > 

Show View Options). In the Fields > Annota-
tions section, click on any field name to dis-
play it in the active view. For more information 
on View Options, see page 43.

�. Simply click on the field in the active view and 
start typing (see figure right). 

Drag-and-drop to Catalog Fields index
The Catalog Index is an alternative way to add 
metadata organization to your media, as opposed 
to entering annotations in the Info Panel. 

All IPTC, XMP and QuickTime standard fields in 
the Catalog Fields index support drag-and-drop. 
Other supported fields include: Catalog Sets, Date 
Finder  and Sample Color. Custom annotation fields 
also appear here (at the bottom of the Annotations 
group) and support drag-and-drop.

Instead of assigning annotations in the Info 
Panel, you can create an annotation field term in 
any of the Catalog Field groups. Then simply drag-
and-drop images on the annotation field value to 
assign it to an item (see figure on previous page). This 
significantly speeds up and simplifies the annotat-
ing process. If you switch to the Info Panel, you will 
notice that same annotation is represented in the 
corresponding annotation field. 

Annotating using the Catalog Fields index
1. Open the Organize Panel: Click on the  

Organize toolbar button or select Window > 
Display > Organize Panel.

�. Display annotation group: Reveal the de-
sired annotation group in the Catalog Fields 
index using the drop-down menu in the 
upper right hand corner of the panel. Expand 
the annotation group by clicking on the 
group name  (e.g. Date Finder, Keywords) to 
show available terms for that annotation. 

�. Add a term: If the annotation value does not 
exist, click the + (plus) icon at the top of the 

Catalog Fields pane. Type the name of the 
term and click OK.

4. Select an item or group of items, then drag-
and-drop them onto the new term. Associat-
ing an item with an annotation in a catalog 
does not affect the original file.

Removing annotations
You can remove the annotation fields from se-
lected items by choosing Action > Clear Annota-
tions. In the pop-up dialog you can choose to Clear 
All annotations or Choose Fields that you wish to 
remove. The latter reveals a list of annotations as-
sociated with all items, allowing you to select the 
fields to remove.
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Clear Annotations > Choose Fields (Action menu) 
reveals the annotation fields attached to item(s), 
allowing you to select the particular field(s) to remove. 

Annotating in views: You can now edit any displayed 
IPTC annotation directly in List, Thumbnail and Media 
views. Simply click on the field and start typing. 



Annotations   ��

Annotation vocabularies
In MediaPro, a vocabulary is a set of annotations.  
When you annotate a media item in the Info or 
Organize panel, there is a list of available anno-
tation terms that appear as a drop-down list. A 
vocabulary, then, is a collection of all those lists of 
known terms for each field. For example, one list 
for keywords, one list for people, etc.

The Vocabulary Editor (see page 27 for more in-
formation) enables you to edit this list; to set up 
annotation terms that are associated with each 
other; create multiple sets of annotations (vo-
cabularies) for different purposes and also lock 
the vocabulary so that only annotation terms in 
a vocabulary can be used.

Entering annotation terms
Each IPTC annotation field has it’s own list of 
terms. Terms for each field, such City and Country, 
can be entered in the Vocabulary Editor. 

Each field will have a handy drop-down menu 
in the Info Panel (see figure right) showing the 
available terms for that field. 

You can browse through the list of terms from 
the drop-down menu, which becomes visible 
when the field is active. To add a word to the se-
lected field, simply scroll through the menu and 
select a word. Notice that when you type a letter 
in the field, the drop-down menu displays the list 
at that point of the alphabetical list.

If the term you want to use is not in the list, sim-
ply type the word and MediaPro adds the new 
term to the vocabulary for that field. 

However, if the vocabulary is locked (con-
strained), new terms cannot be added. To unlock 
the vocabulary, go to Preferences > Vocabu-
lary Editor and uncheck the Constrain editing to 
defined terms box.

Auto-completion
When typing in an annotation field, MediaPro has 
an auto-completion feature that assists in typ-
ing annotation terms. For example, if you type 
“S”, MediaPro auto-completes the term with the 
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Auto-completion: Example of the auto-completion 
feature. The user has typed in “s” and MediaPro fills in 
the rest using the available vocabulary.

Vocabulary: Example of using the field drop-down 
menu to fill in the annotation field. MediaPro populates 
this menu with the available vocabulary. If the term 
you want to use is not in the list, simply type the word 
and MediaPro adds the new term to the vocabulary. 
However, if the vocabulary is locked (constrained), new 
terms cannot be added. To unlock the vocabulary, go 
to Preferences > Vocabulary Editor and uncheck the 
Constrain editing to defined terms box.

Entering metadata: To add a term to any annotation 
field or group, double-click on data entry space next to 
each field name.

Shows vocabulary is locked
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nearest term from the field’s vocabulary starting 
with “S”.

If a word is auto-completed, press the Enter or 
Return key to assign it as the term. Or, you can 
click the Tab key to apply the existing term and 
advance to the next field. 

Vocabulary terms are saved globally and are 
accessible by every catalog you create. 

Modifying vocabularies
Each field’s list of terms is stored as a separate text 
file inside the user-defined MediaPro Plug-Ins > 
Vocabulary folder (see page 5). You can use any 
text editor to edit these files. Each item in the list 
must be followed by a carriage return.

Locking a vocabulary
If you wish to preserve the a vocabulary so that 
new terms cannot be added, go to Preferences > 
Vocabulary Editor and check the Constrain editing 
to defined terms box.

An example of when this might prove useful is 
if a photographer hires an assistant to help enter 
annotations. By requiring the assistant  to choose 
from existing annotation terms the photographer 
ensures the annotations will match existing ones 
and would result in a much more accurately an-
notated catalog.

Alternate vocabularies
The majority of MediaPro users will only need to 
use one vocabulary. Default is the vocabulary that 
is created when MediaPro is first launched. 

MediaPro can have multiple vocabularies. 
This is useful if you have many different uses for 
MediaPro. You might regularly take photos for cli-
ents in the fashion industry, stock travel agencies 
and also take personal photos. 

You could create a vocabulary called Personal 
and this would contain, among other annota-
tions, the names of your family and friends in your 
photos.  You can choose this vocabulary when an-
notating personal photos and switch to another 
vocabulary for the photos for your clients.  This 

way by switching between the two vocabularies 
you will be see annotation terms appropriate to 
the catalog at hand.

For more information on vocabularies and cre-
ating alternates, see page 27.
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Entering terms: In the Info Panel, double-click to add 
keyword. Begin typing the term, and MediaPro’s auto-
complete function will automatically type the nearest 
available term in the vocabulary.

Separate keywords: When you are done entering a 
string of terms, press the Return or Enter key. MediaPro 
will automatically split multiple terms in separate 
keywords. This is handy if you cut and paste a comma 
separated string of terms into one field. MediaPro 
automatically converts the string into single keywords.

Term descriptions: When you select a term in the Info 
or Organize panel, the term description will appear to 
the right of the annotation in grey. Term descriptions can 
only be defined in the Vocabulary Editor.
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Annotation scripts
MediaPro offers some special annotation scripts in 
the Scripts > Annotate menu:

• Copy Photo Data to Clipboard copies all EXIF 
photo metadata to the clipboard.

• Import From PhotoDISC™ (Mac) annotates 
images in your front catalog, using text files 
located in your PhotoDISC™ CD-ROM.

• Make Caption from Photo Data copies all EXIF 
photo metadata into the Caption field. 

• Make Caption from Text Files (Mac) searches for 
.txt files in the same folder as the original, and 
copies the contents into the caption field.

• Make Caption from Text Lines (Mac) opens a 
text file and uses each line of the file as the 
caption for the selected items.

• Make Event Date from Capture copies the 
EXIF Capture Date into the Event Date of the 
Annotations pane. 

• Make Keywords from Folders (Mac) enables 
you to add keywords to media files from 
folder names. The dialog provides the option 
of defining the level of folders in the path you 
would like to use for keywords. 

• Make Product from EXIF Data (Mac)  
copies the EXIF Maker and Model fields and 
puts them into the Product field of the Anno-
tations pane.
You can modify existing scripts or create and 

attach your own annotation scripts at any time. 
Simply write the script, then place it in the user-
defined Plug-ins > Scripts folder (see page 5).

Modifying digital camera metadata
For photographs taken with digital cameras, the 
Info Panel will display special data (EXIF) that was 
captured and embedded in the media file. This 
data is not editable, with two exceptions: 

Set Capture Date (Action menu): Digital cameras 
record the date and time a photograph is cap-
tured based on the internal clock of the camera. 
If this clock is not correct, the date and time can 
be reassigned using this function.  This operation 
cannot be undone and applies only to images 

taken with digital cameras. You can also batch this 
operation by selecting multiple images.

Note: The Correct EXIF orientation function was 
previously an AppleScript that would will rotate 
the thumbnails of all selected items to correct any 
values of the Orientation field written by your dig-
ital camera. This function is now done automati-
cally during import. 
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Set Capture Date: This operation will change the date 
recorded by your digital camera in the original image file.
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Custom annotation fields
iView MediaPro supports up to 16 custom anno-
tation fields. These fields are useful for creating 
additional metadata associated with a specific 
project, client or storage location. 

To add or remove custom fields, choose Edit > 
Custom Fields (see above). If these custom fields 
are necessary for all your catalogs, click the Save as 
Default button in the lower left and these custom 
fields will appear in all new catalogs.

Once defined, custom annotation fields can be 
used in various sorting and searching functions 
of MediaPro, such as: the Info Panel’s Annotations 
data entry fields; the Catalog Index’s Annotation 
Organizer; the Sort toolbar menu; View Options to 
be displayed in List, Thumbnail and Media Views; 
and as fields to be searched in the Find dialog.

When you move images between catalogs, 
custom fields are automatically adjusted between 
the catalogs. If two catalogs contain more than 16 
unique custom fields, the first 16 fields alphabeti-
cally will be retained.

Custom fields: MediaPro supports up to 16 custom 
annotation fields. To add or remove custom fields 
choose Edit > Custom Fields. These fields will appear as 
part of the Annotations group in various functions.

Once defined, Custom Annotation Fields can be used 
in various sorting and searching functions of MediaPro, 
such as the Info Panel (A), Catalog Index (B), Sort toolbar 
menu, View Options and the Find dialog (C).

To make custom fields appear in all new catalogs, click 
the Save as Default button.

A
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Sync annotations 
Adding annotation information to media items in 
a MediaPro catalog does not embed annotations 
into the original file. The annotations only exist in 
the catalog.

To write or embed annotations into a file, use 
the Sync Annotations function in the Action menu. 
This command allows you to embed annotation 
information from the catalog into the original files. 
It also allows you to import annotations, by rescan-
ning files for metadata added outside MediaPro 
with another application. 

The synchronizing function only applies to 
annotations that are part of the IPTC, QuickTime 
or XMP metadata standards. Custom annotation 
fields and Catalog Sets are now written to files as 
part of the XMP standard.

This function is particularly useful, as MediaPro 
allows you to view, classify and batch annotate 
a large number of media items and then export 
the changes to the original files, saving hours of 
time opening and editing individual files. It is also 
useful for updating annotations that have been 

modified by applications outside MediaPro.
Annotations that have been written into the file 

can be read by other applications that can read 
the IPTC, QuickTime or XMP metadata standards, 
such as Photoshop or GraphicConverter.

MediaPro supports the export of XMP metadata 
to JPEG, TIFF and Photoshop formats only. 

Synchronizing cannot be undone.
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Sync Annotations: With this function, you can export 
(or write) annotations from catalog to original files. You 
can also import annotations from original files.

Sync: If you create annotations in MediaPro and export them to the original files, other applications such as Adobe 
Photoshop can read the metadata. Conversely, annotations added in Photoshop can be imported by MediaPro.
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Import annotations
This function is useful if you have edited anno-
tations in a file outside of MediaPro. Using this 
function will instruct MediaPro to reimport the 
annotations for that file.
1. Select an item or group of items.
�. Choose Action > Sync Annotations.
�. Click the radio button for Import annotations.

Export annotations
1. Select an item or group of items.
�. Enter all your annotations.
�. Choose Action > Sync Annotations.
4. Click the radio button for Export annotations. 

The amount of time it takes to write annota-
tions back to files depends on the number 
of files selected. Regardless, it should be rela-
tively fast.

Special annotations plug-in for Adobe CS
The Status, Event, and People IPTC fields are not 
supported by Adobe Creative Suite. To extend sup-
port of these fields to Adobe Photoshop CS, iView 
provides a custom plug-in so that you can view 
and edit these annotations in the File Info dialog 
of Photoshop.

This plug-in also extends support of MediaPro 
Catalog Sets and any custom annotation fields cre-
ated in MediaPro.

To install this plug-in:
1. Find the plug-in called iViewPanel.txt. It is lo-

cated in the iView MediaPro > Documentation 
> Adobe CS File Info Panel folder.

�. Place it in one of the following locations: 
Mac OS X 
{Root Volume}/Library/Application Support/
Adobe/XMP/Custom File Info Panels 
or: 
{User Directory}/Library/Application/Adobe/
XMP/Custom File Info Panels 
Windows 
\Program Files\Common Files\Adobe\XMP\
Custom File Info Panels 

or: 
\Documents and Settings\<user>\Application 
Data\Adobe\XMP\Custom File Info Panels

Extract metadata
This function (Action menu) will export text, image 
or sound files corresponding to selected media 
items. New files will be created in a single folder 
and can later be used to import metadata to one 
or more files. Options include:

Editable annotations: This feature extracts all 
editable ITPC/XMP annotations for each file and 
saves them as an Adobe Photoshop XMP sidecar 
template file. This function applies only to se-
lected items.

Image thumbnails: This feature (previously 
known as Extract Thumbnails in the Make menu) 
saves thumbnails of a catalog as a high quality 
JPEG image files. The dimensions of the extracted 
file will match the dimensions of the thumbnail 
defined in Thumbnail View.  This function applies 
only to selected items.

Voice recordings: This feature (previously 
known as Extract Voice Annotations in the Make 
menu) saves an embedded voice annotation as a 
separate Sound, AIFF or WAV audio file. This func-
tion applies only to selected items.

Extract Metadata: provides the option to export 
annotations, thumbnails and voice recordings for 
selected media items.
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Color profile management 
MediaPro supports ICC color profiles for image files 
in the JPEG, TIFF, PICT, PDF, and Adobe Photoshop 
formats. This enables MediaPro to provide color 
profile management from input source and iView 
catalog to proof and final printing.  

MediaPro provides you with color accurate dis-
play in all views – List, Thumbnail, Media, Lightbox 
and Slide Shows – using your operating system’s 
color management technology (ICM on Windows; 
ColorSync on Mac).

To turn color profile matching off, uncheck the 
Color Match box in the Preferences > Media Render-
ing > Images of the Edit menu (Mac: Application 
menu).

Manage color profiles
The Manage Color Profile function (Action menu) 
allows you to embed RGB and CMYK color profiles 
for individual files using profiles defined by your 
operating system’s color management technol-
ogy (ICM on Windows; ColorSync on Mac). 

When the dialog launches, MediaPro displays 
the image in Media View, allowing you to preview 
the application of various color profiles. You can 
also remove profiles in this dialog.

If this menu option is not available, it means you 
need to turn on Color Match in the Preferences > 
Media Rendering > Images of the Edit menu (Mac: 
Application menu).

Batch assign profiles
1. Preferences: Turn on the color profile match-

ing preference by checking the Color Match 
box in the Preferences > Media Rendering > 
Images of the Edit menu (Mac: Application 
menu).

�. Select items to batch: Select a group of 
images, then choose Action > Manage Color 
Profiles.  If this menu option is not available, it 
means you need to turn on the  color profile 
matching preference.

�. Choose profiles: Select a color profile to 
embed for each type of image color space 
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Preferences: To turn on color profile matching in 
MediaPro, check Color Match in the Preferences > Media 
Rendering > Images dialog of the Edit menu (Mac: 
Application menu).

Manage Color Profiles: (Action 
menu) When managing the profile 
of a single image, MediaPro will 
switch to Media view so that you 
can preview your changes.  

This pull-down menu provides 
complete access to profiles defined 
by your operating system’s color 
management technology (ICM - 
Windows; ColorSync - Mac.) To learn 
more about color profiles, see your 
system’s help documentation.
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– RGB, CMYK, Grayscale.  This prevents you from 
embedding an inappropriate profile that could 
potentially ruin the image.  The options in each 
menu are defined by the operating system’s 
color management technology (ICM on Win-
dows; ColorSync on Mac).  

4. Apply: Click OK. While embedding the profiles 
into the original files, MediaPro will create a 
new thumbnail for each image according to 
the new embedded color profile.

�. Batch remove: You can also batch remove 
profiles in this dialog by selecting Remove Em-
bedded Profile for each image color space.

6. Tip: For older iView MediaPro catalogs that 
contain thumbnails which are not color 
managed, select all items in the catalog and 
choose Action > Rebuild Items. This will create 
new thumbnails for all images according to 
the new embedded color profile and the set-
tings of the Size menu.

Catalog Fields: You can sort catalogs based on Color 
Profiles by using the Catalog Fields index. The Color 
Profile section is read-only a does not support drag-and-
drop assignment of profiles.
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Batch: Each Batch Profiles menu provides complete 
access to profiles defined by your operating system’s 
color management technology (ICM on Windows; 
ColorSync on Mac.) To learn more about color profiles, 
refer to your system’s Help documentation.

Online resources
• Apple ColorSync 

http://www.apple.com/colorsync/
• Microsoft ICM 

http://msdn.microsoft.com/library/
en-us/icm/icm_6ulv.asp

• International Color Consortium 
http://www.color.org/
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Voice annotations 
Voice annotations are short audio recordings 
embedded in media files. Some digital cameras 
and other image capturing devices allow you to 
save voice comments with a picture.

To listen to audio annotations, select an item 
in your catalog and press the spacebar, or choose 
Listen in the Voice annotation drop-down menu of 
the catalog toolbar (microphone icon). 

The drop-down menu allows you to record up to 
30 seconds of voice annotation. This voice annota-
tion is stored in the MediaPro catalog.  You can also 
attach a separate sound file with the Import option. 
This tool also allows you to remove a voice annota-
tion. The compression ratio for voice annotations 
can also be adjusted in this menu.

Voice annotations can be used in Slide Show 
presentations. This feature is enabled by default. 
To disable it, uncheck Play voice annotations in the 
Slide Show options.

Sample colors
iView MediaPro offers the ability to identify media 
(images, movies, etc) by a single color, called a 
Sample Color. This is useful when searching for 
images of a specific color or tone. 

A sample color is automatically generated when 
the media is imported, based on the dominant 
color of the image.  However, you can set the sam-
ple color of the selected media items with the Set 
Sample Color option in the Action menu. Use the 
color picker to choose a sample color. 

Sample colors can be viewed and modified in 
the Catalog Fields window of the Organize Panel. 
You can switch the sample color of an image in 
the Catalog Fields by dragging the image onto 
one of the colors in the Sample Color list.

A
n

n
otation

s

StopRecord Play: use to review recorded 
annotation before saving.

Record voice annotation dialog

Catalog Index: You can sort catalogs based on Color 
Samples by using the Catalog Index. The Sample Colors 
fields support drag-and-drop assignment.

Color picker: 
You can set the 
sample color of 
selected media 
items with the  
Set Sample Color  
option in the  
Action menu.  
Use the color  
picker pop-up 
dialog to define a 
Sample Color. 
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Reviewing and marking media

Once you have imported a collection of media into 
a catalog, you will likely want to review and clas-
sify the media. For example, after importing images 
from a shoot, photographers typically edit images, 
marking their favorites and unusable ones. 

To assist in this process, MediaPro provides two 
methods of classifying and ranking media: star rat-
ings and color labels. Using keyboard commands, 
labels and ratings can be easily assigned in any 
view, the lightbox and during slide shows.

Rating media
Star ratings provide a ranking system for items in 
your catalogs.  You can now rank your media from 
one to five stars, or no stars.

Assign a rating
Once you have selected one or more items, you 
can add a rating three ways: 
1. Choosing a star rating from the Rate Media 

drop-down menu in the toolbar (see figure), or 
in the contextual menu.

2. Pressing Ctrl + a number, 1-5 (Mac: Cmd+1-5). 
This will apply the associated rating (e.g. 3 = 
Three stars).

3. Drag-and-drop items onto the Rating section of 
the Catalog Field index of the Organize Panel. 

Remove ratings
Select one or more items and: 
1. Choose None from the Rate Media drop-down 

menu in the toolbar, or from the contextual 
menu in any view. 

2. Select an item and press Ctrl + the number 
zero (0). On Macs, press Cmd+0.

Show files associated with a ratings
Select one or more items and: 
1. Click a rating in the Rating section of the Cata-

log Field index of the Organize Panel. 
2. Select Show Rated (Find menu). All rated items 

will be displayed in the media viewing area. 
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Assign label toolbar icon, and drop-down menu and 
the Rate media toolbar icon, and drop-down menu. 
Use any of the associated numbers to apply a label to a 
file in your catalog while in any view, even slide shows. 
Use Ctrl+1-5 (Mac: Cmd+1-5) to apply a rating to a file 
in your catalog while in any view. These menus are also 
accessible from the contextual menu.

Catalog Fields: Assign or sort items with labels or ratings. 
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Ratings as annotations
Ratings in MediaPro are mapped to Adobe’s XMP 
standard for ratings. When annotations for images in 
a catalog are synchronized (written) to the original 
files, all ratings will be written into the files. If you 
open the media in Adobe Bridge, the star ratings 
will be displayed. Likewise, if you assign a rating in 
Adobe Bridge,  the star rating will be reflected in 
your MediaPro catalog.

Color labels 
Labels provide a visual identification and classifi-
cation system for items in your catalogs. 

A color label can be used to: mark favorite 
items; mark items to delete, archive or convert; 
or to track items that are in different stages of a 
workflow (See example A). 

After you label your items, you can quickly sort 
the catalog using  the Label section of the Catalog 
Field index in the Organize Panel.

A label can also be used as a temporary method 
of marking items that will be later assigned a par-
ticular annotation. After assigning the annotation, 
the labels can be cleared from the images.

To accommodate your desired method of mark-
ing items, the colors and names of labels can be 
customized in MediaPro as a global application 
preference. Because this customization is global, 
shared catalogs will inherit the label names and 
colors of the user that is opening the catalog and 
not the preferences of the person who created 
the catalog.

Customize labels
1. Open Preferences by choosing Edit > Prefer-

ences > Labels (Windows) or iView MediaPro 
> Preferences > Labels (Mac OS X).

�. Click the color swatch you wish to change. 
This will launch the operating system’s color 
picker, where you can define a custom color. 
Colors can be adjusted for aesthetic preference 
or to better match the tone or contrast of a par-
ticular view background color (see example B).  
Colors can also be matched to a labelling 
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C: Named to match the 
IPTC Urgency values.

B: Lighter palette designed 
for dark backgrounds.

Color label preferences:  A - Customized colors and 
names to assist a workflow.

Ratings marked in Adobe Bridge are viewable in your 
MediaPro catalog. If you assign a rating in MediaPro and 
synchronize (write) it to the file, it will conversely be 
shown in Adobe Bridge (above).
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scheme in another application or environ-
ment, such as Mac OS X system color labels. 

�. Select any label text and type a new name. 
Customizing a label name helps to remember  
the label’s purpose or definition. 

4. Tip: Custom names used for labels become 
indexed as search terms for associated items in 
iView MediaPro.  For example, if a label is named 
“Client Picks,” then any free-form text search in 
the MediaPro toolbar for the word “client” will 
return images assigned with that color label.

Assign a label
Once you have selected one or more items, you 
can add a label three ways: 
1. Choosing a color from the Assign Label drop-

down menu in the toolbar (see figure opposite 
page), or in the contextual menu.

2. Pressing a number key (1 through 9). This will 
apply the associated color (e.g. 1 = Red).

3. Drag-and-drop items onto the Label sections 
of the Catalog Index. 

Remove labels
Select one or more items and: 
1. Choose None from the Assign Label drop-

down menu in the toolbar, or from the contex-
tual menu in any view. 

2. Select an item and press the number zero (0).

Show files associated with a label
Select one or more items and: 
1. Click a color label in the Labels sections of the 

Catalog Index. 
2. Select Show Labelled in the Find menu.  This 

will display all labelled files in the media view-
ing area. Labelled files can also be sorted dur-
ing slide shows. Use the Show Labelled drop-
down menu in the Slide Show controller.

Methods for using labels
A label can stand for anything you want — favor-
ites, items to discard or items that are in different 
stages of the editing process. 

One popular method of using labels is to 
mark favorite selects (and items to delete) after a 
photo shoot. After importing images into a cata-
log, launch a slide show or the Lightbox. As you 
review the images, use one label to mark the best, 
and another label to mark images that are out-of-
focus and unusable. This can be done during the 
slide show (or in any view) by pressing the label’s 
corresponding number key.

Afterward, you can use the Label section of the 
Catalog Field index (Organize Panel) to show only 
the best images from a shoot in your catalog.

Labels as annotations
Labels in MediaPro are mapped to the IPTC stan-
dard’s Urgency annotation field. When annotations 
for images in a catalog are synchronized (written) 
to the original files, all images tagged with a label 
will have the corresponding label number (1-9) 
written into the Urgency field. For Photoshop CS 
users, these are the same values used in the Urgen-
cy field of the File > File Info > Origin panel.

Even if you have customized the colors and names 
of labels, the values 1-9 are written into the Urgency 
field in order to comply with the IPTC annotation 
standards. If the Urgency field is important to your 
workflow, you might customize the label names to 
match the standard (see example C, pg 63).

Inline assignment : Labels can now be edited inline by 
clicking on the color label field in any view.
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Lightbox
The Lightbox mode is the best way to view an 
image or compare up to four different images at 
once.  To use the Lightbox mode, select between 
one and four images and choose Lightbox from the 
View menu, or use the keyboard shortcut,  Ctrl + / 
(Mac: Command + / ).

When you first launch the Lightbox the Help 
menu appears showing the navigation and key-
board shortcuts. While in Lightbox mode, use right 
click (Mac: Option+Click) to show the contextual 
options menu that includes the option to show  
this initial help menu again.  See page 135 for a 
list of all Lightbox keyboard shortcuts.

The default display of the Lightbox is the cho-
sen number of images shown in a Grid layout (2x2) 

with a toolbar for each image. The toolbar shows 
the color label, filename, dimensions and scaling 
percentage of each image (see figure below). 
The toolbar also displays buttons for trashing or 
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Comparing media: MediaPro’s new Lightbox mode is the ideal tool for viewing and comparing images.

Layout: Choose between Grid (top), Landscape (above) 
and Portrait modes for image display.

Label, rating 
drop-down menus

Media Info: Filename, Dimensions, 
Scale Percentage

Remove/Trash Rotate Size
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removing images, rotation and display size.
When you have more than one image showing 

in the Lightbox, try using the Landscape, Portrait 
and Grid layouts (hotkeys L, P and G respectively) 
to use your monitor space as efficiently as possi-
ble.  Which layout works best for you depends on 
the orientation of your images, how many image 
you view at once and wether you want to see the 
toolbar and/or the histogram. You may wish to 
hide the toolbar to maximize the viewing area 
for each image (hotkey T).

The trash/remove button gives you two options: 
Move to Trash and Remove From Catalog.  The first 
option removes the image from the catalog and 
moves the original image file to the trash or recy-
cle bin.  Be careful when using this option. Do not 
use this unless you are sure you want to delete 
the original file.  The second option removes the 
image from the MediaPro catalog and leaves the 
original file untouched.

Marking images
Color labels are set using the normal label hotkeys 
(1-9, 0 [zero] to remove a label).  When more than 
one image is shown the color label is applied to 
the image that the cursor is currently over.  These 
are the same labels used through out MediaPro.  

You can also mark images using star ratings. 
Use keyboard shortcuts Ctrl+1-5 to set the rating 
and Ctrl+0 (zero) to remove any rating. See page 
62 for more about labels; page 63 for ratings.

Adjusting image size
The toolbar’s size menu (magnify symbol) offers  
several options to define the scale of images 
displayed within each Lightbox cell. These size 
options are the same as MediaPro’s Slide Show 
and Media View modes. 

To zoom in on an image, use the + (plus) and 
- (minus) hotkeys. If Scroll Lock is on, all images 
will increase and decrease by the same magnifica-
tion. If Scroll Lock is off, only the scale of the active 
image will be adjusted.

Scroll, Scroll Lock and Zoom
When an image is bigger than the window it is 
in,  your cursor will turn into a hand ( ) which can 
move the image by dragging (clicking and hold-
ing while moving the mouse).  

When more than one image is shown in the 
Lightbox, all shown images will be moved simulta-
neously while Scroll Lock (hotkey S) is on.  If any of 
the images do not move when scrolling in this way 
it is probably because they fit the current window 
and there is no more of the image to show.

When Scroll Lock is turned off, only the image 
under the cursor is moved by dragging. Scroll 
Lock is useful when examining an important area 
of similar images.

By zooming in and scrolling to the part of an 
image you are interested in, the other shown 
images will show the same portion of the image.

If the images are not absolutely identical you 
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Contextual Options menu: Right-click (Mac: Option-Click) on any image to display the Lightbox Options menu.
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may need to toggle Scroll Lock off and move the 
image individually.  Remembering the hotkey (S) 
for the Scroll Lock makes viewing similar images 
much faster.

Next and Previous images
The right or down arrow key changes the image 
in the Lightbox to the next one in the catalog.  The 
up or left arrow key changes to the previous one.  

When there is more than one image onscreen, 
the image that is changed is the one the cursor is 
currently over.  When changing the image using 
the cursor keys, the current zoom and scroll posi-
tions are maintained to make it easier to examine 
the same point on similar images.

Pixel Magnifier
The Pixel magnifier is a floating palette that shows 
a close up of the image area underneath the cur-
sor.  To turn on the pixel magnifier, use the M 
hotkey.  The pixel magnifier can be quicker than 
zooming and scrolling, particularly when there is 
more than one area in any particular image that 
you need to examine closely.

The slider controls how far the magnifier zooms 

in.  There are four settings from the least magni-
fied at the bottom to the most, at the top.  The 
slider snaps to one of these four settings. 

The pixel magnifier also shows the X/Y coor-
dinates of the cursor (highlighted by a green 
square), as well as the RGB color values.

Using the Histogram and  
Exposure warnings to judge images
When viewing images you may wish to view a 
Histogram and Exposure warnings for each image, 
(hotkey H to show/hide the histogram and W for 
the exposure warnings).

A histogram is a graph showing the relative dis-
tribution of Red, Green and Blue pixel densities in 
an image. It shows the number of pixels with high 
density on the left (darker colors) and low density 
on the right (lighter colors). Its purpose is to show 
the distribution of tone throughout an image. 

For example, an image with no shadows will 
have a histogram with a valley on the left; a histo-
gram with no highlights will have a valley on the 
right. Dark shadows will be seen as a peak of all 
three colors to the left and bright highlights a peak 
of all three colors of the right. 
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The Pixel magnifier shows a close up of the image area underneath the cursor.

Use slider to 
adjust zoom.

RGB color values and X/Y coordinates apply to this green square. 
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The exposure warnings will show areas of pos-
sible over exposure in an image as solid red rep-
resents, under exposure in solid blue.  Both over 
exposure and under exposure are areas of an 
image where detail may be lost due to too much 
or too little light being captured.  

Exposure warnings only indicate areas of an 
image that might be over or under exposed  For 
example, these warning areas may be of a very 
dark or light object that simply appears as it 
should or parts of an image may intentionally be 
very dark or light.

If we consider the histogram for the image A 
(above), it is biased towards the right, the green 
and blue colors reach the top of the chart at the 

extreme right side.  We could consider that this is 
an image of a intentionally very bright summer 
scene, so the strong sunlight, blue sky and aqua 
marine pool are just reflected in the histogram.

Examining the exposure warnings for this 
image (A), as we might expect, the left the whole 
sky is colored red to warn us of possible over 
exposure. There is no detail in the sky in this image 
because the sky has been over exposed. The per-
son is the focus of this image and the band of 
white sky works quite well with the other two 
horizontal bands created by the sea and the pool.  
So, for this image, whether it would be improved 
by editing is a subjective.

So the histogram and exposure warnings simply 

A

B

B

A
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Original images, with no exposure warnings.

Judging images:  Lightbox showing exposure warnings and histograms.
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gives us an indication of areas we might want to 
consider improving through editing.

But lets compare this with image B. It shows 
a similar pattern of the red, green and blue with 
both images showing red towards the middle 
with lots of green and then blue as we go to the 
light side of the histogram.  

The histogram, for the image on the right, is 
still biased towards the right but not to the same 
degree as the other image, the pixels are spread 
across the mid section of the histogram not just 
the very light side. With a more balanced histo-
gram we would expect to see a wider range of 
tones. Both the pool and the sky are deeper in 
tone and there is some detail in the sky.

Looking at the exposure warnings, a smaller 
area of the sky is red and this is a broken up area, 
rather than the solid area in the left hand picture. 
Certainly, from the point of view of the sky, the 
image on the right is better. There are solid areas 
of red on the side of the models face, indicat-
ing over exposure, but this is direct sunlight and 
since the subject of the image is sunbathing this 
works well. Part of the models hair shows as under 

exposed but again that is not necessarily an indi-
cation of a problem.

One opinion may be that the image on the left 
would benefit from editing and the image on the 
right less so. A balanced histogram is normally 
considered better although there is no ideal his-
togram.  Areas shown as possible over and under 
exposure are things to consider when viewing 
your images. 

In the end, whether an image is good or can 
be improved is subjective. The histogram and 
exposure warnings should help you make your 
decision. Knowledge of digital image editing 
techniques will help you know what to look for 
when using both these tools. Please read the 
documentation provided with your image edit-
ing software for more information.

Adjusting Lightbox exposure warnings
You may want to adjust the sensitivity of exposure 
warnings. To define the under and over exposure 
values that trigger red and blue warnings, see the 
Lightbox Warnings section of the Preferences > 
Media Rendering > Images dialog. 
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Red warnings indicate potential over exposure. Blue warnings indicate potential under exposure.

Histogram



70    IV IE W MEDIAPRO USER MANUAL

Moving media in catalogs 
To rearrange items in a catalog, click and drag 
them to where you want and drop them. You can 
drag single items or groups of items.

In previous versions of MediaPro, you could 
rearrange media files using the Move Items func-
tion in the toolbar. This feature has now been 
moved to the View menu. Moving functions are 
also accessible in the View sub-menus of the con-
textual menu.

This feature enables you to move media items 
to the top, or bottom of a catalog. You can also 
move an item or group of items to a specific loca-
tion within the catalog.  

When you choose the Move to Location func-
tion, the cursor will turn into a crosshair. At this 
point, use the scroll bars to go to any location 
in the catalog, then place the crosshairs at the 
desired location and click. Your media items will 
drop into the new location. This feature is particu-
larly useful for moving files in catalog with a large 
number of files, most of which are not visible in 
the viewing area.

Move Again will repeat the last move made in 
the catalog, whether it be to the top, bottom, loca-
tion or a manual drag-and-drop.

Move to New Catalog will take selected items 
and create a new MediaPro catalog with them. It 
does not remove selected items from the current 
catalog.

Organizing catalogs
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When dragging items to a new location, a black bar 
appears in the location where the files will be placed.

The Organize Panel has two windows: Catalog Fields 
and Catalog Folders. To show/hide this panel, click the 
interface Organize button. Drag the divider to adjust the 
size of the two windows. 
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The Organize Panel
The Organize Panel has two windows: Catalog Fields 
index and Catalog Folders. To show or hide the Orga-
nize panel, click the interface button.

Catalog Fields index
The Catalog Fields index is good for global searches 
or groupings, allowing a quick comparison across 
hundreds of files, often revealing annotation incon-
sistencies among a large number of files. By view-
ing your media from a global rather than individual 
perspective, you ensure the standardization and 
accuracy of annotations across your media.

The Catalog Fields index lists all annotations or 
tags present in the catalog. By dragging media 
items and dropping them on the existing data 
values, you can assign these values to the mul-
tiple media items. This significantly speeds up and 
simplifies the annotation process.

The Catalog Fields index has two types of 
groups. Read-only groups, such as File Type and 
Import Device are attributes that are automati-
cally read by MediaPro and cannot be reassigned. 
Annotation groups, such as Date Finder or Key-
words, are used to categorize the media and can 
be changed at any time. 

Use the Catalog Fields index list configuration 
menu to show/hide various media attributes and 
annotations. To expand a field, click the arrow next 
to its name. 

The Catalog Fields index has three sections:

Basic Fields section
Label and Rating: Use this group to show files 

with a color label or star rating (see page 62).
Sets: Catalog sets are a free form, hierarchical 

method of organizing media files. You can use 
sets to organize playlists, photo albums, projects 
or work assignments (see page 74).

Date Finder: When files are added to your cata-
log, MediaPro searches for dates already embed-
ded in the media. In this order, it looks for the 
Event Date (IPTC), then the digital camera  Cap-
ture Date (EXIF), then the File Creation Date. If a 
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Catalog Fields configuration menu: Use this menu to 
show/hide various media attributes and annotations 
that you can use for sorting and organizing items.

Read-only groups: These fields show embedded media 
attributes that are automatically read by MediaPro and 
cannot be reassigned.

Groups - Date Finder and Place Finder: When files are 
added your catalog, MediaPro searches for dates and 
locations embedded in your media. 
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file has all three, MediaPro will use the Event Date 
as primary date for display in this list.

You can adjust the date assigned to a file by 
drag-and-dropping the file onto a different date 
field.  This assigns the new date to the IPTC Event 
Date and does not alter the Capture Date or File 
Creation Date for the media file.

The digital camera (EXIF) Capture Date can be 
reassigned using the Set Capture Date option in 
the Action menu. This operation applies only to 
images taken with digital cameras.

If the date you want isn’t available in the list, 
use the annotation field drop-down menu to add 
a new date. This drop-down menu also provides 
you with option to remove a date from the list. 
Removing a date will not only delete the date, but 
all associated files from the catalog. 

Place Finder: A hierarchical  display of the IPTC 
Country, City, State and Location fields. 

Media Fields section
File Type (read-only): Shows a list of all media 

sorted by the file format, such as TIFF, JPEG, MPEG,  
MP3, etc. 

Import Devices (read-only): This list categorizes 
media by the digital device that created the file. 
Digital cameras and some scanners record this 
information in every image they capture (EXIF 
metadata).  Media items that do not have a device 
assigned will not be represented in this list.

Color Profiles (read-only): Displays media based 
on the color profile embedded in the media file. 
Media items that do not have a color profile 
assigned will not be represented in this list. Color 
profiles can only be assigned to files using the 
Manage Color Profile option in the Action menu, 
and cannot be assigned through drag-and-drop 
to the Catalog Index. 

Sample Color: A sample color is generated when 
the media is imported, based on the dominant color 
of the image.  To change a media item’s sample color, 
you can choose Set Sample Color from the Action 
menu, or you can drag-and-drop the item onto any 
sample color in this list. 

Annotation Fields section
These fields give you an alternative way to assign 
metadata organization to your media files, as 
opposed to entering this data in the Info Panel. 

These fields in the Catalog Fields index are all 
part of the IPTC/XMP and QuickTime standards. 
They are: Product, Genre, Event, Status, Author, 
Credit, Source, People, Keywords, Categories, Scene, 
Subject Code and Intellectual Genre. Custom anno-
tation fields also appear here.

Instead of assigning these annotations in the 
Info Panel, you can create an annotation field in 
any of these groups, then drag-and-drop media 
on the field name and the annotation will be 
assigned to the item. This significantly speeds up 
and simplifies the annotation process.

If you switch over to the Info Panel, you will 
notice that same annotation is represented in the 
corresponding annotation field.

Conversely, if you add metadata to an annota-
tion in the Info Panel, it will also appear in the cor-
responding group in the Catalog Fields index.
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Add a term: Open an annotation group, such as Events, 
then click the plus sign at the top of the Fields panel.

Add a term: Select the annotation field you want to 
add a term to, then type the term in the field below. 
Check Add selected items to associate this term with any 
actively selected media items.
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Working with annotations
Open/close an annotation group: Click the field 
label of the group. 

Add an annotation term: Select an annotation 
group, such as Events, then press the plus sign (+) 
at the top of the Catalog Fields index. Type the 
name of your annotation term. All new terms are 
stored in the vocabulary for the respective field.

Add an item to an annotation term: Select 
an item, or group of items, then drag-and-drop 
them onto an annotation term. Associating an 
item with an annotation term in a catalog does 
not affect the original file.

Remove an item from an annotation: Click 
the dot next to an annotation term, showing 
only those files associated to it. Select a item, or 
group of items, and press the Delete key. A dia-
log will ask if you want to remove this item from 
the annotation term or the entire catalog. If you 
switch over to the Info Panel, you will notice that 
the same annotation has been removed from the 
corresponding annotation field.

Locating media by fields
Once you have assigned media to various anno-
tation terms, you can now filter the catalog using 
the Catalog Field index. 

To find files that match an attribute (date, file 
type) or annotation (events, locations, etc.), click 
the dot next to term in the Catalog Fields index 
and the corresponding files appear in the active 
view (see figure above). This will hide all files that 
do not match that annotation or attribute. This is 
useful for finding a particular group of files which 
can now be batch processed, exported, reorga-
nized or printed. 

After you have found your files, use Show All in 
the Find menu to reveal all the hidden files in your 
catalog. You can also use the Show All Items icon 
in your toolbar to show all files.
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Add an item to an annotation term: Select a file, 
or group of files, then drag-and-drop them on to an 
annotation field (above) in the Catalog Fields index. 
If you switch over to the Info Panel (left), you will 
notice that same annotation is represented in the 
corresponding field for that file. Conversely, if you add 
metadata to an annotation in the Info Panel, it will also 
appear in the corresponding term in Catalog Fields.

Locating media by metadata: To find items that are 
associated with an annotation or attribute, click the dot 
next to the field label in the Catalog Field index. When 
MediaPro is showing only those files, the dot is green.

Restoring the catalog: After you sort a catalog, use the 
Show All Items icon in your toolbar to reveal hidden items.
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Catalog Sets 
Catalog sets are a free form, hierarchical method 
of organizing media files. You can use sets to orga-
nize playlists, photo albums, work assignments or 
to create a complex system of categorization.

Sets can be used to quickly display sub-groups 
of items in a catalog, and to maintain their order, 
even after items within the sets have been moved 
or sorted. These catalog sub-groups can then be 
used in export functions such as slide show pre-
sentations, quick searches, classifications, printing, 
and Web pages.

Any media item can belong to more than one 
set, allowing catalogs to be logically organized 
into sets for different projects, clients or themes, 
without confusing the overall annotation or clas-
sification of files in the catalog. 

Sets can be shifted or reordered to change the 
hierarchy of an individual set within the group of 
sets. 

View sets: Open the Organize Panel by clicking 
the interface button. Sets are located in the Cata-
log Fields index.

Create a set by clicking on the plus sign (+) at 
the top of the Catalog Fields index. In the dialog, 
type the set name. Make sure the Field drop-down 
menu has Catalog Sets selected before pressing 
the OK button.

Add media items to a set: There are two ways 
to add items to a set. 
1. Drag-and-drop one or more media items from 

the catalog’s active window to the set name. 
�. Select an item, and choose Add Term to 

Selected Media Items from the set’s drop-down 
menu.
When you add media items to, or remove them 

from a set, the set counter to the right of the set 
name automatically updates.  

Remove items from sets: Click the dot next to 
the set name to show only associated set items 
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Add/remove sets

Individual sets menus 
offer the option to select 
images associated with 
that field in the active 
view.

Icons are 
assigned by 
the first item 
associated 
with a set.

File types that 
do not have 
thumbnails, 
such as MP3s, 
have generic 
set icons.

Set 

Subset 
container 

Click the dot next to 
any field term and the 
corresponding items will 
appear in the active view.
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in the active view. Select the items you wish to 
remove from the set and press the Delete key. A 
dialog will prompt you to choose whether you 
want to remove the item from the set or the cat-
alog. If you remove the item from the set, it still 
remains in the main catalog.  

You can also remove items from sets by select-
ing Remove Term from Selected Media Items in each 
set’s menu.

Display a set: Click dot next to the set name 
in the Organize Panel. This displays the items of 
the selected set in the active view, hiding all other 
files in the catalog. Use the Show All function in 
the Find menu to reverse this feature, revealing 
all hidden files. You can also use the Show All Items 
toolbar icon to reveal hidden files.

Once you have displayed a set in the active 
view, you can easily perform batch commands or 
export functions without affecting the rest of the 
catalog.

Display a group of sets: Click the higher level 
set in a hierarchy of sets.  This will display all items 
associated with all sub-sets.

You can also display a group of sets by clicking 
the dot next to each set name and holding down 
the Ctrl key (Mac: Cmd key).

Select set items: To select all media items asso-
ciated with a set, choose Select Media Items in a 
sets’ drop-down menu.  This is useful for selecting 
items without having to first display the set.

Set associations now stay with a media item 
when you copy media files from one catalog to 
another, and when you merge one catalog with 
another. 

Sync: Sets can now be synchronized (written) 
into the original file. It is written to a custom XMP 
annotation field.
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Add files to a set: Select a file, or group of media files, 
and drag-and-drop them from the catalog’s active 
window to the set name. 

Reorder sets: Sets can be shifted around to change the 
level or relative position of an individual set within the 
group of sets. 

Restoring the catalog: After you sort a catalog using 
sets, use Show All in the Find menu to show all the items 
in your catalog. You can also use the Show All Items icon 
in your toolbar to show all items.

Create a set: Click the plus sign at the top of the 
Catalog Fields index to create a new set. 
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File renaming
Good digital asset management strategy starts 
with having unique, meaningful filenames. For 
creative professionals — who can easily produce 
huge volumes of media in a relatively short time 
— this is particularly important.

When an image collection grows past a thou-
sand files it is easy to have filename problems, 
such as having two images with the same name. 

Most digital cameras have a sequential photo 
numbering option. With this option on, every image 
will have a unique filename, such as DSC0211.jpg, 
DSC0212.jpg, DSC0213.jpg, etc.

Sequential numbers allow you to move files 
around easily without having to rename them to 
avoid duplication of filenames. Sequential numbers 
are also useful when you must find other photos 
that were taken at the same time or in the same 
place.  However, sequential numbering is only part 
of the solution to a good filename. 

Filenaming  conventions
A valuable filename also includes additional infor-
mation such as date, author, client name, project 
name or subject of a photo shoot. It also might 
contain business-related information such as prod-
uct or part numbers (see figure below). 

Standardizing on a particular filenaming con-
vention offers several advantages for photo man-
agement workflows:

• It is difficult to create two files with the same 

filename. This makes them easier to identify 
and reduces problems with duplication. 

• If you always include a standardized date in 
the filename, such as the Capture Date, you 
can easily locate a file. 

• With sequentially numbered files, a folder 
of images on your desktop is automatically 
sorted into chronological order. 

• Workgroups use the same conventions, there-
by promoting consistency across the organi-
zation and facilitating file retrieval.

• By looking at just the filename, you will know 
a lot about the image (i.e. date created, person 
who took the image, subject or client, and the 
order in which it was created). 

• If you decide to switch image management 
applications, or are running several database 
applications, important metadata can be 
derived from the filename.
Your filenaming convention should be spe-

cific to your business and archiving needs. For a 
large catalog of stock  images, you could use the 
Dewey Decimal or U.S. Library of Congress system 
to identify the subject of the photographs. 

The key is to integrate the naming system into 
your workflow so that every file is named properly 
before it ends up in an archive.

Ultimately, if you create specific guidelines for 
filenaming and stick to them, you and everyone 
you work with will be able to easily identify, locate 
and share those files. 
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Filename examples Name components

lexus_newsletter_0904_001.tif Client name, project, publication date and sequential numbering

wegatv_KDF42WE655_012.jpg Product name, product ID and sequential numbering

hourmedia_040623_066.pdf Client name, 6-digit date (YYMMDD) and sequential numbering

hollywood_040721_0457.jpg Subject, 6-digit date (YYMMDD), slide ID (for scanned images)

smith_jones_040721_sb_0215.jpg Bride, groom, 6-digit date (YYMMDD), creator’s initials, sequential numbering

job314_040727_0013.jpg Job number, 6-digit date (YYMMDD), sequential numbering

20040721_P_0525.jpg 8-digit date (YYYYMMDD), subject code (Portrait) and sequential numbering

For recommendations for image filenaming strategies, see David Riecks’ Controlled Vocabulary web site. 
http://www.controlledvocabulary.com/imagedatabases/filenaming.html
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Batch renaming in MediaPro
To rename all selected catalog items, as well as the 
corresponding original files, choose Action > Batch 
Rename. The Batch Rename function provides four 
options for renaming files: Date, Text, Sequential 
Numbering, and Filename. Up to three options can 
be combined in various ways to create unique 
batch renaming instructions.

Example 1 - Incremental: Use the date, a string of 
text and numbering sequence for renaming your 
items (see figure above).
1. Select a group of items and choose Action > 

Batch Rename. If you select a single image, the 
function will be not be available.

�. Choose Date from the Rename Options drop-
down menu. This function will automatically 
insert either the IPTC Event Date, the EXIF 
Capture Date or the file Creation Date in that 
priority.  MediaPro will display date tags, such 
as MM-DD-YYYY, which you can reorder and 
use different separators, such as YY_DD_MM.

�. Click the plus sign (+) button to add another 
Rename Option. Choose Text in the Rename 
Options drop-down menu. 

4. Enter a text string: For example, a string might 
be a subject, location or the photographer’s 
initials. Use text that will be meaningful to all 
items being renamed.

�. Click the plus sign (+) button to add another 
Rename Option. Choose Number From in the 
Rename Options drop-down menu. 

6. Define starting increment: An increment is the 
numeric value that is used to start sequential 
numbering. For example: if you type “10”, files 
will enumerate: sb10.jpg, sb11.jpg, sb12.jpg, etc.  
Incremental renaming ignores file types and 
will continue to incrementally enumerate 
regardless of the file type. This means that if 
your first two files are TIFFs and the next two 
are JPEGs, then they would be named: 1.tif, 2.tif, 
3.jpg, 4.jpg.

7. In the field next to the increment, define num-
ber of digits for the sequential numbers. For 
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For repeat use of your 
settings, save them 
using the Option Sets 
pop-up menu. 

Change case to:
lowercase, UPPERCASE 
or Title Case.

Preview window 
shows a list of your 
files before and after 
the batch rename.

Date uses the IPTC 
Event Date, the EXIF 
Capture Date or the 
file Creation Date to 
rename items. 

You can adjust the date 
using various tags:

MM = Month
DD = Day
YYYY = 4-digit Year
YY = 2-digit Year
hh = Hours
mm = Minutes
ss = Seconds

Adjust the zero padding 
by defining the number 
of digits for sequential 
numbering.
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example, if you choose a starting increment of 
8 and 3 digits, files will be named: 008, 009, 010.

8. Click the Rename button. File renaming 
should be relatively instantaneous, but might 
take a few seconds if you are renaming more 
than a thousand files. 
Tip: MediaPro remembers the last increment 

used in batch renaming and automatically pro-
vides you with the next increment for additional 
batches. For example, if you renamed 50 files, then 
later added more files that you wish to rename, 
the Number From field would automatically show 
51 as starting value for your next batch rename.

Example � - Search & Replace: In this method of 
renaming, you can search for text and replace it 
with more relevant information. This function is 
good for turning sequential digital camera file-
names into ones that match your filenaming con-
vention, while maintaining the sequential numbers 
created by your camera (see figure above).
1. Select a group of items and choose Action > 

Batch Rename. If you select a single image, the 
function will be not be available.

�. Choose Date from the Rename Options drop-
down menu. 

�. Click the plus sign (+) button to add another 
Rename Option. Choose Filename in the Re-
name Options drop-down menu. 

4. In the Search for field, enter a text string that 
you want to replace. In this case, use the string 
“DSC” (common to digital cameras). 

�. Replace it with a string that follows your 
filenaming convention, such as subject or 
photographer’s initials.  

6. Case sensitive: Check this box to restrain your 
search based on the case of the text. 

7. Click the Rename button. Now we have turned 
DSC09851.jpg into a more usable filename: 
20051020_sb_nyc_09851.jpg.
Format Options: For all batch renames, you 

can change the case of all text to: lowercase, UP-
PERCASE or Title Case. There is also options to strip 
diacritical marks such as accents. For example, you 
could change “déjà vu” to “deja vu”. Stripping diacrit-
ical marks from filenames is important for increas-
ing filename compatibility across platforms.

File renaming scripts
• Rename using Text File (Scripts > Files): This 
script uses each line of a text file as a new 
name for the selected media items.

Troubleshooting file renaming
• Offline catalog items, such as those on CD, DVD 
or removable drives, cannot be renamed.

• Files that are locked by the operating system 
cannot by renamed.

Filename compatibility
For maximum portability across Windows, Macin-
tosh, and Unix networks and platforms: 

• Limit filename length to 31 characters
• Keep filename extensions, such as .jpg, .gif.
• Use underscores ( _ ) to separate blocks of in-
formation, instead of dashes or spaces.

• Format dates in a 6 or 8-digit code. For exam-
ple, July 21, 2004 should be 040721 (YYMMDD), 
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Batch rename: Example showing search and replace.
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or 20040721 (YYYYMMDD). This will help keep 
files sorted in their proper order in the folders 
on your desktops and removable media.

Organizing original files 
Move to Recycle Bin (Toolbar): Removes selected 
files from the catalog and moves the originals to 
the Recycle Bin. MediaPro does not empty the Re-
cycle Bin. If you change your mind, you can always 
open the Recycle Bin and move files back to their 
original location. 

Transfer to Folder (Action menu): Gives you 
three options for copying and moving files.

• Move files: Moves media files to a new folder, 
deleting original files. Catalog items will refer 
to the new files in the new folder. 

• Copy files: Copies media files to a new folder, 
keeping the original files. Catalog items will 
refer to the files in the new folder.

• Duplicate files: Copies media files to a new 
folder. Catalog items and referenced files will 
remain unchanged.
Folders Panel (Catalog Index). Drag-and-drop 

any file from your catalog onto a folder in the Fold-
ers Panel.  This moves the location of a file to a dif-
ferent folder on your computer. The path to the file 
is automatically updated in the catalog.

Finder Properties: These commands allow you 
to manipulate various attributes of files that de-
termine how the Finder displays and opens them, 
as well as the accessibility or visibility of files by 
other users. 

In the Action menu (Mac only)
• Set Creator: For changing the 4-character file 
creator that the media file is associated with. 
For example, it’s useful for changing files with 
QuickTime creator to a Photoshop creator. 
This will allow you to double-click the files 
and open them with Photoshop. 

• Desktop icons: For easy identification of files 
within the application or in the Finder, this 
will replace generic desktop icons with image 
icons of original files. 

• Media Thumbnails exports and embeds a 

small thumbnail into original referenced files 
outside the catalog. This preview can be read 
by a number of media editing applications 
which use built-in thumbnails in their open-
ing dialog for quick identification. 

• Lock Status will lock or unlock files in the 
Finder. 

• Delete Resource Fork will remove the resource 
fork, which can contain thumbnails, icons and 
various metadata, from a media file. 
In the AppleScript-Files menu  (Mac only)

• Set File Comment will save the Caption field 
inside the file’s comment field, visible in the 
Finder and the Get Info window of original files. 
When the operating system indexes your files 
on the desktop, your media file captions will 
now be part of your Sherlock search index.
Version Control (Image Editor): This is useful 

both for individuals and small work groups to 
browse and track different versions of the same 
files. This is particularly useful as a backup as well 
as for reverting to different versions. (See section 
on Version Control, page 126).
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Finder Properties (Mac OS X): A media file’s Finder info, 
with lock status and icon created by MediaPro.



80    IV IE W MEDIAPRO USER MANUAL

Catalog Folders
MediaPro offers advanced folder management to 
enhance your workflow and provide direct con-
trol over your file system. Catalog Folders is a sec-
tion of the Organize Panel, which can be shown 
by clicking the Organize interface button.

Folder watching
Catalog-wide folder watching can be enabled to 
monitor folders which contain media within your 
catalog. To enable folder watching, select an option 
from the catalog folder watching menu — either 
update folders Every minute or Every 5 minutes. 

When new media items are added to any folder, 
MediaPro alerts you to the new content (shown 
by a blue arrow on the folder icon). You can then 
choose to import these new files directly to your 
catalog by selecting Update Folder Now from the 
individual folder’s drop-down menu.

To turn off folder watching, select Never from 
the catalog folder watching menu. 

Auto-update folder watching
Auto-update takes folder watching to the next 
level by automatically importing from selected 
folders when new media are added.

To enable this feature, select Switch Auto-
Update On in the drop-down menu of the folder 
that you want to be constantly monitored. Once 
new media is added to that folder, MediaPro will 
automatically import those items into to your cat-
alog. Auto-update folders are designated green.

Additional folder functions
Remove folder and its contents: This function 
in the folder drop-down menu removes a folder 
and its contents from the catalog but not from 
the hard drive.  
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Indicates that 
the volume is 
not available.

Folder watching menu

Green folders 
indicate auto-
update is on.

Blue arrows 
indicate 
that new, 
uncataloged 
images are 
in this folder. 
Select Update 
Folder Now to 
import these 
new items.

To expand  
all folders, 
Alt+Click (Mac: 
Option+Click) 
on the volume 
arrow.

Green indicates Folder Watching is on

Catalog Folders: Click the Organize toolbar button to show/hide the Catalog Folders panel (Window menu).

Individual folder menu : Reveal this 
menu by right-clicking (Mac: Option-
clicking on the folder name.

Click the dot next to any folder to 
show only items in that folder in the 
media viewing area.
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Reset folder path: This folder drop-down menu 
feature is useful if you have moved a folder of files 
to a new location but the catalog still thinks it 
resides in the old location. This command is much 
faster than the Reset Paths command in the Find 
menu, but assumes that the contents of the folder 
in question have not been reorganized.  

Display contents of a folder: Click the dot next 
to the number for each folder, or choose Select 
Media Items in a folder’s drop-down menu.  This 
displays the items of the selected folder in the 
active view, hiding all other files in the catalog. Use 
the Show All function in the Find menu to reverse 
this feature, revealing all hidden items. Once you 
have displayed a folder in the active view, you can 
easily perform batch commands or export func-
tions without affecting the rest of the catalog.

Display a group of folders: Click the dot next to 
the number for a high-level folder.  This will display 
all items associated with the high-level folder and 
subfolders. Alternatively, you can display a group of 
folders by clicking each dot and holding down the 
Ctrl key (Mac: Cmd key).

Select folder items: To select all media items 
associated with a folder, choose Select Media Items 
in a folder’s drop-down menu.  This is useful for 
selecting items without having to first display the 
folder’s contents.

Direct folder manipulation
MediaPro also offers several features that enable 

you to directly use system file operations. Most of 
these functions cannot be undone, as they directly 
manipulate files and folders on the desktop.

• Open Folder reveals folders and its contents in 
the desktop.

• Create sub-folder will create a new folder on 
the desktop. You can name it from the Catalog 
Folders section.

• To rename a folder on the desktop simply click 
on the name in the Catalog Folders list and 
retype the name.

• Move Folder to Trash removes files and folders 
from the catalog and hard disk. This feature 
moves files and folders to the desktop Trash/
Recycle Bin, but does not empty it.

• Move files directly around the file system from 
within the catalog. To move a file to a different 
folder on your computer, drag-and-drop the 
file onto a folder icon in the Catalog Fold-
ers section. The media files will be physically 
moved to the folder selected.

• Transfer To Folder (Action menu) gives you 
three options for copying and moving files:  
Move files: Moves media files to a new folder, 
deleting original files. Catalog items will refer 
to the new files in the new folder.  Copy files: 
Copies media files to a new folder, keeping the 
original files. Catalog items will refer to the files 
in the new folder. Duplicate files: Copies media 
files to a new folder. Catalog items and refer-
enced files will remain unchanged.
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To move one or more files to a different folder on your desktop, drag-and-drop the file onto a folder icon in the 
Catalog Folders section of the Organize Panel. This operation cannot be undone.
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Finding and sorting media in catalogs

iView MediaPro offers a number of ways to find 
and sort media files, as well as related file, media 
and tag attributes, in open catalogs. 

Instant catalog searching
You can search catalogs quickly and directly from 
the search box in the catalog toolbar. Searching is 
case-insensitive and includes all annotations (EXIF, 
IPTC Annotations, Captions, etc.), media fields and 
catalog set names.

To perform a search, simply type the word or 
words in the search box and press the Return or 
Enter key. Results are presented in the active cata-
log view. 

After you have found your items, use Show All 
in the Find menu to show all the items in your 
catalog. You can also use the Show All Items icon 
(house) in your toolbar.

Find command 
The Find command (Find menu) can search more 
than 50 different media attributes, annotations 
and custom fields inside your catalogs. 

Using the Find items in pop-up menu, you have 
the option of searching the active or front catalog, 
all open catalogs, recent catalogs or all catalogs in 

a particular folder. The Find command also has 
the ability to perform compound (a.k.a. Boolean) 
searches of attributes using “and/or” commands.

To add or subtract search criteria, use the plus 
and minus buttons in the upper-right corner of 
the dialog.

Results of your search are defined by the pull-
down menu in the lower-left corner of the Find 
dialog box. Find next will highlight the first item 
that meets your search criteria. Select all will select 
items that meet your criteria. Show all will hide all 
items in the catalog that do not meet your criteria. 
Show all in a new catalog will place all matching 
results in new catalog. 

Searches can be saved for later recall in the 
drop-down menu in the upper-right corner of 
the Find dialog box.
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Search box: Type the word or words in this field and 
press the Return or Enter key. Results are presented in 
the active catalog view. 

Save searches 
for easy access 
in this drop-
down menu. 

Add or Subtract search criteria using these buttons.Find items in: Define the catalogs you wish to search.

Results: Define how you want search results presented.

Boolean 
commands 
for compound 
searches.



Finding Media   8�

Filtering and sorting by metadata
Catalog Fields index - Organize Panel: To find 
items that match an attribute (date, media format) 
or annotation (events, locations, etc.), click on the 
dot next to the field name in the Catalog Field 
index of the Organize panel (see figure above). This 
will make the corresponding items appear in the 
active view of the catalog. When a catalog is being 
filtered to show only items assigned to a field, the 
dot will turn green. 

Use the Catalog Fields index list configuration 
menu to show or hide various media attributes 
and annotations that you can use for sorting func-
tions in the Organize panel (see figure above).

Sort (Toolbar icon) lets you view and sort files 
by more than 25 attributes and annotations, 
including custom fields. iView MediaPro can also 
shuffle files randomly for slide show viewing. The 
Default option returns the organization of items 
to that of the last saved version of the catalog.

Show Labelled (Find menu): Show only those 

items that have been marked with a color label 
in your catalog. Labelled items can also be sorted 
by  each label using the Label section of the Cata-
log Fields index. The Show Labelled option is also 
available in the Slide Show controller.

Show Rated: (Find menu): Show only those 
items that have been marked with a star rating 
in your catalog. Rated media items can also be 
sorted by each rating using the Rating section of 
the Catalog Fields index. 
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Catalog Fields: Find files that match a media attribute (date, media format) or annotation field (events, locations, etc.).

List configuration menu: Select Show/Hide Fields 
display various media attributes and annotations 
fields in the Catalog Fields index. This will launch a 
palette where you can turn fields on or off (below)

Click the dot next to any field 
term in the Catalog Fields index 
and the corresponding items 
will appear in the active view. 

Click to invert 
sort order of 
items in catalog.

Click the label of each 
column to sort items by that 
attribute. Click the label again 
to invert the sort order.

Indicates the number 
of media in the catalog 
associated with the 
attribute or annotation. 
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use the state arrows to navigate back and forth 
among various states that your catalog has shown 
during the searching and sorting process in the 
Organize Panel.

List View: To sort the catalog according to various 
attributes and annotations, click the corresponding 
label in the Header bar above the media viewing 
area. To invert the sort order, click the arrow on the 
far left of the header bar. Use View Options (Window 
menu) to show or hide up to 10 media attributes 
and annotations in the Header bar.

Filtering by sets and folders
Filter by a set: Click the dot next to any set or 
container name in the  Catalog Index. This dis-
plays the items of the selected set in the active 
view, hiding all other files in the catalog. 

Filter by folders: Find files by their location on 
your computer or removable disks, by clicking the 
dot next to the appropriate folder name in the 
Catalog Folders section of the Organize panel. The 
corresponding files will appear in the active view. 

You can also display a group of sets or folders by 
right-clicking (Mac: Option-clicking) each folder or 
set name and selecting Show Media Items from the 
drop-down menu.

Filtering options: After selecting one field in 
the Organize Panel, hold down the Ctrl key (Mac: 
Cmd key) and click on another dot to show the 
union of both fields in the media viewing area. 
This is the same as using the Find command to 
search for one criteria plus another criteria. 

Other sorting options
Show Similar Items: Use this function in the Find 
menu to display media items with similar visual 
appearance, or with similar file names. 

You may have to experiment with the Match-
ing settings to get optimal results. Check Match 
selected items only to find media in the catalog 
similar to the items selected.

Show Last Import: This is useful if you are 
downloading multiple media cards and you need 
to view only items from the previous import.

States: As you search, sort and organize your 
catalog, certain files will become hidden. To re-
store your catalog and view all files, click on the 
Home (Show All Items) toolbar icon. Or you can 

Filter by a set: Click the dot next to any field 
term or folder in the Organize Panel and the 
corresponding items will appear in the active view.

Hold down the Ctrl key (Mac: Cmd key) and click 
on another dot to show the union of both fields 
in the media viewing area.
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Show Similar Items : Use to find media will similar 
visual appearance or with similar names.

State Arrows: As you search, sort and organize your 
catalog, certain files will become hidden. To restore your 
catalog and view all files, click on the Home (Show All 
Items) toolbar icon. Or you can use the state arrows to 
navigate back and forth among various states that your 
catalog has shown during the searching and sorting 
process in the Organize Panel.



Finding Media   8�

Finding original files 
Show Media File (Toolbar) reveals the location of 
the selected media item(s) on the desktop. 

Find Duplicate Items (Find menu) searches 
for similar or duplicate files, allowing you to set 
the level of similarity (tight or loose). Additional 
options: Ignore brightness is good if you want to 
exclude image brightness quality. Compare items 
with similar names is useful for imports of images 
from digital cameras that reuse file names, which 
can conflict with a previous import. 

Duplicate results are presented in the open cata-
log, hiding all other items. This allows you to iden-
tify and compare items, side by side, and rename 
or discard them. Afterward, use Show All in the Find 
menu to reveal hidden items.

Find Missing Items (Find menu) searches 
for broken links to media files and highlights all 
unmounted or missing items in the catalog. You 
can then remove them from the catalog or search 
for them in a specific directory. 

MediaPro stores the path of the original file and 
can detect if the file has moved in a relative path. 
If the file name has changed, the file or folder has 
moved, or the file, folder or volume is no longer 
mounted, the full size image in Media View will no 
longer be available and an error message appears 
in red text in the Header bar.  

The thumbnail and annotation data is kept in 
the catalog but the path to the full size image, 
movie, or sound is no longer correct. To rectify this, 
you can use the Reset Paths dialog (Find menu) to 
amend the file paths. 

Reset Paths (Find menu) allows you to reassign 
or modify the path, for one or more items. Using 
the dialog, navigate to and select the folder or 
directory where the file(s) now reside. MediaPro 
will display each file in a window for you to con-
firm each file’s path restoration. If you have a group 
of files, and you are certain that all the new paths 
are correct, you can use the Accept All button in to 
avoid having to confirm each to new path. 

However, if you have simply moved or renamed 
an entire folder or disk, it is much faster to use the 
Reset folder path command in Catalog Folders pane 
of the Organize panel (see page 80).
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Reset Paths dialog, once results have been found. 

Restoring the catalog: After you sort a catalog, use the 
Show All Items icon in your toolbar to reveal hidden files.
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iView MediaPro enables you to view or project a 
slide show presentation with your photographs, 
movies and audio soundtracks. 

Slide show basics
• To start, click the Slide Show button in the 
toolbar.

• During the slide show, click the Escape (ESC) 
key or double-click to exit. 

• The slide show is controlled via the floating 
controller, which you can display or hide by 
pressing the Enter or Return key. 
Audio: MediaPro slide shows can contain a 

single (background) audio channel. Sound items 
included in a catalog are always queued into the 
audio channel. If you place an audio file at the 
beginning of a slide show of images, it plays dur-
ing the presentation.

Video: MediaPro slide shows can display  up 
to 16 video channels. All media types (including 
images, movies) are played in one or more video 
channels depending on your grid selection.

Grids are the arrangement of video channels, 
in full-screen, quarter-screen or a variety of other 
options. Unless you are using a computer with 
a powerful processor, using the slide show with 
more than one video channel will place con-
siderable strain on your machine and degrade 
playback. Experiment with Half or Quarter video 
channel grids first before choosing more complex 
grids. 

Use the Grid drop-down menu of the slide show 
controller to change grid styles. There might be a 
slight delay when changing grids while MediaPro 
loads the media.

Timing: MediaPro lets you specify how long 
still images will appear, however movies always 
appear for their full duration. To adjust the timing 
of images (in seconds), use the up/down arrows 
next to the green number on the right hand side 
of the controller.

 Transitions: MediaPro offers several options 

to adjust the transition effect between images. 
There are 10 different transition effects, such as 
Cross Fade, Barn Horizontal and Radial wipes, as 
well as a Random effect option.  

Effects defined in the Transitions drop-down 
menu of the slide show controller apply globally 
to all images of the slide show. 

Size of Media: Use the Scale drop-down menu 
of the slide show controller to adjust the size of 
media on screen. You can also enlarge or reduce 
the size of your images with the Zoom In/Out key-
board shortcuts (+ and –). This setting will apply 
globally to all images of the slide show. 

Slide show controller 
The slide show controller palette allows you to 
adjust presentation options during a slide show. 
To show the controller, press Enter or Return.

This palette is also useful for running presenta-
tions on a second screen or projector. If you use 
multiple monitors, position your catalog inside 
the monitor you want to use for the slide show. 
You can start the presentation on that monitor 
and keep the controller on the other one. 

If you are not using two monitors, displaying 
the slide show controller on top of the slide show 
stage will impair viewing.
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Slide Shows

Slide Show controller: Use the Enter or Return key to 
hide or show the controller.

Control Options
Transitions

Exit Back Play
Pause

Forward

Scale

Adjust timing
(in seconds)

Adjust 
volume

File shown |
Total files in catalog

Grid
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Playback Settings
• Interactive: Using this option enables you to 
use the forward/backward arrows of your key-
board to manually advance or go back in your 
presentation. The up/down arrows work the 
same as forward/backward arrows. 

• Continuous: This is the default for MediaPro 
slide shows. Images will appear on screen for 
the specified duration, then automatically 
advance to the next image. Movies will appear 
on screen for their full duration, then automati-
cally advance. You can use the spacebar to 
Pause/Play a slide show in Continuous mode. 
Also, the forward/backward arrows will manu-
ally override the pace of your presentation.
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Slide Show controller: Files panel. Slide Show controller: Info panel.

Use these arrows to flip through the various pages of 
information. This area shows all available annotations, 
metadata and captions. The amount of information 
varies for each file. 

Use this arrow to show or hide advanced options.

Each media file can have 
individual Timing, Transition, 
Grid and Scale settings. To 
define one of these settings, 
select the file in the list and 
make a selection from a 
drop-down menu in any 
of the four columns to the 
right of the file name (See 
figure below).

Use arrows to adjust Timing Transition

GridScale

Timing

Color Label: Click picture to assign label

Show All Items 
restores the slide 
show list to show all 
items. Available after 
filtering by labels. 

Show Labelled Items 
will display only those 
items marked with a 
particular color label.
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• Random: MediaPro will randomly choose 
images and movies to present on screen.

Stage Settings
• Set background color: Change the background 
color of slide shows. The default is set to black.

• Draw margin between media will add a few 
pixels of background color to help sepa-
rate items from each other in multi-file grid 
arrangements. 

Other Options
• Play voice annotations will play any attached 
voice annotation whenever a media item is 
loaded. 

• Play sound from all movies plays all the avail-
able movie audio tracks simultaneously.  This 
option is only useful when you intend to play 
multiple movies in a grid arrangement. If this 
feature is disabled, MediaPro plays the back-
ground sound channel, as well as the active 
movie soundtrack. 

Slide show options
The setup features and options can be set prior 
to running the slide show, using the Slide Show 
Options dialog in the Make menu. This dialog box, 
as well as the Controller, allows you to set the fol-
lowing options: 

General Options
• Duration is the flip speed in seconds for each 
slide. (In the Controller, the duration can be 
adjusted using the up and down arrows on 
the top right hand corner of the window.) The 
duration applies only when the slide show is 
run in non-interactive mode. Note that mov-
ies and sounds default to their own duration. 
The duration can also be over-ridden by tim-
ings set for individual media items.

• Color: Change the background color of slide 
shows. The default is set to black.

• Transition: The current version of MediaPro 
offers a basic set of QuickTime effects which 
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Slide Show controller: Text panel.

Text options enable you to display a variety of media 
information beneath the image.

Choose text color, alignment, font and size by clicking 
on the options.

When the Title annotation is not available, MediaPro 
will show the File Name instead. 
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can be used during slide show media transi-
tions. The duration of the transition effects 
(1 second) is currently fixed. This setting will 
effect all media items, unless individually 
defined (see Timings). 

• Media Scaling lets you control the scale or size 
of media items. You can set this option before 
or during an active slide show. 

Stage Options
• Stage Grid: The slide show can run the standard 
full screen or you can divide the screen into sev-
eral video channels, from half, quarter, sixteenth, 
to a range of different cell arrangements. 

• Custom Grid: Click this button to design a cus-
tom slide show grid template.

Playback Options
• Interactive (or click mode), allows the user to 
click the mouse, use the space bar or arrow 
keys to advance to the next media item in the 
slide show. In this mode, the pause button 
changes to a mouse icon. Switch this option 
off to run the slide show using timers. 

• Continuous mode runs slide show presenta-
tions in a loop, restarting automatically from 
the beginning of the catalog when the slide 
show has finished. This mode is useful for 
kiosk or exhibition presentations. 

• Random: MediaPro will randomly choose 
images and movies to present on screen.

Other Options
• Margin between grid cells will add a few pixels 
of background color to help separate items 
from each other in multi-file grid arrange-
ments. 

• Play voice annotation will play any attached 
voice annotation whenever a media item is 
loaded. 

• Play sound from all movies plays all the avail-
able movie audio tracks simultaneously.  This 
option is only useful when you intend to play 
multiple movies in a grid arrangement. If this 

feature is disabled, MediaPro plays only the 
background sound channel, as well as the 
active movie soundtrack. 

• Fade In fades the start and end of shows. 
• Show controller will display the slide show 
controller during the slide show. Use the Esc 
or Return keys to hide the controller.

Keyboard shortcuts
MediaPro offers a complete set of shortcuts for 
keyboard and mouse navigation of slide shows. 
See page 136 for a list of these shortcuts.
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Slide Show Example: Uses a Quarter grid and displays 
Photo Info. Ideal for photographers to compare results.

Slide Show Options: Make menu
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Save a slide show as 
a QuickTime movie
MediaPro provides the option to save a slide show 
as a QuickTime movie, so you can distribute a cata-
log of images as a movie (with transitions and tim-
ing) without the MediaPro application.  

A QuickTime movie can be played using Apple’s 
QuickTime Player on both Mac and Windows 
computers. 

 Slide shows can be saved with any grid, as well 
as generic and individual transition effects and 
timings. To create a QuickTime movie slide show, 
choose Save Slide Show as Movie... in the Make 
menu. 

In this dialog, you can define the movie dimen-
sions or choose from a pre-defined set of indus-
try-standard sizes. To control the background 
color, global slide duration (timing) and transition 
effects, use the Slide Show Options dialog in the 
Make menu.

MediaPro offers a range of playback options 
when running QuickTime Player. For instance, 
click the checkbox to switch on Auto-Start and Full 
Screen Mode options to have your movie played 
back in full-screen mode automatically when you 
double-click the movie file on the desktop. 

If you select Include chapter track, QuickTime 
will display each file name in a pop-up menu 
below the movie (see figure above).
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QuickTime Player
These options 
will embed 
information that 
will instruct the 
QuickTime Player 
how to handle the 
movie.

Dimensions drop-
down menu allows 
you to choose from a 
list of pre-defined set 
of industry-standard 
sizes.

Exported QuickTime Slide Show presentation: If you 
choose to include the chapter track, QuickTime places 
file name and places it in a pop-up menu. 

Save Slide Show as Movie: Available from the Make menu

Quality
Use this pop-up 
menu to define the 
level of compression 
applied to the 
exported movie.
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Adding a soundtrack 
to a slide show
Use the following instructions to add a background 
soundtrack to your slide shows:
1. Create a catalog of images and movies, then 

organize them in the order you want them to 
appear in the slide show.

�. Place an audio file (MP3, AIFF, etc.) as the very 
first file in the catalog. 

�. Make sure the audio file is selected and then 
start your slide show. The music will continue 
to play throughout the slide show.

4. When you quit the slide show (ESC key), the 
song will automatically fade out.

�. If at any point you want the slide show  
to switch to a different song, just place an 
audio file at that point. MediaPro will auto-
matically fade from the old song to the new 
one. 

6. If you have Play sound from all movies selected 
(in the Slide Show Options of the Make menu), 
MediaPro will also play any soundtracks in 
your movies, reducing the volume of the 
background soundtrack for the duration of 
the movie. 

Making slide shows faster
In most cases, two factors affect the speed of 
slides shows: grids and media file size.

Grids: Unless you are using a computer with a 
powerful processor, slide shows with more than 
one video channel will place considerable strain 
on your machine and degrade playback. Experi-
ment with Half and Quarter video channel grids 
first before choosing more complex grids.

File Size: On computers with slower proces-
sors, a slide show of 20 MB image files will run 
much slower than a slide show with 1 MB image 
files. What slows MediaPro down is not necessar-
ily the file size, but the actual dimensions of the 
media. With larger dimensions, MediaPro has to 
dynamically shrink the image to fit the screen. If 
the image is the same shape as the screen (4:3 
proportion) the delay isn’t too noticeable. But for 
portrait images (vertical), the delay can be a few 
seconds.

Slide shows on slower computers: If you are 
having display or audio issues with your slide show, 
it may be asking too much of your computer’s pro-
cessor or video card. 

One solution is to create temporary copies of 
your images that are optimized for fast on-screen 
display. You can do this by using  Convert Image 
Files... in the Make menu. Here are the parameters 
that help:

• Size: Match your screen dimensions (for exam-
ple, 1024x768). That way MediaPro won’t have 
to resize the image.

• Setting: Match your monitor’s color depth, 
such 16-bit or 24-bit (Mac: Thousands or Mil-
lions). This will reduce processor usage.

• Resolution: Use 96 dpi (Mac: 72 dpi), same as 
your screen resolution.

• File format: Select an uncompressed format, 
such as Bitmap (BMP) or PICT instead of 
JPEG. This way the image file won’t have to 
be decompressed on the fly, during the slide 
show.
Create a new catalog with the converted imag-

es and your slide show will be amazingly fast.
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To add a background soundtrack, place an audio 
file as the first file in your catalog.
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Export Features

iView MediaPro can export and convert your media 
files in a variety of ways, by selecting options from 
the Make menu.

HTML Gallery 
With this export function, you can output a cata-
log of images and movies as a web site. Photog-
raphers, illustrators and designers can use this 
option to easily create a portfolio web site of their 
work. QuickTime movies can also be exported to 
HTML galleries.

Typically, an exported HTML gallery looks simi-
lar to the Thumbnail and Media Views of your 
catalog. It contains an table of thumbnails which, 
when clicked in a web browser, will take you to a 
larger image.

iView MediaPro offers you two options when 
you create HTML galleries:
1. You can use a default theme to create a web 

site based on the View Options of the Thumb-
nail and Media Views in your catalog. Or you 
may use any of the visual themes provided 
with the application.

�. You can use your own Themes, which can be 
created before exporting and saved inside the 
user-defined Plug-Ins > HTML Templates folder 
(see page 5). iView MediaPro uses a different 
template for the index and media views of 
your gallery, and offers a rich vocabulary that 
can be used to extract catalog information 
(fields, thumbnails, etc.), as well as a  high-level 
tags for navigation, date, time, etc. Creating 
themes requires HTML editing skills.  To learn 
more about creating themes and templates, 
see page 97.

Create a gallery 
1. Launch an iView MediaPro catalog of pho-

tos, illustrations, movies or any media file that 
can be distributed on the web. MediaPro will 
export only the visible items in the catalog. So 
make sure the items you want to export are 
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HTML Options:  Themes have pre-defined table 
grids, thumbnails and media sizes. However, you can 
customize to your liking by modifying these fields.

HTML Options: Theme panel, with Default chosen
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Index Page

Media Page

Tip: To reduce the loading time 
of your web pages, try to include 
less than 25 images on a single 
index page. Also, you might try a 
smaller thumbnail size.

File Name

Index Table: The number of 
thumbnails (across and down) that 
appear on an HTML Index page.

Index page links: The number 
of thumbnails (across and 
down) that appear on an HTML 
Index page.

Site Title

In some themes, the gallery’s 
creation date is added 
automatically.

Media size  is defined by the 
theme chosen. Each theme’s 
media page template has HTML 
Engine Directives that define 
media image size.

Media info:  If included in the 
theme design, captions and 
associated metadata (such as 
EXIF or IPTC fields) can appear 
on Media pages.

Navigation: On Media pages, 
the web site viewer can advance 
through the gallery using the 
previous/next links, or they can 
return to the Index page of the 
gallery. In some themes (like the 
one shown left), icons can be 
used in place of these links.

Thumbnails: All of these images 
are automatically hyperlinked to 
their respective media pages.
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displayed in the media viewing area before 
you create the gallery. When ready, choose 
Make > HTML Gallery.

�. Choose a Theme: In this dialog, you can define 
what your web gallery will look like.  
Site Title: This text will appear at the top of the 
index page in your gallery. If you don’t want a 
title, leave this field blank.  Some themes do not 
require a site title. 
Index Table: Customize how many thumbnails, 
across and down, will appear on the Index 
page in a gallery.   
Theme: Choose from a selection of preset 
themes or use Default to create your web site 
based on the View Options of the Thumbnail 
and Media Views in your catalog. If you use 
Default, make sure to choose the desired index 
table,  Thumbnail and Media size options. All 
other themes have pre-defined tables and 
media sizes that are designed for optimal 
output. You can change the options, however 
some themes are written to work with specific 
defaults and altering those would produce odd 
results. If a produced HTML gallery looks incor-
rect try remaking it with the default settings.

�.  Adjust your Settings 
HTML Extension: Defines the suffix of the 
HTML filenames. Options include:  htm, html, 
shtml, asp, php, xml. 
Output: Use numbers for HTML filenames uses 
a numerical increment (1,2,3...) for HTML file-
names instead of the media filename. Treat 
captions as raw HTML enables you to use 
HTML code, such as <b></b>, in the Caption 
annotation field. 
JPEG Quality: Choose the level of compres-
sion applied to thumbnails and media images. 
MediaPro now offers the option to set a custom 
target size for exported images. If  you choose a 
target file size, MediaPro will dynamically adjust 
the compression level in order for the exported 
images to meet or be less than the target size. 
Watermark: MediaPro exports images with a 
visual watermark — a secondary image which 

is overlaid on the primary image. See instruc-
tions for using watermarks on page 96.  
Frame images: Choosing this option places 
a 1 pixel black border around each exported 
thumbnail and media image. 
Embed annotations: MediaPro will embed 
all IPTC/XMP Core annotations into each 
exported image. 
Preserve color profiles: MediaPro will embed 
the ICC color profiles into each exported 
thumbnail and media image. 
Preserve EXIF/GPS metadata: MediaPro 
will embed the EXIF and GPS digital camera 
metadata into all exported media images. 
Movies: These options adjust the properties of 
QuickTime movies on Media pages. Auto Play 
will automatically play a movie, once it’s loaded 
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HTML Options: Settings panel

For repeat use of your settings, 
save them using the Options menu. 
This is useful if you have alternate 
settings using the same theme.
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in a browser;  Continuous will make the movie 
play in a loop; Display QuickTime Controller
toggles the standard QuickTime controls for a 
movie on and off. Kiosk mode hides the options 
to save movies and change QuickTime settings 
from within a  browser window.

4. Define FTP Server Settings: MediaPro can 
now upload (or FTP) exported web galler-
ies without using third-party software. This 
panel provides you with the options to define 
the FTP server address, user name, password 
and the directory that you want the gallery 
uploaded to.  You can also define a preview 
web address (URL) that will launch in a brows-
er when the upload is complete.

5. Enter Theme Fields: Some themes have 
variables that you can enter in this panel. For 
example, you might have a generic theme for 
your professional assignments. This theme 
might have special theme fields for you to 
enter the client’s name, job number and 
assignment details. This information will then 
appear on the exported web pages.

6. When completed:  Before creating your gal-
lery, there are two final options to review. In 
order for MediaPro to upload an exported gal-
lery, the Upload to server box must be checked. 
Check Launch browser when done to have 
MediaPro launch the exported web gallery in 
the system’s default web browser.

7. Create: After defining your settings, click  
Create. The amount of time it takes for iView 
MediaPro to create a gallery can vary depend-
ing on the number of images, their original 
size and the export size. The gallery will launch 
in your web browser after export, if that 
option is selected.

8. Optional - Upload to server: Once MediaPro 
has exported the gallery, a dialog will display 
saying “Gallery build is completed. Do you wish 
to upload (X) files to the server?” Click OK, and 
the progress bar panel will display the progress 
of each file as its being uploaded to your server. 
The number of files to be uploaded may seem 
like a lot, but many of them are small (such as 
thumbnails) and will upload quickly.
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FTP Server 
Settings

Server: Enter the FTP address for 
your server. For example:
ftp.ourmedia.org. As various servers 
are defined, they are stored in this 
drop-down menu for later reuse.

Enter the user name and password 
information for your FTP server.

Folder: In this field you are defining 
two pieces of information. First is 
the path to the web root directory 
of your account on the server. The 
second component is the directory 
for your gallery. If you do specify  
a folder that does not already exist  
MediaPro will create it.

Skip existing image files: Check this 
box if you have already uploaded 
your gallery images and are simply 
reuploading the HTML.

.. /.. /var/www/gallery1/.. /.. /var/www/gallery1/.. /.. /var/www/gallery1/

Path to root Folder for upload

Upload to 
server: In order 
for MediaPro 
to upload an 
exported gallery, 
the Upload to 
server box must 
be checked.

Preview: In this 
field, write the 
complete URL 
for the exported 
gallery. Make 
sure that you 
have typed the 
same upload 
folder name that 
you designated 
in the Folder field.
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Watermark HTML images
iView MediaPro exports HTML images with a visual 
watermark — a secondary image which is overlaid 
on the primary image, and provides a means of 
protecting the image. This is not the same as digital 
watermarks which are implemented algorithmi-
cally and are designed to be invisible. 

Create and set a watermark
1. Launch Adobe Photoshop, or alternate 

program which can create a TIFF file with a 
transparent background. MediaPro will accept 
the TIFF, PSD, JPG, PICT, PNG, BMP, GIF formats. 
Note that the JPG format does not support 
transparency. iView recommends TIFF for opti-
mal results.

2. Create a new file. For this example, say it is 200 
pixels wide and 50 pixels high. Make it RGB 
with Background Contents set to Transparent.

3. Choose the Type tool and type something 
with color set to Black.

4. Choose Save. Select TIFF as the format. There is 
no need to save alpha channel or layer info.

5. In the next dialog, choose your desired com-
pression and check Save Transparency.

6. Return to MediaPro’s HTML Settings panel, 
and in the Set Watermark dialog, select your 
TIFF file by clicking the New Image... button.

Watermark options
The previous instructions will create an overlay 
where the logo’s color is opaque (such as 100 per-
cent black or white). 

To alter the logo color’s opacity and give it a 
transparent quality, adjust the layer’s opacity in 
Photoshop to somewhere between 50 and 90 
percent. To make it a little jazzier, as in the exam-
ple shown above, add following after Step 3:
a. Add a Drop Shadow filter.
b. Set filter color to white or black, or whatever 

color desired.
c. You can adjust the opacity in the filter dialog 

to 75 percent for transparent quality.
Using a drop shadow will ensure your water-

mark is readable even if it falls in dark or light 
parts of an image.
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Set Watermark: 
The preview of the 
watermark and the 
image will be blank 
until a watermark 
image is assigned.

Preview of currently 
assigned watermark.

Align: Click any 
of these boxes to 
adjust the relative 
alignment of the 
logo, where it will 
be overlaid on the 
exported image. 
The watermark is 
shown to scale in the 
Preview window to 
the right.

Click the New Image... 
button to choose a 
different image. 

Use buttons to select the previous or next catalog image as the alignment preview image.
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Creating themes and templates
iView MediaPro introduces themes to help orga-
nize HTML gallery templates. A theme is simply 
a folder containing Index and Media HTML tem-
plates. By storing both templates in one folder it is 
much simpler to share a new gallery design with 
others users. 

A theme folder also contains an Assets folder 
for related HTML graphics and an image used as a 
preview of the theme in the HTML export dialog. 

MediaPro templates are normal HTML pages, 
that may contain one or more field phrases that 
get replaced with catalog content (such as anno-
tations) during the export process. The example 
at right is a simple HTML template which contains 
three MediaPro field phrases: (iView:Catalog), 
(iView:Media) and (iView:Filename). 

During export, all three phrases get replaced 
by the catalog name, the media image and the 
image file name respectively.

To learn more about creating themes and tem-
plates, refer to the About Templates document in 
the application’s Documentation folder.

A good way to learn is to make a copy of an 
existing template, rename it, and modify different 
fields or the design.  Modifying theme templates 
requires a modest knowledge of HTML. You can 
learn more about HTML from a basic HTML hand-
book or by reading tutorials on the Web.

HTML Template components: 
Templates:  Typically, each theme requires a 

template for both index and media pages. The 

FTP progress: The progress bar panel will display the progress of each file as its being uploaded to your server.
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Template: This basic Index page template would be one 
component of a typical HTML theme.

<html>
	 <head>
	 <title>(iView:Catalog)</title>
</head>
	 <body>	
	 	 <p>(iView:Catalog)</p>
	 	 <p>(iView:Index)</p>
	 	 <table>
	 	 	 <tr>
	 	 	 <td>(iView:Preview)</td>
	 	 	 </tr>
	 	 </table>
	 	 <p>Made	with	iView	MediaPro</p>
	 	 <p>(iView:Date)</p>
	 </body>
</html>

Basic Index template code

Template: This basic Media page template would be 
one component of a typical HTML theme.

<html>
	 <head>
	 <title>(iView:Catalog)</title>
</head>
	 <body>	
	 	 <p>Simple	Media	Template</p>
	 	 <p>Image:</p>
	 	 <p>(iView:Media)</p>
	 	 <p>File	name:</p>
	 	 <p>(iView:Filename)</p>
	 </body>
</html>

Basic Media template code
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index page template displays the media in your 
catalog much like the Thumbnail View. The Media 
page template is specific to a single catalog item 
and typically contains a larger image and/or infor-
mation regarding that catalog item. 

Tags: Tags are a rich vocabulary that control 
a range of functions from media rendering and 
page structure to navigation and extracting and 
repurposing metadata information. (See exam-
ples of HTML tags at right).

Most MediaPro tags are substituted by a single 
number or piece of text taken out of the catalog 
data. Simply place any text-based tags (iView:xxx), 
anywhere into an HTML page and it will get sub-
stituted with appropriate content. 

To learn more about tags, refer to the About 
Templates document in the application’s Docu-
mentation folder.

HTML Engine Directives: The size of images on 
Index and Media pages are now controlled in the 
theme using these new tags. Thumbnail tables 
are also controlled by directives. When a theme 
is selected in the HTML export dialog, MediaPro 
will populate the appropriate fields with the 
directive’s values.

Theme Fields:  Theme fields are a variation on 
HTML Engine Directives. These template instruc-
tions essentially create user-defined fields for 
text that can be entered by the gallery creator 
before export. See next page for an example of 
the Theme Fields dialog.

Structure for theme folders: Each theme 
has its own folder which contains the Index and 
Media templates as well as an Assets folder.  A 
preview JPEG of the template, called about.jpg, 
is optional. This image is displayed in the HTML 
Options > Theme panel.

Store your themes in the user-defined Plug-ins 
folder (see page 5) to ensure that they are not lost 
during MediaPro upgrades. 

HTML tips
To reduce the loading time of your Index 

pages: Include less than 25 images on a single 
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Directives: A template that has media width and height 
directives (above) will populate the appropriate fields 
when this theme is selected in the HTML export dialog. 
You can still make changes to the final export from this 
dialog without having to go back into the template.

Themes: Each theme contains an Index and Media 
template, as well as an Assets folder. Custom themes 
should be stored in the user-defined Plug-ins folder. 
On Windows, the Plug-ins folder is located at:

C:\Documents and Settings\username\Application 
Data\iView\Plug-ins

On Mac OS X, this folder is typically located at: 
~User/Library/Application Support/iView/Plug-ins

<!--	iView	HTML	Engine	Directives	
(iView:InMediaWidth	800)	
(iView:InMediaHeight	600)	
-->	

Tag What it controls/defines

(iView:Catalog) Title of iView MediaPro catalog file

(iView:GoPrevious) Link to previous media/index page

(iView:Running) Current index or media page number.

(iView:OriginalSize) File size of the original image

(iView:Duration) Duration of playable media.

(iView:Caption) IPTC Description field (aka Caption)

(iView:Date) The date of creation of the web gallery

Tags: Examples of MediaPro’s HTML tag phrases. Tags 
control a range of functions from media rendering to 
navigation to metadata information.
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Create a cross-platform CD
One way to create a catalog of images that is com-
patible with most operating systems (Windows, 
Unix,  MacOS), is to burn an exported HTML gallery 
onto a CD or DVD-ROM disc. Here is how to do it:
1. Create your catalog as usual, add the files, set 

the layout, add your keywords, annotations 
and captions. Since some computer platforms 
do not accept long file names, you should 
shorten all your file names to 8 characters or 
less. You can easily do this using the Batch 
Rename command in the Action menu. Use 
that same command to ensure that you have 
the proper file name extensions on all images 
or movies, as some platforms require exten-
sions. Remember, renaming files cannot be 
undone, so you might want to make a backup 
of your media before you rename them for 
this HTML gallery.

�. Export an HTML Gallery, using a MediaPro 
pre-defined theme or one that you created. 
HTML can be further customized with an 
HTML editor after export.  In this step, you will 
want to choose the HTML Extension “.htm” in 
the Settings pane. This will work on all plat-
forms. All links inside the gallery pages must 
be relative (e.g. .../img/hello.jpg) in order for 
them to work on a CD.

�. Burn your gallery files onto the CD: In order 
for your CD to be compatible with most oper-
ating systems, you must burn the CD in the 
ISO 9660 format.

4. Extra: You can use the Print Template called 
CD Jewel Case to print a cover for the CD you 
just created.
Another way to create a cross-platform CD or 

DVD of media for use on Mac and Windows plat-
forms is to burn your media, the catalog and copy 
of iView Catalog Reader on the CD or DVD. Using 
this royalty-free software, you can distribute and 
share your iView catalogs with non-iView users 
at no cost or restriction. See page 112 for more 
information on Catalog Reader.

index page. Also, you might try a small size thumb-
nail (96 pixels), with low JPEG compression.  

To reduce the load time of your Media pages: 
Try a smaller size media export (such as 480x320 
pixels), or increase the amount of JPEG compres-
sion in the Settings panel.  

To use a Cascading Style Sheet (CSS) with 
a theme: Using embedded style sheets will 
work fine with MediaPro themes. In order to use 
a linked style sheet, place the CSS file in your 
theme’s Assets folder. This way, the style sheet 
will be exported as a related asset of your gallery. 
Using the HTML Engine Directives for index table 
rows and columns, CSS and XHTML can now be 
used to control the positioning of tables. If your 
site already has a stylesheet that you would like 
to use, make sure that you write a complete URL 
to the existing CSS in your theme.
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HTML Options: Theme Fields panel. Theme fields are 
defined by HTML Engine Directives embedded in each 
template.  This example shows special fields for you to 
enter the client’s name, job number and assignment 
details. This information will then appear in a designated 
space on exported web pages.
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Send Email
This function enables you to export a copy of  
selected media items and attach them to a new 
email ready to be sent. 

MediaPro can email a copy of the original 
file, or it can convert images to create a resized, 
compressed and watermarked JPEG that can be 
emailed. Optionally, you can choose to automati-
cally include annotation information in the body 
of the email for each media item.

How to email media items
1. Select an item or group of items.
2. Click the @ toolbar icon, or choose Send Email 

from the Action menu.
3. Choose your options and click OK.
4. Switch to your email application.  Your email 

will be in your Drafts folder. 
5. Add a Subject and your recipients email 

address to the email.
6. Send your email.
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Email Client options:
On the Mac, you can 
choose from Microsoft 
Entourage and the OS X 
Mail client. On Windows, 
you can choose from 
Outlook, Outlook Express. 
To email items using other 
email applications (such as 
Eudora or PowerMail), try 
using MediaPro’s Helper 
Application function. See 
page 110 for instructions.

Compression quality:
In this drop-down menu,  
choose the JPEG compression 
quality for the images that will 
be emailed. The Custom option 
enables you to define the 
maximum file size of emailed 
images.

Displays the number of 
items selected to be emailed.

Resize media:
This slider provides five 
predefined sizes for the 
images you wish to email. 
The options are: 160, 320, 
640, 800,1024 and 1280 
pixels. Each image will be 
proportionally resized to fit 
this dimension.

Resize and compress 
media: If you do not 
check JPEG Compress 
Media, MediaPro will 
simply email a copy 
of the original file. 
Checking this box 
provides you with 
options to define the 
JPEG compression 
quality, dimensions of 
the exported images, 
as well as the option to 
apply a watermark.

Sent Files:
Select a folder to store 
media files to be attached to 
emails. Attachments may be 
deleted after your email has 
been sent. 
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Include media summary with each 
email: If this option is checked, all 
IPTC/XMP annotations will be included 
in the body of the email message.  Of 
course, the amount of annotation 
information will vary for each item.

Create multiple emails: Checking 
this option will create a separate email 
for each item to be emailed. If left 
unchecked, all items will be  attached 
to a single email.

Embed metadata in media 
attachments: If this option is checked, 
MediaPro will write (synchronize) 
all IPTC/XMP annotations into 
the exported email image. This 
enables your email recipient to 
open the image in MediaPro or 
Adobe Photoshop and review all the 
associated annotations.

Options

Set Watermark: 
As with all image export 
functions, MediaPro 
provides the option to 
apply a visual watermark 
— a secondary image 
which is overlaid on 
the primary image, and 
provides a means of 
protecting the image. 
This is not the same 
as digital watermarks 
which are implemented 
algorithmically and are 
designed to be invisible. 
For instructions on how 
to create and apply a 
watermark, see page 96.
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Text Data File 
The Text Data File function allows you to export 
media properties and annotation fields as a text 
file. This file can be imported into 3rd-party data-
base or spreadsheet applications. You can save 
the text as a tab- or comma-separated format. 

You can also export your data using the Merge 
option, in order to create personalized documents 
like form letters. In Microsoft Word, for example, 

you can combine variable data (like media names, 
or properties) in a merge file with text in a main 
document. The Merge option is particularly use-
ful when importing information in FileMaker Pro 
or Microsoft Access since it auto-detects fields to 
place imported data. 

For repeat use, save your settings using the 
Options pop-up menu. Saved options can be 
incorporated in scripts. 

Text Table Options  
is accessed by 
choosing Text Table 
in the Make menu. 
Use the yellow 
arrows to add, 
remove or reorder 
desired fields.

For repeat use of your settings, save them using the Options 
pop-up menu. Saved options can be recalled at any time 
and can be incorporated in scripts. This feature is standard to 
MediaPro export functions.

An example of an exported text table that has been imported in Microsoft Excel™.

Format options of 
the exported text 
file.

Use these Up and 
Down arrows to 
set the order of 
exported fields in 
the text table.

Use these arrows 
to add or remove 
fields from the 
exported text 
table. Double 
arrows will Add 
All or Remove All 
fields.
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XML Data File
XML (Extensible Markup Language) is a flexible 
way to create common information formats and 
share both the format and the data on the Web or 
with other applications and databases. 

MediaPro’s XML Data File function exports an 
XML file containing basic file-related information 
for all media items in the catalog. The XML Data 
File export dialog offers the option to include 
Media properties, Annotations and EXIF data (digi-
tal camera info) in the XML Data File.  

XML is similar to the language used for Web 
pages, Hypertext Markup Language (HTML).  Both 
XML and HTML contain markup tags to describe 
the contents of a page or file. HTML describes how 
to display and interact with the content of a Web 
page.  XML describes the content in terms of what 
data is being described.  

This means that an XML file can be processed 
purely as data by a program or it can be stored 
with similar data on another computer or, like an 
HTML file, it can be interpreted and displayed. 

MediaPro uses a custom DTD (Document Type 
Definition) to define the markup of an exported 
XML file.  A DTD is a specification that accompanies 
a document and identifies what are the markup 
tags. By including a DTD with an XML document, 
another application will be able to process the 
document and display or print it as intended. 

Export Catalog as XML file (File menu): This 
feature export all catalog text contexts and attri-
butes as an XML file, along with folders containing 
thumbnails, audio annotations and original files. 
At any point,  the entire XML catalog file can be 
reimported into MediaPro.

XML: Sample portion of an exported XML Data File. 

<MediaProperties>
	 <Width	unit=”Pixels”>5325</Width>
	 <Height	unit=”Pixels”>3543</Height>
	 <Resolution	unit=”DPI”>300</Resolution>
	 <Depth	unit=”Bits”>24</Depth>
	 <PrimaryEncoding>PhotoJPEG</PrimaryEncoding>
	 <ColorProfile>sRGB</ColorProfile>
</MediaProperties>

Export metadata: 
MediaPro’s XML Data 
File function exports 
an XML file containing 
basic file-related 
information for all 
media items in the 
catalog. The export 
dialog offers options to 
include Media properties,  
Annotations and EXIF 
data (digital camera 
info) in the XML Data 
File.  

Options: Check 
Include document  
type definition to 
embed the custom 
iView DTD in the 
exported XML file.

Create Folders: 
Checking any of 
these boxes will 
create a folder 
for thumbnails, 
voice annotations 
and copies of the 
original media 
files. If these boxes 
are not checked,  
this content will 
not be exported 
with the XML file.

Transforming XML:  
Use the plus sign 
to choose an XSL 
stylesheet. XSL defines 
the presentation of an 
XML document and is 
used to translate XML 
documents into other 
formats.
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Contact Sheet 
This export option creates contact sheets as imag-
es files (such as JPEG or Photoshop) which can be 
printed or emailed to your clients. 

MediaPro automatically calculates the number 
of items that can fit in the designated contact 
sheet size, taking into account the View Options 
of your catalog’s List or Thumbnail View. 

List View is useful for printing a table of con-
tents of your catalog. This style matches the layout 
of the catalog’s List View, with icons and associ-

ated field information of each file. 
Thumbnail View prints a table of thumbnails 

similar to your catalog’s Thumbnail View. The size 
of the thumbnail in your catalog determines the 
size of the thumbnail in the contact sheet.

To adjust the visual settings of your contact, 
go to View Options in the catalog and make any 
necessary changes. 

The size, resolution and format of the contact 
sheet image file can be customized in this dialog.  
Headers and footers can also be added.

Supported file format 
options of the exported 
contact sheet file.

Format settings: Each file type (JPEG, BMP, etc.) will have various options for compression 
and color quality of the exported contact sheet image. Simply choose the quality of the 
exported contact sheet, or choose a target file size for MediaPro to produce. This dialog 
will change depending on the file format.

Preview pager: Choose which 
page appears in the preview 
window on the right. 

If you have more media items 
than can appear on a single 
Contact Sheet, MediaPro will 
output as many pages as 
necessary to completely export 
the catalog as contact sheets. As 
you adjust the dimensions of the 
Contact Sheet, the number of 
exported pages is adjusted. 

Units: Define the size 
of the exported contact 
sheet in pixels, inches or 
centimeters.

Layout: Choose from 
two styles of contact 
sheet: List or Thumbnail. 
See next page for more 
on layout options.

Real-time preview of your contact sheets.
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Contact sheet examples: Exported contact sheets will inherit the image size, visual appearance and displayed fields of the 
Thumbnail View. To alter the appearance of a contact sheet, you must change the View Options of the Thumbnail or List View 
before opening this dialog. Remember, some thumbnails are imported into the catalog by using the file’s built-in thumbnail, 
which may be of poor quality. If your contact sheet thumbnails are coming out poorly, have MediaPro remake them by 
selecting the thumbnails and choosing Rebuild Item in the Action menu. Then try creating your contact sheets again.  

Header

Options: Choose Zero pad increments to add zero-padding to the sequential numbers. For example: 001, 
002, 003 instead of 1, 2, 3. This is valuable because it will keep files in sequential order on your desktop and 
removable media.  Without zero padding, the files would be in this order: 1, 10, 11, 12, etc. 

Footer
Headers/Footers: Choose the + or - signs to add or remove a header or footer. MediaPro 
will accept headers and footers in the TIFF, PSD, JPG, PICT, PNG, BMP, GIF image formats.
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File Conversion
The File Conversion functions (Action menu) are 
useful for single or batch conversion of images, 
movies, animations, or sounds.  

Convert Image Files... will convert images, as well 
as poster frames from animations, into a new for-
mat such as JPEG, TIFF, etc. To convert to other for-
mats, you will need to use a 3rd party application. 

Existing color profiles, EXIF metadata,  IPTC 
annotations and associations with sets can be 
exported to the converted media files. JPEG and 

TIFF image conversions have the option to pre-
serve EXIF metadata. JPEG, TIFF and Photoshop 
conversions can preserve ITPC annotations.

When converting Camera Raw files, MediaPro 
uses the large embedded preview as the image to 
be converted. The actual raw data is not converted.

Sound conversions will convert sound files as 
well as soundtracks from selected movies. 

For frequent use of this feature, you can save 
settings using the Options menu. Saved options 
can be incorporated into scripts.

Supported file format 
options of the exported 
contact sheet file.

Options: 
Preserve color profiles 
will embed the 
ICC color profiles 
into each exported 
image. This option is 
available when you 
have color matching 
(Mac: ColorSync) 
turned on in the 
Preferences > Media 
Rendering dialog. 

Preserve EXIF/GPS 
metadata will 
embed the EXIF and 
GPS digital camera 
metadata into all 
exported images. 
This option is only 
available for JPEG 
and TIFF conversions. 

Embed annotations: 
MediaPro will 
embed all IPTC/XMP 
Core annotations 
into each exported 
image. This option 
is only available 
for JPEG, TIFF and 
Photoshop format 
conversions.

Image File Conversions

Format settings: Each file type 
(JPEG, BMP, etc.) will have various 
options for compression and color 
quality of the exported contact 
sheet image. Simply choose the 
quality of the exported contact 
sheet, or choose a target file size 
for MediaPro to produce. This 
dialog will change depending on 
the file format.

Files: Replace original 
files will replace the 
original with the 
converted image.
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Set Watermark: 
As with all image export 
functions, MediaPro 
provides the option to 
apply a visual watermark 
— a secondary image 
which is overlaid on 
the primary image, and 
provides a means of 
protecting the image. 
This is not the same 
as digital watermarks 
which are implemented 
algorithmically and are 
designed to be invisible. 
For instructions on how 
to create and apply a 
watermark, see page 96.

Scale media to fit will export the image to the size you 
define. However, exported images are not distorted 
to fit these dimensions exactly. Rather, the larger 
dimension (width or height) will conform and the 
smaller dimension will proportionally adjust. 

Landscape images are 
proportionally scaled 
to the width. 
Width: 640 px
Height: 480 px

Size Settings: Scale Media to Fit
Dimensions: Width: 640 x Height: 640
Using a standard 4:3 aspect ratio image

Portrait images are 
proportionally scaled 
to the height. 
Width: 360 px
Height: 480 px

Portrait images are 
proportionally scaled 
to the height. 
Width: 480 px 
Height: 640 px

Landscape images are 
proportionally scaled 
to the width. 
Width: 640 px
Height: 480 px

Understanding media scaling options

Size Settings: Scale Media to Fit
Dimensions: Width: 640 x Height: 480
Using a standard 4:3 aspect ratio image

Options
Use natural bounds defines the exported image 
using the existing image dimensions. 
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Movie conversion
will convert movies and 
animations into a new format. 
On the Mac: If you convert 
to DV Stream, the file can be 
imported into Apple’s iMovie 
for additional editing. 

Sound conversion will convert 
audio files as well as soundtracks 
from selected movies.

Settings: Each file type (AVI, DV Stream, etc.) 
will have various options for video and sound 
compression, frame rates, channels and more.

Files: Replace original files will replace the 
original with the converted image. If you have 
not checked Selected items only, MediaPro will 
convert all items in the catalog.

Settings: Each file type (AIFF, Wave, etc.) will 
have various options for compression, sample 
rates, sample size and  more.

Files: Replace original files will replace the 
original with the converted image. If you have 
not checked Selected items only, MediaPro will 
convert all items in the catalog.

Sound File Conversions

Movie File Conversions
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Backup/CD-ROM
This feature (Make menu) enables you to prepare 
CDs and DVDs for burning using the built-in disc 
burning technology on Windows XP and Mac  
OS X. Backup is also ideal for archiving digital files 
onto disk partitions, removable disks (e.g. Zip) or 
hard drives on a network. 

MediaPro automatically scans your computer 
for available hard drives, partitions and removable 
media, such as CD, DVDs and Zip drives. It places 
available locations for backup in the Destination 
pull-down menu. 

When backing up files to a CD or DVD that 
will be burned with the Mac operating system’s 
built-in disc burning technology, the CD or DVD is 
named on the desktop after it has been inserted 
into the drive.

Additional options enable you to backup All 
media files or Only visible media files in the catalog 
(e.g. showing a set in the active view). You can also 
keep the folder structure of your original media, as 
well as include a copy of the MediaPro catalog with 
your backup. 

The Reset paths option will reset the paths of 
items in the open catalog to the location of the 
media files that have been backed up. For exam-
ple, if you backed up a group of files to a CD-ROM, 
the catalog would reset paths of those items to 
the media on the CD-ROM. 

To backup your media, choose your options, 
then click the Backup button. MediaPro may ask 
you to save the catalog before burning.

Before burning backup files to a CD or DVD, you 
might also consider placing a copy of the iView 
Catalog Reader application on your removable 
media. Using this royalty-free software, you can 
distribute and share your iView catalogs with 
non-iView users at no cost or restriction. 

To include Catalog Reader, simply copy it to 
your removable media before burning. iView 
Catalog Reader is included with the MediaPro 
install CD.  If you need either the Mac or Windows 
version, it can be downloaded from the iView web 
site (www.iview-multimedia.com).

Catalog Reader has the same system require-
ments as iView MediaPro (see page 5) and will 
need QuickTime on the host computer in order 
to function properly.

Alternative Backup: Transfer to Folder
The Backup function does not provide the option 
of choosing a particular folder. MediaPro’s Transfer 
to Folder feature will do this. 

Select a file, group of files, or all files in the cata-
log, then choose Transfer to Folder in the Action 
menu. This dialog has three options for copying 
and moving files.

• Move files: Moves media files to a new folder, 
deleting original files. Catalog items will refer 
to the new files in the new folder. 

• Copy files: Copies media files to a new folder, 
keeping the original files. Catalog items will 
refer to the files in the new folder.

• Duplicate files: Copies media files to a new 
folder. Catalog items and referenced files will 
remain unchanged.
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Backup dialog: MediaPro automatically scans your 
computer for available hard drives, partitions and 
removable media and places them in the Destination 
pull-down menu. 
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Image editing: Assign an application such as 

Adobe Photoshop or Jasc Paint Shop Pro as a Helper 
for editing photos. Find images that you want to 
edit, open them in the Photoshop, make correc-
tions to the images, then save them (over the exist-
ing files, or as a copy to a new folder). When you 
go back to your MediaPro catalog, the edits will be 
reflected in updated thumbnails.  If you saved the 
images as copies to a new folder, they will need to 
be imported into the catalog.

Edit anything: The same technique for edit-
ing images can be applied to just about anything 
- desktop publishing files such as InDesign and 
Quark; graphics files such as Freehand or Illustra-
tor; even audio, video and text files. Just assign the 
appropriate application for the file and execute 
the Open With command.

Raw conversion: Select a batch of raw images, 

Helper applications
Your workflow will most likely involve performing 
some actions outside of the MediaPro working 
environment, such as advanced image editing 
with Adobe Photoshop. 

This is where iView MediaPro’s Open With Helper 
Application function comes in handy. The way it 
works is simple: Select any file (or group of files) in 
the catalog and open it with a Helper application 
directly from MediaPro. 

This keeps you from having to launch an appli-
cation, navigate through the desktop and locate 
the file, thereby cutting extra steps out of your 
workflow.

Add a Helper
When first launched, MediaPro will automatically 
scan your computer for Helper Applications, but 
you may want to add or remove some later.
1. Choose Define Helper Applications in the 

toolbar’s drop-down menu (see figure) or 
in the contextual menu or in Preferences > 
Helper Applications menu. This dialog will let 
you choose media editors, utilities or viewers 
so that you may quickly access them via the 
toolbar or through a contextual menu. 

2. Click Add in the Define Helper Applications 
dialog box (see figure). Navigate to the desired 
application and select it. 

3. Click OK.  The Helper Application will be added 
to the list in alphabetical order. 

Open items with a Helper Application
1. Select a group of images.
2. Choose a Helper Application, such as Adobe 

Photoshop, in the toolbar menu (see figure), or 
through a contextual menu. Right-click (Mac: 
Ctrl-click) to access a contextual menu.

3. The application will launch and open the 
batch selection of files.

How Helpers can assist you
The possibilities are limitless for using Helper 
applications in your workflow. Here are some ways 

Add Helper:  To add a Helper, click Add and navigate to 
the desired application on the desktop and select it. 

Open With: After 
selecting images, you 
can execute an Open 
With Helper command 
two ways:  In the 
toolbar’s icon pull-
down menu (left), or 
through a contextual 
menu. Right-click (Mac: 
Control-click)  
to access a   
contextual menu.
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and open them with a raw image converter, such 
as Capture One PRO, Adobe Photoshop, Adobe 
DNG Converter or Canon Raw Converter. You 
images will be ready to color correct and process.

Compression and packaging: Assign applica-
tions such as WinZip or Allume Systems’ StuffIt, 
DropStuff or DropZip tools to compress items or 
create self-expanding files for Mac and Windows.  
This method is excellent for packaging a group of 
media files for email, backup or burning.

CD/DVD Burning & Backup: Assign any CD 
and DVD-burning application as a Helper and 
add files to a new disc image ready for burning. 
Of course, this action is similar to, but not exactly 
the same as, iView MediaPro’s Backup command 
(see page 109).

Email: You can add any file, direct from MediaPro,  
as an attachment to an email. To do this select the 
file, then choose a mail client (such as Outlook) in 
the Helper application drop-down and the file will 
automatically open as an attachment to a new 
email. Results will vary depending on your email 
client and operating system. This is a useful option 
if your email client is not supported by MediaPro’s 
Send Email function. 

Previews and Players: While MediaPro is an 
excellent viewer for almost every format, you may 
want to view your files in another application such 
as the Mac OS X Preview app, browsers such as 
Internet Explorer, or Windows Media player. If you 
use other players, such as iTunes, WinAmp or Audi-
on, set them as Helpers. This will make it easy for 
you to add a particular MP3 to player’s database.

Font management: On Mac OS X, you can 
assign Font Book as a Helper for a quick, efficient 
way to add fonts from a MediaPro catalog to the 
active fonts panel. This means that making any 
font active in your system only one click away.

Droplets: Droplets created by Adobe Photoshop 
or ImageReady can be integrated into your work-
flow by assigning them as Helpers. A “Rotate 90 
Left” Photoshop droplet or “Make JPEG (quality 
60)” ImageReady compression droplet will save 
you quite a bit of time when used as an MediaPro 

Helper application. 
Applets (Mac):  Any AppleScript applet, scriplet 

or droplet that has been saved as an executable is 
viewed by your operating system as an application 
and can be defined in MediaPro as a Helper. 

Online Photo Printing Services:  While iView 
MediaPro does not have built-in functionality for 
ordering prints from an online photo service, it’s 
easy to make MediaPro work with photo services 
by using Helpers. 

Simply set the online photo service software 
as an MediaPro helper application. Then open 
the images with this helper application. For some 
photo service software, this may not work. In that 
case, you can select the images you want and 
drag-and-drop them from the MediaPro catalog 
to the printing service software. This method also 
works well with Apple’s iPhoto software.
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Applets and Droplets: Examples of droplets created by 
Adobe ImageReady, Photoshop and AppleScript Editor 
(Mac). Any AppleScript applet, scriptlet or droplet  is an 
application and can be defined in MediaPro as a Helper.

Email: When you use Windows’ Outlook or Mac OS X’s 
Mail client as a Helper application, it automatically takes 
any selected file in an MediaPro catalog and adds it to a 
new message as an attachment. This is ideal for mailing 
photos to family and friends.
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iView Catalog Reader
This new software from iView allows you to dis-
tribute and share your iView catalogs with anyone 
at no cost or restriction. Catalog Reader is free to 
download and distribute and works on both the 
Macintosh and Windows platform.

iView Catalog Reader will open catalogs writ-
ten by iView Media 1.2 or higher and MediaPro 
1.5 or higher. It has the same file format support as 
MediaPro and includes the Slide Show function.

Catalog Reader has the same system require-
ments as iView MediaPro (see page 5) and will 
need QuickTime on the host computer in order 
to function properly.

Burn iView Catalog Reader and your catalog to 
CD or DVD, send by email, or across a network to 
enable others to view your catalog.

Catalog Reader is included with the MediaPro 
install CD.  If you need either the Mac or Windows 
version, it can be downloaded from the iView web 
site (www.iview-multimedia.com).

You can choose not to include your original 
media with a catalog which you distribute. This 
lets you protect your digital assets from being 

copied while allowing others to view the List and 
Thumbnail Views. If you include original media 
this will allows a Catalog Reader user to access 
the media contained in a catalog. If your catalog 
contains Full Screen Previews, a Catalog Reader 
will be able to view them in Media View.

iView Catalog Reader does not allow the viewer 
to make any alterations to your catalog or to cre-
ate new catalogs. You do not have to purchase 
iView MediaPro to use Catalog Reader.

Protecting distributed catalogs 
Once you have created a catalog  for distribution 
with iView Catalog Reader, you might want to 
allow only certain people to  view or access it. To 
set password protection for a catalog:
1.  Select Catalog Info from the File menu.
�.  Click the Set Password button. This button is 

only available if you have saved your catalog.
�.  Type the password. Then save the catalog. 
4.  When opening the catalog in the future, you 

will be asked to provide the password before 
you can view the catalog’s contents. 
For additional security options, see page 22.
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The iView Catalog Reader interface is slightly different from MediaPro.
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As you use iView MediaPro, you’ll find that you 
perform certain tasks over and over. Using scripts, 
you can automate some of these tasks. A script is a 
series of commands that tells MediaPro and other 
applications what to do.

MediaPro can be scripted to perform basic func-
tions such as annotate, convert, organize and print. 
Or it can be scripted to perform a complex series 
of tasks such as: copy images from a media card to 
a new folder on your computer, build a MediaPro 
catalog, assign and embed annotations in the 
images, and save the catalog to the same folder.

Scripts can work in collaboration with other appli-
cations that are scriptable. Using scripts, MediaPro 
can be easily integrated with 3rd-party applications, 
Web services or database systems to perform work-
flow automation. 

Scripting 
Windows: MediaPro supports Visual Basic Script 
and JavaScript automation on Windows operating 
systems. Once you create a script, you can attach 
it to the application for access through the Scripts 
menu. For instructions on creating scripts, refer to 
the scripting documentation, Windows Scripting 
Guide, included with MediaPro. It is located at:

• C:\Program Files\iView MediaPro\ 
Documents\
Mac: MediaPro supports AppleScript automa-

tion on OS X. Once you create a script, you can 
attach it to the application for access through the 
AppleScript menu (see figure). To get started with 
scripting, review MediaPro’s scripting dictionary 
and the sample scripts included with MediaPro. 
They are located at:

• /Applications/iView MediaPro/ 
Documentation/Examples AppleScript 
Please note that MediaPro 2 introduced a num-

ber of changes to the AppleScript dictionary, so if 
you are using an older script, test it first. 

To create a script, use a text editor or a spe-
cial application such as the Script Editor, which is 

Automate tasks and workflow

included with Mac OS X. Test your existing scripts 
to ensure proper functionality before using them 
with cataloged media.

Attaching scripts to MediaPro
The iView MediaPro installation creates a Plug-ins 
folder containing files that are important to the 
application’s functionality. MediaPro also creates a 
user-defined Plug-ins folder for you to customize 
or install additional functionality, such as scripts, 
HTML templates, print templates, favorites lists,  
and media importers. 

The MediaPro Scripts menu displays all scripts 
from both Plug-ins > Scripts folders. When install-
ing custom scripts, place them inside the user-
defined Plug-ins folder, and not the application 
Plug-ins folder. This way you will not lose your 
custom settings and plug-ins when upgrading 
to future versions of MediaPro.

Windows: The user-defined Plug-ins folder is 
located in one of the following locations:

• C:\Documents and Settings\username\ 
Application Data\iView\Plug-ins

• C:\Documents and Settings\All Users\ 
Application Data\iView\Plug-ins
On some Windows operating systems the Appli-

cation Data folder may be hidden. To display hid-
den files and folders on Windows XP:
1. Click Start and then click Control Panel.

Scripts: 
You can add 
scripts to the 
AppleScript menu
(Mac) by placing 
them in the user-
defined Plug-ins > 
Scripts folder.

Custom scripts 
appear at the 
bottom of the 
Scripts menu.
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�. Click Appearance and Themes and then click 
Folder Options.

�. On the View tab, under Hidden files and folders, 
click Show hidden files and folders. Hidden files 
and folders will appear dimmed.
Mac: The user-defined Plug-ins folder is located 

in one of the following locations:
• ~User/Library/Application Support/iView/
Plug-ins

• /Library/Application Support/iView/Plug-ins
• Network/Library/Application Support/iView/
Plug-ins

Scripts for importing
MediaPro provides two scripts for importing cata-
logs created by other digital photo management 
applications:

• iPhoto (Mac): Choose iView MediaPro > Get-
ting Started and select Import iPhoto Library. 
MediaPro will automatically find the iPhoto 
library for the active user and import all origi-
nal photos into a new catalog. This feature 
works with iPhoto 2, 4 and 5.

• Adobe Photoshop Album (Windows): Select 
Scripts > Import > Import from Photoshop 
Album. MediaPro will find the Photoshop 
Album catalog for the active user and import 
all original photos into a new catalog. This script 
works with Photoshop Album 1, 2 and 3.

Folder actions (Mac only)
A folder action is an AppleScript that you attach to 
a folder. Triggered by certain events, such as when 
you open or close the folder or add an item to it, 
the folder action script performs some function.

The function could be to upload (FTP) files to a 
Web server, copy files to a backup hard drive or to 
batch print files to a network printer. The function 
is determined by the attached script.

Folder actions are powerful automation tools 
when combined with MediaPro’s Catalog Folders 
tool (Organize Panel). A folder action will be activat-
ed by dragging-and-dropping images onto the rel-
evant folder in the Catalog Folders pane. Likewise, 

you could move or duplicate files to a folder that 
has an attached script using the Action > Transfer 
To Folder function.

Scripts as Helper Applications
Helper Applications are other programs installed 
on your computer that you can use to edit, play, 
view or compress catalog items. Using Helpers 
keeps you from having to launch an application, 
navigate the desktop and locate a file. 

Some scripts, depending on how they are created, 
are viewed by the operating system as an applica-
tion and can be defined in MediaPro as a Helper (see 
pg. 110 for instructions on defining Helpers).

Droplets created by Photoshop or Image-Ready 
can be integrated into your workflow by assigning 
them as Helper Applications (see figure). A Rotate 
90-degree clockwise Photoshop droplet or Make 
JPEG (quality 60) ImageReady compression droplet 
will save you quite a bit of time when used as a 
MediaPro Helper. Any AppleScript applet, scriplet 
or droplet that has been saved as an executable 
can be defined in MediaPro as a Helper.

Sharing scripts
The iView customer forum has several topic areas 
dedicated to scripting solutions. MediaPro’s com-
munity of customers use this forum to share 
answers to common questions, advanced tech-
niques and scripts they have developed.
Online at: www.iview-multimedia.com/forum/

Droplets: Examples of droplets created by Adobe 
ImageReady, Photoshop and AppleScript Editor (Mac) 
which can be defined in MediaPro as a Helper.
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Installed scripts
The Scripts menu displays scripts that are inside 
MediaPro’s Plug-Ins - Scripts folder. Since scripts can 
be attached to MediaPro, you can place additional 
scripts in this menu to access them while using 
MediaPro.  To add your scripts to this menu, place 
them inside the user-defined Plug-ins folder (see 
page 5 for location).

Annotate
• Copy Photo Data to Clipboard copies all EXIF 
photo metadata to clipboard.

• Import From PhotoDISC™ (Mac) annotates 
images in your front catalog, using text files 
located in your PhotoDISC™ CD-ROM.

• Make Caption from Photo Data copies all EXIF 
photo metadata into the Caption field. 

• Make Caption from Text Files (Mac) searches for 
.txt files in the same folder as the original, and 
copies the contents into the caption field.

• Make Caption from Text Lines (Mac) opens a 
text file and uses each line of the file as the 
caption for the selected items.

• Make Event Date from Capture copies the EXIF 
Capture Date and puts it into the Event Date 
of the Annotations pane. 

• Make Keywords from Folders (Mac) enables 
you to add keywords to media files from 
folder names. The pop-up dialog provides the 
option of defining the level of folders in the 
path you would like to use for keywords. 

• Make Product from EXIF Data (Mac) copies the 
EXIF Maker and Model fields and puts them 
into the annotations Product field .
You can modify existing scripts or create and 

attach your own annotation scripts at any time. 
Simply write the script, then place it in the Plug-ins 
- Scripts - Annotate folder.
Desktop Picture (Mac)

• Add sets the desktop picture of the main 
monitor to the selected item of the front 
catalog. 

• Remove discards the desktop picture of the 
main monitor.

Files
• Rename Using EXIF Date renames files using 
valid EXIF Capture Date field. See Media Info 
Panel to view the Capture Date field.

• Rename Using Text File (Mac) opens a text file 
and uses each line of the file as the new name 
for the selected items.

• Set File Comment (Mac) will save the Caption 
field inside the file’s comment field, visible in 
the Finder and the “Get Info” window of origi-
nal files. 

• Set File Label (Mac) will set the color label of a 
file using label marking ID set in catalog.

Import (Windows)
• Import from Adobe Photoshop Album will assist 
you in converting a Photoshop Album library  
to an iView MediaPro catalog.

Select
• All Landscape will select all images that are 
horizontal.

• All Portrait will select all images that are verti-
cal. Square images will not get selected by 
either script.

Tools (Mac)
• Copy HTML Theme will offer the option to 
choose an HTML theme and place a copy of it 
to the user-defined Plug-ins folder (see pg. 5).

Web (Mac)
• Visit iView Online will launch the home page 
of iView Multimedia’s web site in the default 
web browser.

Other (Mac)
~Empty Trash will empty the trash in the Finder.
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AppleScript menu: 
(Mac) You can add 
your own scripts 
to this menu by 
placing them in 
the user-defined 
Plug-ins folder 
(see page 5 for the 
location of this 
folder).
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Option sets
Several complex functions in MediaPro offer the 
ability to save a set of options for easy recall and 
repeat use. These settings are stored in the Options 
menu of a function’s dialog box (see figure). Saved 
options can be incorporated in scripts. 

The following functions can store Options:
• Find: Save and recall simple or complex bool-
ean (and/or) search strings.

• Batch Rename: Store combinations of settings 
for file renaming. 

• View Options: Store the display options for 
text, color and metadata of the List, Thumb-
nail and Media Views. A view’s Size menu 
options are also stored with an option set.

• HTML Gallery: Store variations on theme set-
tings for different clients or projects. The Site 
Title is not stored with an option set.

• File Conversion (Images): Good for saving con-
versions with a specific purpose, such as com-
pression for Web or email distribution.

• Text Table: Save and recall various metadata 
groupings that you wish to export (see figure).

• PDF Maker: Store page layout styles for the 
production of high-res PDFs. 

Save an option set
1. Ensure you have all the function’s dialog 

options set appropriately.
�. Select Save from the option set menu. 
�. Type the name of the option set, and click OK. 

Option sets menus are listed alphabetically. 
If you want to force a particular option set to 
appear at the top the list, then put a blank 
space as the first character of the name.

4. Tip: There are no methods for renaming an 
option set. If you want to change the name, 
you must save the option set a second time 
using a different name, the remove the old 
one from the list.

Remove an option set
1. Select Remove from the option set menu.
�. In the dialog, select an option set and click the 

Remove button.
Share an option set
You may want to install option sets on other com-
puters in a workgroup or share them with other 
MediaPro users. Option sets are small custom files 
and are easy to copy, share and install.
1. Locate the user-defined Plug-ins > Option Sets 

folder. See page 5 for instructions on locating 
this folder.

�. There are several folders of option sets:  
CLGE = PDF Maker; BREN = Batch Rename; 
IMGC, SNDC and MOVC = File Conversion; 
LAY0, LAY1, LAY2 = List, Thumbnail, Media View;  
HTML = HTML Gallery; TEXT = Text Table. 
Find option sets cannot be shared.

�. Copy the desired option set to the desktop 
and distribute it to whomever you wish. The 
recipient must place the option set in the cor-
rect corresponding option set folder.

4. Tip: It is important that the recipient/user of 
your shared option set has the same version 
of MediaPro as you. Also, when sharing HTML 
Gallery option sets, your recipient will need 
to have the relevant themes installed for the 
option set to function properly.

Option sets are 
good for saving and 
recalling a large group 
of settings. Option 
menus are typically 
located in the lower 
left of a dialog.

A
u

to
m

at
io

n



Image Editing   117

iView MediaPro offers powerful image editing 
as well as calibration tools that can enhance the 
color, sharpness and brightness of your images. 

Image Editor 
The features of this tool apply only to image file 
formats (such as JPEG or TIFF) and will not work 
on movies or vector graphics. 

The Image Editor can be launched from the 
toolbar icon ( ), or by selecting Show Image Edi-
tor from the Window menu.

In order to properly preview the filter effects 
of the Image Editor, MediaPro will automatically 
switch to Media View when a filter is selected.

To edit images, use the following process:
1. Choose a filter from the Image Editor palette 

by clicking on the filter name in the list. 
�. Make your edits in the pop-up filter dialog, 

the press OK. Apply as many filters to the image 
as necessary. Use the Revert button to discard all 
changes and reload the original image. Use the 
Undo button to remove the effect of the last filter 
applied.

�. Image modifications by any of the tools 
described in this section are not saved until you 
press the Save button in the Image Editor palette. 
The Save button launches a dialog to define com-
pression and file type settings. To overwrite the 
existing file simply press Save. This dialog also 
gives you the option of storing a backup copy of 
the original file in a folder of your choice, or in the 
Version Control folder.

Saving image files will remove embedded 
digital photo annotations (EXIF) that may have 
existed in the original file, unless you check the 
option to Preserve EXIF metadata in the Save dia-
log. IPTC and XMP metadata cannot be preserved. 
You must synchronize them after saving, using the 
Sync Annotations command (page 57).

The following pages describe how each of the 
Image Editor filters and tools work. You can use as 
many filters as you want before saving changes.

Image Editing and Version Control
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Image Editor palette 
The Image Editor can be launched from the 
toolbar icon, or by selecting Show Image Editor 

from the Window menu. To launch a filter or image 
editing tool, click the name in the filter list. 

Click the arrow to show 
or hide the Version 
Control section. 
For instructions on how 
to use Version Control, 
see page 83.

Undo removes the effects 
of the last filter applied.

Revert reloads the image 
from the original.

Save launches a save dialog.
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Crop 
The Crop tool is used to reduce the visible area of an 
image. To begin cropping, click the image and draw a 
box around the desired area. MediaPro grays out the 
area that will be cropped. Click the OK button to accept 
the crop.

Before accepting the crop, you can adjust the edges 
of the selection to fall exactly at the desired location. 
Simply place the cursor over one of the four sides 
and drag to the desired location. While adjusting the 
cropped area, you can review the coordinates of the 
crop in the Area fields. 

To constrain the proportions of a crop, check the 
Constrain box and enter the desired dimensions. This is 
useful for cropping an image for a specific print, screen 
or video sizes, such as 4x6 or 640x480. 

You can adjust the unit of dimension displayed in this 
dialog by selecting pixels, inches or centimeters in the 
Units pull-down menu.

Click Cancel to exit the Crop tool.
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The Units pull-down 
menu controls the 
unit of measure: pixels, 
inches or centimeters. 

To move the cropped 
area, place your cursor in 
the active area, then click 
and drag the hand ( ). 

Resize the cropped area by clicking and 
dragging on any of the red control corners.  When 
proportions are not constrained,  you can pull on 
any side to alter the crop (see below).

Area defines the Left and Top edges 
of the cropped area in relationship to 
the original image. This is similar to X/Y 
coordinates used in other applications.

To begin cropping, click the image 
and draw a box around the desired 
area. MediaPro grays out the area 
that will be cropped.

Width and height 
are the dimensions 
of the cropped 
area.  The lock icon 
appears when 
proportions are 
constrained.

Check the 
Constrain box to 
lock the proportions 
of the cropped 
area. The drop-
down menu in this 
area provides easy 
access to standard 
print, screen and 
video sizes.

When resizing a cropped area that is not constrained,  
dimensions can be adjusted by clicking and dragging 
on any side of the box.  You do not have to click exactly 
on the red control bars.

This button inverts 
the width and height 
variables of the 
constrained proportions. 
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Padding is the space created when you choose a target size that is wider 
or taller than existing image proportion. When you choose Enable Padding, 
MediaPro will fill in the extra space with a color of your choice (see above). 
If padding is not enabled, MediaPro will resize the image according the 
Scaling Mode. This usually scales the image to fit the width or height. For 
example, without padding the horizontal image above would be output to 
match the width at 500 x 375. 

Resize 
The Resize tool is used to reduce 
the size of an image.  This tool 
works similarly to MediaPro’s 
batch file conversion utility, but 
includes some options for finer 
adjustment.

To resize an image, define the 
new width and height in the 
Target Size fields. Adjust how the 
image will fit into the Target Size 
by selecting a Scaling Mode. If 
you want the image to conform 
to a specific size, without 
stretching the image, check the 
Enable Padding box and select a 
Pad Color.

MediaPro cannot interpolate, 
or increase, the size of images. 
Thus, when you give dimensions 
larger than the image’s original 
size, this dialog will show blank 
space (or padded space) around 
the image.

The original resolution 
of images is not affected by 
resizing with MediaPro.

Scaling Mode defines the way 
the image with fit into the Target 
Size.  Options include:

Scale to Fit proportionally scales 
the image to the Target Size.

Pin Larger scales the image 
with its larger side expanded or 
shrunk to fit the Target Size.

Pin Smaller scales the image 
with its smaller side expanded 
to fit the Target Size. This option 
will fill the entire area, but your 
image may be clipped.

Fit Width scales the image based 
on the horizontal parameters of 
the Target Size. If you apply this to 
a vertical image, some of it may 
be clipped.

Fit Height scales the image 
based on the vertical parameters 
of the Target Size. If you apply this 
to a horizontal image, some of it 
may not be visible.

In this example, the image output will be clipped at the top and bottom 
because the Target Size proportions are not as tall as the dimensions of the 
original image.
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Transform
The Transform tool lets you alter the shape and 
perspective of your images. This tool is good for 
correcting optical distortion such as converging 
verticals or barrel distortion.

The Constrain drop-down menu provides three 
transform choices: Perspective, Skew and Free.

Perspective: Applying perspective lets you apply 
one-point perspective to an item. To apply a vanishing 
point perspective along the horizontal or vertical axis, 
drag a corner handle along that axis. The opposite 

Constrain 
This drop-down 
menu provides 
three transform 
choices: Perspective, 
Skew and Free.

Handles 
Click and drag  
one of the four 
red corner handles 
to transform the 
image.

corner will move in tandem. 
Skew: This operation enables you to tilt or slant an 

object to one side while keeping all other sides fixed. 
Drag a corner handle to reposition just that handle. You 
can adjust all handles independent of moving others.

Free: This tool lets you apply skew and perspective 
transformations in one continuous operation.

Offset
Provides the X and Y 
coordinates for each 
corner of the image.

Reset
This button 
resets the image 
and removes all 
transformations.

Pad color
Use this box to 
define the color of 
the background 
created by 
transformations
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Rotate 
The Rotate tool is used to adjust 
the angle of an image.  You can 
adjust the rotation in increments 
as small as 1/10th of a degree. 

To rotate an image 90 
degrees clockwise, just type 90 
into the Angle field. To rotate 
counter clockwise, place a 
negative sign (-) in front of the 
number in the Angle field.

This rotation method is 
not the same as lossless JPEG 
rotation.  See JPEG Rotate in 
the Action menu, for lossless 
rotations of 90, -90 and 180 
degrees.

Adjust Angle: Use the arrows to rotate by increments of .1 degrees (up rotates 
clockwise; down rotates counter clockwise); or just type in the number of degrees 
to rotate (negative numbers rotate counter clockwise). You can also drag the 
image with the mouse.

Pad Color: Select a 
color to use for the 
background of images 
when rotated.

Remove Grain 
This filter will help smooth out 
grainy images by applying a 
slight blur. 

Choose between Fine, 
Medium and Coarse, depending 
on the size the grain.

Preview: Checking this box will apply the filter to the image in 
MediaPro’s Media View. The time it takes to render a preview of the filter 
will vary depending on the complexity of the filter and the speed of your 
computer’s processor. 

Real-time preview: 
This window shows 
the affects of the filter 
applied to a sample of 
the image area at 100%. 
To change the area of the 
image being previewed, 
click the image and drag 
it to the desired location.  
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Zoom: Use this 
slider to zoom 
in on the eyes.

Selection tool: Click 
and drag the red 
corners to adjust the 
size of the selection.

To move the image in the 
preview window, place 
your cursor in the active 
window, then click and 
drag the hand ( ). 

Area in preview windowRemove Red Eye 
This filter helps you remove 
the “red eye” effect caused by a 
camera flash.  To remove red eye 
from images:

1. Zoom in on the area where 
the eyes are located. 

�. Use the selection tool to 
draw an area around the pupil of 
the eye (above).  Depending on 
the skin tone, it is safe with some 
images to draw a box around 
both eyes. Be aware of reddish 
skin tone, lips and red hair that 
might be affected. 

�. Adjust the level of red-
eye using the Reduction slider. 
Usually somewhere in the 
middle (5 or 6) works best.

4. Click OK. Repeat steps 1-3 
to adjust the other eye.

Sharpen Edges 
This filter adjusts the sharpness 
of your images. It works by 
determining the edges of 
elements in the image through 
their contrast.

The Sharpening slider defines 
the number of pixels (from 1-10) 
in the edge neighborhood that 
are retouched.

The Edge Detection slider 
adjust how strong the contrast 
of edges must be before a pixel 
is considered to be in-range to 
be sharpened.

Tip: Be careful not to over-
sharpen the image as it will 
bring out imperfections, making 
JPEG artifacts more visible.
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Convert to Duotone 
This filter converts color and 
black & white images into 
duotones. Duotones were 
designed to increase the tonal 
range of a grayscale image 
by using different colors to 
reproduce different gray levels. 

To create a duotone, select a 
light and dark color by clicking 
on the respective color button. 
Then adjust the brightness 
and contrast using the sliders. 
Negative numbers reduce 
brightness and contrast.

Invert Photo 
Negative 
The Invert Photo Negative filter 
inverts the colors of an image. 
This filter is useful for turning a 
positive image into a negative 
or to make a positive from a 
scanned negative. 

Adjust Saturation 
This filter adjusts the color 
saturation and lightness of your 
images. 

The Saturation slider defines 
the intensity of the colors. The 
existing level of colors in an 
image is 100. To reduce color 
saturation, drag the slider to 
a number less than 100. Zero 
represents no color, making an 
image black and white.

This tool can help 
compensate for a lack of color 
definition, but bear in mind that 
inkjet printers tend to over-
saturate color, rendering the 
colors unrealistic.
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Adjust Brightness 
and Contrast 
This filter adjusts the tonal 
range of your images though  
brightness and contrast. It can 
help to correct blurry images 
and bring out fine details in 
tone. 

Dragging sliders to the 
left decreases brightness and 
contrast; dragging them to the 
right increases the levels.

Adjust Color Levels 
Color Levels histogram displays 
the tonal range of the entire 
image. The sliders are used 
to adjust highlights (right), 
shadows (left), and midtones 
(middle). 

The middle slider changes 
the intensity values of the 
middle range of tones without 
dramatically altering the 
highlights and shadows. The 
outer two levels sliders set the 
black point and white point of 
the image. 

Adjust Color 
Balance 
The Color Balance filter changes 
the overall mixture of colors in 
an image for generalized color 
correction. 

To adjust the color balance, 
drag a slider toward a color you 
want to increase in the image or 
drag a slider away from a color 
you want to decrease in the 
image. Values range from -100 
to +100.
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Auto Enhancement 
This filter is a one-click 
enhancement that combines 
several filters (including 
saturation, brightness, contrast) 
to automatically produce an 
optimal image. 

Results will vary depending 
on the tonal range of the 
original image.

Preset Enhancement 
This filter offers several one-click 
enhancements for your images. 

Color Cast: Images usually 
suffer from color casting if they 
have been shot using the wrong 
film type. For example, images 
shot under artificial light tend 
to have a yellow bias. This filter 
removes the yellowness of the 
image.

Contrast/Brightness: Backlight 
compensates for the effect 
of the subject being slightly 
backlit. Under and Over Exposure 
adjusts the tonal range to 
compensate for the effect of 
an image being under or over 
exposed.

Subject: This category offers a 
set of options to adjust skin tone 
of portrait photography and the 
color of objects in landscapes.

Windows: Some filters are 
only available on the Windows 
version. On Windows, a filter 
from each group can be 
combined to provide a custom 
enhancement.

Mac: On the Macintosh 
version, you can adjust the 
percentage of the filter that 
is being applied to the image 
using the Levels slider.

Windows: Some filters are only available on the Windows version. On Windows, a 
filter from each group can be combined to provide a custom enhancement.

Mac: On the Macintosh version, you can adjust the percentage of the filter that is 
being applied to the image using the Levels slider.
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Version Control 
This feature is useful both for individuals and 
small workgroups to browse and track different 
versions during the editing process. This is useful 
as a backup as well as to revert to or compare dif-
ferent versions, and can be of great help during 
image editing. 

To activate this feature, select a folder using the 
Setup dialog in the Image Editor palette. Backup 
copies of version-controlled files will be saved 
in this folder. You must make sure that you use a 
separate folder for each catalog.  

The Version Control folder maintains a log of the 
items added and removed from the folder, with 
the name of the original file and, the number and 
details of each version saved. MediaPro will auto-
matically purge version control files for entries 
that have been removed from the catalog, when 
a catalog is closed. The size of the folder will grow, 
depending on the size and number of copies of 
files. It is advisable to have the folder on a volume 
which has plenty of storage space. 

Once a Version Control folder has been assigned 
to the catalog, you can begin to edit and backup 
media files. After you have edited an image, click 
the Save button in the Image Editor palette. In this 
dialog, check the box Save in versions folder.

MediaPro automatically assigns the current 
time and date and saves this data in the export 
log in the Version Control folder, together with a 
MediaPro-encoded backup copy of the file.  

You can examine and compare any backup ver-
sion, at any time, by simply clicking on the differ-
ent versions in the list. 

There are two important icons next to each 
item in the backed-up versions list: 

  The arrow icon replaces the current media 
file with the selected backed-up version. 
This option will also give you the opportu-
nity to Swap files instead of replacing. 

  The trash icon deletes the selected 
backed-up version, and removes it from 
the Versions list. 

MediaPro also has version control support for 

image editing performed in other third-party 
applications such as Adobe Photoshop. For 
MediaPro to recognize these edits, you must have 
the Image Editor active and open the image file 
with the third-party editor via the Open With help-
er application menu (see page 110).
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Version Control Setup in the Image Editor 
palette and its resulting dialog.

Click the folder icon to locate and choose your Version 
Control backup folder.

The Save in versions folder option of the Save dialog 
places a backup of the original version in the Version 
Control backup folder. It also provides Options to 
preserve color profiles and EXIF metadata.
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The print dialog automatically defaults to match 
the active view of your catalog. iView MediaPro 
offers three printing styles to match those views:

Content List is useful for printing a table of 
contents of your catalog. This style matches the 
layout of the catalog’s List View, with icons and 
associated field information of each file. 

This style also includes options for showing/
hiding icons and field headers on the printout. 
The size of the icons in your catalog’s List View 
determines the size of the icons in the printout. 

Contact Sheet prints a table of thumbnails 
similar to your catalog’s Thumbnail View. The size 
of the thumbnail in your catalog determines the 
size of the thumbnail in the printout.

Remember, thumbnails are imported into the 
catalog by using the file’s built-in thumbnail or 
ones created by MediaPro. If your thumbnails are 
printing poorly, choose Rebuild Item in the Action 

menu. Then try printing again.  
You can also choose the Hi-Res Thumbnail 

option for quality printing.  Checking this option 
will send more image detail for every thumbnail 
to the printer, so allow extra time for printing. The 
printing speed is dependent on your computer’s 
processing power and the type of printer. 

Media Sheet renders the full size, hi-resolution 
images from original files. Since some of these 
files may be quite large, allow extra time for print-
ing.  The size of the displayed and printed media 
can be changed by using the Scaling pull-down 
menu (see explanation next page). 

The most useful of these is Scale to Fit, as it auto-
matically rescales the image to fit within the print 
area. Other useful options are Actual Size and Fit 
Width, but they may hide parts of the image when 
the size and shape of the original image is larger 
than the rendered area or printed cell size.

Printing
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Define 
print area

Print view 
fields will 
include fields 
visible in 
Thumbnail 
View. 

Range

MediaPro’s 
print dialog box 
features a real-
time preview 
of your prints. 
Each change in 
preference will 
be rendered in 
this window. 

Margins: The 
light blue color 
represents 
margins defined 
using the button 
in the upper left.

Print style

Print dialog: Contact Sheet mode

Header

Open printer 
setup dialog

Footer

By default, 
MediaPro 
prints lo-res 
thumbnails. 
Check this 
box to print 
high-quality 
images.
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Choose which 
page appears 
in the preview 
window on 
the right. 

Print view 
fields will 
include fields 
visible in 
Media View. 

Repeat media: This option will tile a single image in the available print area. Use the Grid option 
to define the number and size of the tiled images. Check the Margin between box to place a small 
amount of space between tiled images. See an example on page 130.

Media Sheet 
prints are 
rendered from 
the original, 
hi-resolution 
images. 
Since some 
of these files 
may be quite 
large, allow 
extra time for 
printing.  

Print dialog: Media Sheet mode

Define 
print area

If checked, 
your printout 
will show 
icons match-
ing the size 
chosen in List 
View (small or 
large).

Range options include: Define in Print Box, Current Page, Odd pages and Even pages.  
The default is to let your printer’s dialog box handle this function. 

Label row

Print style

Print dialog: Content List mode

Headers and 
footers settings 
are retained 
across all print 
styles.

Use view 
colors mimics 
the style set 
in Media 
View. 

Use view colors 
mimics the style 
set in List View. 
In this example, 
it only shows 
the divider lines. 
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Print Options: Margins
Visible in all views.

Use Mirror margins 
for including spines on 
double-sided documents 
that will be bound or 
punch-holed.

Print Options:   
Headers & Footers
Place labels such as headers, 
footers, right and left labels 
on your print out.

You many use one 
or all of these label 
fields on a given print 
out. This example will 
place Mykonos Greece 
Assignment at the top 
of print outs. On the 
bottom, it will print the 
Page Number and Total 
Number of Pages. It is 
acceptable to mix these 
symbols with regular 
text.

Click this button to 
alter typographic, 
color and style 
preferences.

Special drop-down menu 
Insert the Date, Time, Page Number, Total Number of 
Pages, and Catalog Title. These are represented by their 
respective symbols in the caption’s box.  The Ampersand 
option is to help differentiate the character from the 
special character commands. The Indent option aligns the 
label center or right. One Indent mark (&i) will center the 
text. Two indent marks flushes the text to the right. 

Print Options: Grid
Only visible in the Thumbnail 
and Media Views.

Cells allows you to 
define the number of 
rows and columns, but 
may override the image 
size settings or possibly 
crop some of the field 
text if the Print Area 
Size is too small.

Default for view takes into 
account the predefined 
layout and image size 
settings selected within each 
view mode, and the Print 
Area Size. Size is similar to cells, 

but allows you to define 
the exact size of each 
media cell.

Margin dimensions will 
default to those set by 
selected printer.
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Print options
Define the Print Area menu has options for 

full page, as well as CD and other disk cases, such 
as Zip or Jaz disk. If you select Full Page, MediaPro 
uses the page size defined in the Page Setup dia-
log. The options will differ according to the type 
of the printer chosen. You can add custom print 
area templates to this menu. For instructions, see 
the following page.

Margins allows you to further adjust the Print 
Area Size on all sides. With the Mirror Margins 
option, you can include spines for double-sided 
documents that will be bound or punch-holed.

Headers enables you to place a label on the 
top (header), bottom (footer), right and left sides 
of your printout. You can adjust the type and style 
of the labels. In the Special drop-down, add auto-
matic page numbers, date, time and more. Header 
settings are retained across all print styles.

Grid: For Contact Sheets, this option defines 
the number of rows and columns for a printout. 
For Media Sheets, you can define how multiple 
copies of the same image, or different images, will 
be printed.  Default for view takes into account the 
image size settings for the respective view of the 
catalog. Cells allows you to define the number 
of rows and columns. Size is similar to cells, but 
allows you to define the exact size of each cell.

Range modifies which pages will print. The 
default is to allow your printer’s dialog box to 
handle this function. You may also choose Current 
Page, and Odd or Even pages. 

Printing tips
• To print a selection of files, make your selec-
tion, then choose Show Selected from the Find 
menu. Print your results.

• Multi-layer/-page files: MediaPro only prints 
the frame assigned as an item’s thumbnail. In 
order to print a layer or page within a com-
posite file, go to the page or layer you wish 
print in Media View, then select Rebuild Item 
from the Action menu before printing.
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Actual Size uses the 100% size of the image, and 
centers it in the Print Area.

Scale to Fit proportionally scales the image to the 
size of the Print Area.

Fit Width scales the image based on the horizontal 
parameters of the Print Area. If you apply this to a 
vertical image, some of it may not be visible.

Fit Height scales the image based on the vertical 
parameters of the Print Area. If you apply this to a 
horizontal image, some of it may not be visible.

Pin Smaller Side draws the image with its smaller 
side expanded to fit the screen. This option will fill 
the entire screen, but your image may be cropped.

Pin Larger Side draws the image with its larger 
side expanded or shrunk to fit the screen.

Tile the image (in actual size) in the window. This 
option is helpful when you are printing patterns.

Percentages allows reduction or enlargement of 
the image from 25% to 2000%.

Page selector: Use the up and down arrows to choose 
which page appears in the preview window on the right 
side of the dialog box. 

Scaling menu:  Only visible in Media Sheet mode.
To define the image size, choose one of the following 
options from the menu: 

Print dialog: Media Sheet mode (shown with 2x2 grid)
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Print templates
iView MediaPro lets you create printing templates 
to suit all your needs. These printing templates are 
text files and reside in the user-defined Plug-ins 
- Print Templates folder (see page 5 for location of 
this folder).

Printing templates allow the user to define the 
specific size and position of the printing area on a 
page. It is made up of a line of text containing five 
values, each separated by a single space.

Example:  -1 -1 �4� ��9 px
• Value 1: Left margin
• Value 2: Top margin
• Value 3: Width
• Value 4: Height
• Value 5: Unit of measure

Acceptable units of measure
• in (inch)
• px (pixel)
• cm (centimeter)
• mm (millimeter) 
• Use “.” or “,” as decimal separators.

If the margin is set at  “-1”,  MediaPro centers the 
printing area with these margins.

Example template for CD jewel case
The print area on the front of a standard CD jewel 
case is 120x120 mm. 

To center the image horizontally, you need to 
place it: (210-120) ÷ 2 = 45 mm on the right mar-
gin. 

To center the image vertically, you need to 
place it: (297-120) ÷ 2 = 88.5 mm on the left mar-
gin. For simplicity, we will use 80 mm.

The coordinates that we need for the CD case 
template are:  

45 80 120 120 mm or -1 -1 120 120 mm
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Step 4: Modify the scale, crop marks, etc. 

Step �: Select the 
new template in the 
Print Dialog box. 

Step �: Select the image you want to print in Media View. 
Click the Print icon in the toolbar.

Create a template
Step 1: Create a text file with the proper order and 
number of values. Place it in the user-defined Plug-ins 
- Print Templates folder (see page 5 for location).
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PDF Maker
This feature allows you to produce high-resolu-
tion PDF files of any size and layout using the 
media in your catalog. The layout of the PDF can 
be completely customized.

How to use PDF Maker
1. Launch this feature by selecting Show PDF 

Maker in the Window menu.
�. Start in the Layout tool by defining page size 

and orientation. To show the Layout tool, click 
the large button in the upper right corner of 
the palette. Once you have this view showing, 
you can decide how and where media items 
should appear on the page. Use the various 
option tools to define page size, orientation 
and unit of measure. Then use the layout tools 
to draw and move around boxes that will con-
tain your media. Media locations are freeform 
and can even be overlapping.  You can save 
various layouts for later recall by using the 
Options Sets drop-down menu.

�. Once your layout is defined, change to the 
Content tool by clicking the large icon in the 
upper right corner of the palette. Then, simply 
drag-and-drop media from your catalog to 
the PDF layout locations. When images are 
dropped into locations, they may need to be 
resized, rotated or relocated with the media 
location box. You can use the Clear tool to 
remove an image from a box. 

4. Finally, click Make and your custom PDF file 
will be generated and saved to a location of 
your choice on the desktop. The time needed 
to create a PDF depends on the size and reso-
lution of the images used in the PDF.   

The high-resolution PDFs that you create are 
ideal for printing, but may be too large for dis-
tribution on the Internet. Currently, there are 
no options for customizing the compression of 
images in the PDF. Exported PDFs can be further 
customized using a PDF editing application such 
as Adobe Acrobat.
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Options

Layout Tools

Click this button to toggle between Layout and 
Content panels of PDF Maker

PDF Maker palette: Layout panel

Move tool
Position or 
resize frames

Clone tool
Click a frame
to duplicate it

Create tool
Click page to 
add a new frame

Delete tool
Click a frame
to remove it

Set page size 
(offers 11 
standard sizes) 

Set display 
units (inches, 
centimeters)

Set page 
orientation 
(portrait or 
landscape)

Option sets
(Save or load
layouts)

Click this 
button to 
create a PDF 
and save it to 
the desktop.

X/Y coordinates
of page position

(Top/Left)

PDF page 
dimensions

Frame 
dimensions
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Printing to PDF (Mac OS X)
On Mac OS X you can print MediaPro catalogs to 
PDF format using the system’s built-in printing 
functionality. Instead of actually printing a docu-
ment, you use the Print dialog to export your cata-
log to a PDF. 

First, use the MediaPro print dialog to custom-
ize the print style (e.g. Content List, Contact Sheet 
or Media Sheet), then click the Print button. 

In the system print dialog, click Save As PDF. 
Type a name for the document and choose where 
you want to save the PDF. 
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Content Tools

PDF Maker palette: Content panel

Click this button to toggle between Layout 
and Content panels of PDF Maker

Drag tool
Position content 
in a frame

Rotate tool
Set content 
orientation 
(rotates 
clockwise)

Zoom tool
Scale content 
in a frame

Clear tool
Remove 
content from 
a frame

Placing images into PDF Maker layouts

Step 1: Select an 
image in the catalog 
and drag-and-drop it 
into the desired  frame 
of the PDF. If you drop 
it into the wrong frame, 
use the Clear tool to 
remove the image from 
the frame.

Step �: Images will 
snap to fill either the 
height or width.  
Use the Zoom tool to 
resize the image. 
Place the tool cursor  
on the image and drag 
up to enlarge or down 
to reduce. 

Step �: Use the Drag 
tool to position the 
image within the frame. 
Place the tool cursor on 
the image and drag it 
around in the frame to 
the desired position.

Step 4: Use the Rotate 
tool to adjust the 
orientation of the 
image within the 
frame. Place the tool 
cursor on the image 
and click. Each click 
rotates another 90 
degrees clockwise.

Save As PDF:  In the OS X print dialog, 
there is a button that enables you to 
save your printout as a PDF instead of 
actually printing the file.
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Appendix A: Keyboard shortcuts

File Menu Windows Mac

New Catalog Ctrl+N c N

Close Catalog Ctrl+W, Ctrl+F4 c W

Open Catalog Ctrl+O c O

Catalog Finder Ctrl+s+O s c O

Save Catalog Ctrl+S c S

Save As... Ctrl+s+S s c S

Catalog Info Ctrl+K c K

Catalog Importers Ctrl+Alt+K o c K

Import from Files/Folders Ctrl+I c I

Import from Catalog File o c I

Import from Spotlight Query s c I

Import from Camera Ctrl+Alt+U c U

Import from Disk Ctrl+Alt+U o c U

Import from URL Ctrl+s+U s c U

Cancel Running Tasks Ctrl+Break c . (Period)

Print Ctrl+P c P

Page Setup Ctrl+s+P s c P

Exit (Quit) Alt+F4, Ctrl+Q c Q

Edit Menu Windows Mac

Undo c Z

Cut Ctrl+X c X

Copy Ctrl+C c C

Paste Ctrl+V c V

Delete Delete Delete

Select All Ctrl+A c A

Deselect All Ctrl+D c D

Define Custom Fields Ctrl+s+D s c D

Preferences Ctrl+, c , (Comma)

Find Menu Windows Mac

Show All Ctrl+E c E

Show Hidden Ctrl+Alt+E o c E

Show Selected Ctrl+s+E s c E

Hide Selected Ctrl+Alt+s+E o sc E

Show Previous State c x

Show Next State c v

Show Rated Ctrl+s+R s c R

Show Labelled Ctrl+s+L s c L

Find Ctrl+F c F

Find Next Ctrl+Alt+F o c F

Go To Ctrl+G c G

Go Again Ctrl+Alt+G o c G

Make Menu Windows Mac

Run Slide Show Ctrl+Alt+R c R

Slide Show Options Ctrl+s+R o c R

View Menu Windows Mac

Lightbox Alt+Enter c /

Actual Size/Scale to Fit Ctrl+0 c 0

Zoom In Ctrl++ c +

Zoom Out Ctrl+– c –

Rotate 90º CW Ctrl+] c ]

Rotate 90º CCW Ctrl+[ c [

Move to Top Ctrl+Alt+Up c  w

Move to Bottom Ctrl+Alt+Down c  

Move to New Catalog Ctrl+s+N s c N

Move to Location Ctrl+Alt+L c L

Move Again Ctrl+s+L o c L

Sort Again Ctrl+Alt+; o c ;

Invert Sort Order Ctrl+; c ;

Application Menu Mac

Empty Trash s c Delete

Preferences c , (Comma)

Vocabulary Editor s c V

Hide MediaPro c H

Hide Others o c H

c Command    s Shift     o Option w Arrows

Legend

A
p
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Lightbox shortcuts

Lightbox function Windows Mac

Exit Lightbox ESC, Double-click ESC, Double-click or c . (Period)

Previous image Left Arrow Left Arrow

Next image Right Arrow Right Arrow

Assign Color Label 1 .. 9; 0 to remove label 1 .. 9; 0 to remove label

Assign Star Rating Ctrl+1-5; 0 to remove rating Ctrl+1-5; 0 to remove rating

Zoom in to the next available size option. + (Plus key) + (Plus key)

Zoom out to the previous available size option. – (Dash key) – (Dash key)

Set Orientation: 90º Clockwise Ctrl+] c ]

Set Orientation: 90º Counter-Clockwise Ctrl+[ c [

Move displayed item to Trash/Recycle Bin Ctrl + Delete c Delete

Remove dispalyed item from Catalog Delete Delete

Histogram - Toggle display H H

Exposure Warnings - Toggle display W W

Tools - Toggle display T T

Magnifier - Toggle display M M

Scroll Lock (simultaneous scrolling of all images) S S

Layout: Grid G G

Layout: Landscape L L

Layout: Portrait P P

Add item to Lightbox Ctrl + (Plus key) Ctrl + (Plus key)

Remove item from Lightbox Ctrl – (Dash key) Ctrl – (Dash key)

Window Menu Windows Mac

Minimize Window c M

Show/Hide Toolbar Ctrl+T c T

Switch Views  
(List, Thumbnail, Media)

Ctrl+1, Ctrl+2, 
Ctrl+3 c 1, c 2, c 3

Show/Hide Panels
(Info, Organize)

Ctrl+4,  Ctrl+5 c 4, c 5

Show/Hide View Options Ctrl+J c J

Action Menu Windows Mac

Rebuild Item Ctrl+B c B

Sync Annotations Ctrl+Alt+B o c B

Clear Annotations Ctrl+s+B s c B

Move to Recycle Bin (Trash) Ctrl+Delete c Delete

c Command    s Shift     o Option w Arrows

Keyboard shortcuts cont.

Legend

Lightbox function Windows Mac

Click to position image. Use Scroll Lock to position images simultaneously. Click (Normal mode) Click (Normal mode)

Display settings menu Right-Click (F1 for Help) Ctrl + Click; Right-Click

Mouse shortcuts

A
p
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Slide Show shortcuts

Slide Show function Windows Mac

Exit slide show. Escape (ESC) Escape (ESC)

Show/Hide slide show controller.
When the controller is hidden, the mouse cursor is also hidden.

Enter or Return Enter or Return

Run/Pause slide show. Space Bar Space Bar

Display the next media file.
The next media file is always displayed, even in Random mode. 

Right or Down Arrow Right or Down Arrow

Display the previous media file.  
The previous media file is always displayed, even in Random mode. 

Left or Up Arrow Left or Up Arrow

Move to next frame of a movie. Suitable for stepping through movie frames 
while slide show is paused.

Alt + Right or Down Arrow o + Right or Down Arrow

Jump to the last frame of the movie. s+Alt+Right/Down Arrow s + o + Right/Down Arrow

Move to previous frame. Suitable for stepping through movie frames while slide 
show is paused. 

Alt + Left or Up Arrow o + Left or Up Arrow

Jump to the first frame of the movie. s + Alt + Left or Up Arrow s + o + Left or Up Arrow

Zoom in to the next available size option. + (Plus key) + (Plus key)

Zoom out to the previous available size option. – (Dash key) – (Dash key)

Toggle scale of images between Scale to fit and Actual Size. Ctrl+0 c 0

Change display to the next available grid option. d d

Change display to the previous available grid option. s + D s + D

Set/unset  slide show to Interactive mode. If slide show is in interactive mode, 
you can use the arrow keys or mouse to move forward or backward.

I or i  (case insensitive) I or i  (case insensitive)

Set/unset slide show to Continuous (Loop) mode. L or l  (case insensitive) L or l  (case insensitive)

Set/unset slide show to Random mode.
Random mode uses all available media items once before repeating media.

R or r (case insensitive) R or r (case insensitive)

Turn Multi-sound mode on or off. This is useful when playing multiple movies at 
once. When it is off you will only hear audio from the active movie.

M or m (case insensitive) M or m (case insensitive)

Change the active media item to the next item in the grid. This is useful in 
multi-grid mode only. It will reset the slide show audio and swap information 
displayed in the info panel. Changing the active item also changes the order at 
which items are loaded.

Tab Tab

Assign a color label to active media item. This label will apply to all views in the 
catalog. Use the slide show controller to check/show/hide labelled items.

Numbers 1-9 Numbers 1-9

Remove color label from active media item. 0 (Zero) 0 (Zero)

Slide Show function Windows Mac

Run/Pause slide show. Click (Normal mode) Click (Normal mode)

Load next slide. Click (Interactive mode) Click (Interactive mode)

Load previous slide. s + Click
(Interactive mode)

s + Click
(Interactive mode)

Drag media in grid cell.  This takes effect only if the displayed media is clipped, 
(i.e. larger than the grid cell size).

Alt + Click o + Click

Exit slide show. Double Click Double Click

Keyboard shortcuts

Mouse shortcuts
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Appendix B: Supported file formats
Image File Formats (Import)

Image Export formats: SGI, Photoshop, BMP, JPEG, JPEG 2000 (Mac only), MacPaint, PICT, PNG, QuickTime Image, TGA, TIFF

Audio File Formats (Import)

Audio Export formats: AIFF, AU, Wave

File Format Extension

Adobe Photoshop 8BPS, PSD  m m

Alias Pix † ALS, APIX m m

AppleWorks ‡ CWPT m m

BMP BMP, BMPf, BMPp, DIB m m

Canon RAW CRW, CR2 m m

Digital Negative RAW † DNG m m

FlashPix Image FPX, FPix m m

Fractal Design 
Painter

‡ RIFF m

Fuji RAW (Preview) † RAF m m

GE Medical CRI CRI m m

Genuine Fractals ‡ 8BIN, STN, STNG m m

JacqCAD Expn m m

JPEG JPEG, .JPG, .JPE, EXIF m m

JPEG 2000 JP2, .jp2 m

Kodak PhotoCD kpcd, PCDI, PCD m m

Kodak RAW DCR m m

Leaf Valeo RAW † MOS m m

Live Picture ‡ FIT2 m

Macintosh Icon ICN, ICNS, Icon m

File Format Extension

AIFC AIFC m m

AIFF AIF, AIFF m m

AMF Movie Importer M4A, M4B, M4P m m

AMR AMR m m

AU AU, SND, ULAW, ULW m m

Audio Data Transport 
Stream

ACC, ADTS m m

CAF (CoreAudio File) CAF, caff m m

Compact Disc Audio 
(AIFF)

CDDA m m

† Importer renders preview only
‡ User-defined importer

File Format Extension

MacPaint MAC, PNTG m

Minolta RAW † MRW m m

Nikon RAW NEF m m

Olympus RAW † ORF m m

Pentax RAW † PEF m m

Picture PCT, PIC, PICT m m

Picture Clipping clpp m

PNG PNG, PNGf m m

QuickTime Image QIF, QTI, QTIF m m

Seattle Filmworks SFWI, SFW m m

SGI SGI m m

Sigma RAW † X3F m m

Sony RAW † SRF m m

Startup Screen SCRN m

TGA TGA, TPIC m m

TIFF TIF, TIFF, DCBa, FAX, 
RICH

m m

Windows Icon ICO m

File Format Extension

GSM Audio GSM m m

MP3 MP3, MPG3, Mp3, 
PLAY, SWA, SwaT

m m

Sound Designer II SD2, Sd2f m m

Standard MIDI MID, Midi, SMF m m

System Sound sfil m m

Wave BWF, WAV, WAVE m m

Windows Media Audio WMA m
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Video File Formats (Import)

Video Export formats: 3G, AVI, DV Stream, FLC, Image 
Sequence, MPEG-4, QuickTime Movie

File Format Extension

3GP2 3G2, 3gp2 m m

3GPP Movie 3GP, 3gpp, SDV m m

AMC AMC m m

AMF movie importer M4V m m

Animated GIF GIF, GIFf m m

AutoDesk Animator CEL, FLC, FLI m m

AVI VFW m m

DivX AVI Import 
Component

AVI, DAVI, DIVX m

DV DIF, DV, dvc! m

Flash (Macromedia) SWF, SWFL m m

MPEG MPG, MPEG m m

MPEG-4 MP4, mpg4 m m

Quartz Composer 
Eater

QTZ m m

QuickTime Movie MOV, MooV m m

Standard MIDI KAR m m

Windows Media Video WMV m

Note: MediaPro’s capacity to import 
certain file types is dependent on 
having the most current version of 
Apple’s QuickTime installed on your 
computer. Download the latest update 
for free from Apple’s site at:
http://www.apple.com/quicktime/

Text, Font and Web File Formats (Import)

File Format Extension

Text TEXT, TXT, ttro m m

Text Clipping clpt m

Font - True Type FFIL, TFIL, TTF, TTC, 
SFNT

m m

Font - Open Type OTF m m

Font - Suitcase Font DFNT m

Active Server Page ASP m m

HTML Document HTML, HTM m m

HTML Archive MHT m

PHP Document PHP m m

Web Archive WEB m

XML Document XML m

Illustration File Formats (Import)

† Importer renders preview only
‡ User-defined importer

File Format Extension

3D Studio 3DS m m

Adobe Illustrator AI m m

AppleWorks ‡ CWGR m

Canvas ‡ drwX, drw9, drw8, 
drw7, drw6, drw5, 
CNV, CVX

m

CorelDRAW † CDR* m

Macromedia 
Freehand

† AG*, FH* m m

Postscript EPSF, EPSP, EPS, PS m m

PowerCADD ‡ Pd%4 m

Windows Metafile EMF, WMF m

DTP File Formats (Import)

† Importer renders preview only
‡ User-defined importer

File Format Extension

Adobe InDesign ‡ INDD, IDd3 m

Adobe PageMaker ‡ ALB6 m

AppleWorks † CWWP m m

Microsoft Excel † XLS m

Microsoft 
PowerPoint

† PPT m

Microsoft Word † DOC, W8BN m m

MultiAd Creator † Crtr, CRTR m m

PDF PDF m

Quark XPress † QXD, XDOC m m

RTF (Rich Text 
Format)

RTF, RTFD m m
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Appendix C:  Annotation mapping

iView MediaPro supports a set of pre-defined 
fields for annotating your media. This set (also 
known as IPTC fields or headers) enables you to 
define the author, event date, location, copyright 
and more for your media files.

These annotation standards have been defined 
by International Press and Telecommunications 
Council (IPTC) and the Newspaper Association of 
America (NAA). Adobe uses this standard in part 
to define their XMP metadata standard. 

MediaPro also supports annotations defined by 
QuickTime, Apple’s tool for media authoring and 
play back of high-quality audio and video.  

To simplify annotating media, and prevent 
multiple sets of annotations for each standard, 

MediaPro has mapped QuickTime’s annotation 
fields to the IPTC fields.

The table below lists the fields used by iView 
MediaPro and their corresponding definitions in 
the IPTC and QuickTime standards, as well as in 
Adobe Photoshop CS.  

Because the definitions of each annotation are 
not integrated into the data, other applications 
may refer to an annotation by a different name.   

The IPTC Size is the character limit defined by 
the standard. The IPTC Code is provided as refer-
ence to the standard. For additional information 
on the IPTC metadata standard, please refer to the 
official IPTC web site: 

http://www.iptc.org/IIM/
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* Supports multiple entries in field;  ** Supported in earlier versions of Photoshop ; + Supported in Photoshop CS via iView plug-in

iView MediaPro� IPTC/XMP Core Size Code QuickTime Photoshop CS�

Title Headline 255 0x0269 Information | Full Name Headline

Product Object Name 63 0x0205 Product | Album (mp3) Document Title

Genre Primary Category 3 0x020F Genre Category

Event Fixture 31 0x0216 Description +

Event Date Date Created 8 0x0237 Creation Date Date Created

Author Author 31 0x0250 Author | Original Artist | Artist (mp3) Author

Author Title Author Title 31 0x0255 - Author’s Position **

Credit Credit 31 0x026E Producer Credit

Source Source 31 0x0273 Original Source Source

Copyright Copyright 127 0x0274 Copyright Copyright Notice

Transmission Transmission 31 0x0267 - Transmission Reference

Country Country 63 0x0265 - Country

State State/Province 31 0x025F - State/Province

City City 31 0x025A - City

Location Location 31 0x025C - +

Instructions Special Instructions 255 0x0228 Special Playback Requirements Instructions

Status Edit Status 63 0x0207 Disclaimer +

Writer Writer 31 0x027A Writer Description Writer

Caption Caption 2000 0x0278 Comment Description

People * Contact 127 0x0276 Performers +

Categories * Supplemental Categories 31 0x0214 - Supplemental Categories

Keywords * Keyword 63 0x0219 Keywords Keywords

Color Label Urgency 1 0x020A - Urgency
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Basic troubleshooting
Make sure that you have the installed:

1. The latest version of MediaPro from our site. 
http://www.iview-multimedia.com/

2. The latest version of QuickTime from Apple’s 
site. QuickTime 6 is required. We recommend 
version 7.x or higher. 
http://www.apple.com/quicktime/

3. Windows users should keep up to date with 
the latest service packs and drivers for their 
operating system. Use the Windows Update 
command in the Start Menu to download and 
install the latest updates.

4. Mac users can also solve problems by: Delet-
ing the MediaPro preferences in the System’s 
Preferences folder.

Thumbnails look fuzzy, pixelated.
By default, MediaPro imports thumbnails that have 
been embedded into the file by other programs 
or devices. This makes MediaPro very fast when 
importing media, but embedded thumbnails may 
look blurry or pixelated. To improve thumbnail 
quality, choose the item and select Rebuild Item 
from the Action menu. For more information on 
improving thumbnail quality, see page 37.

Transition effects do not appear to work in 
slide shows exported as a QuickTime movie.
If you are using video compression, make sure 
that your frame rate is higher than 1 fps (frame 
per second). If there is no value in the QuickTime 
compression settings dialog box, fps defaults to 
1, and you’ll get no effect (as the effect lasts for 
only one second).

Common Error Messages
No importer found: This error message appears 
when MediaPro cannot display or render a par-
ticular file type. Try upgrading to the latest version 
of QuickTime. 

Volume not mounted: iView MediaPro needs 
access to the actual file in order to display it on the 
screen in Media View or Slide Shows. This error is 
displayed when MediaPro cannot find the media 
storage device or disk on which the file is stored. 
Mounting the disk should solve the problem. 

Customer Support
If you have additional questions, please make sure 
you check the manual, our online FAQ and commu-
nity forum. If you still can’t find an answer, or you 
would like to send us a comment or suggestion, 
then fill out our online technical support form at:
www.iview-multimedia.com/support/directsupport.html

Customer forums
Join the community of iView users.  Find answers 
to many issues, learn about new features, and post 
questions. Connect online at:
http://www.iview-multimedia.com/forum/

Appendix D: Troubleshooting
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It is important that you carefully read this notice before proceed-
ing with the download, installation and use of the software. By 
clicking the button below marked “continue” you agree to be 
bound by the terms of this agreement which constitutes a legally 
binding contract between the licensor, (hereafter “iView multime-
dia ltd”), and the licensee, (hereafter “you”).

1 THIS AGREEMENT
1.1 In this Agreement the phrase the Software means the com-
puter program above and all associated media, printed materials, 
“online” or electronic documentation and bundled software. This 
definition of “the Software” does not include any other products 
or computer programs of iView Multimedia Ltd.
1.2 The Software is protected by copyright and other intellectual 
property laws and international treaties. Title to, ownership of, 
and all rights and interests in and to each and every part of the 
Software, (including all copyrights, trade marks, patent rights or 
any other intellectual property rights of whatever nature), and all 
copies thereof shall remain at all times vested in iView Multimedia 
Ltd or its licensors.
1.3 The Software is licensed, not sold, to You for use only under 
the terms of this licence agreement, and iView Multimedia Ltd 
and its licensors reserve any rights not expressly granted to You. 
Your rights of ownership are limited to the media on which the 
Software is recorded or fixed.
1.4 By installing, copying or otherwise using the Software, you 
agree to be bound by the terms of this Agreement. If You do 
not agree to the terms of this agreement You must not use the 
Software and must immediately delete any and all copies of the 
Software in Your possession. 

� GRANT OF LICENSE
2.1 iView Multimedia Ltd hereby grants to You the following 
non-exclusive rights in respect of the Software subject to Your 
fulfilment of the relevant criteria. The rights granted to You are 
personal and non-transferrable.
2.2 Evaluation License. You may use a copy of the evaluation ver-
sion of the Software, (comprising the evaluation version of the 
program and any accompanying documentation), for evaluation 
purposes only without charge for a period of 21 days. If You con-
tinue to use the Software after expiry of the evaluation period You 
must pay the License fee and obtain a full License. Until You have 
paid the License fee for the Software, You may only use the Soft-
ware for evaluation purposes. For details of payment, please refer 
to the Purchase Information in the package or visit our Web site at: 
www.iview-multimedia.com. When payment has been received 
by iView Multimedia Ltd You will be sent a License number which 
will unlock any locked or disabled functionality in the evaluation 
version of the Software
2.3 Single User License. You may use the Software on a single 
computer for your personal, educational or business use PRO-

VIDED THAT you have obtained from iView Multimedia Ltd a 
Single User License Number. Under this Single User License you 
may also install the Software on a second computer, for example 
a home computer or laptop, provided that you are the sole user 
of both computers and that you do not allow concurrent use of 
the Software by more than one individual.
2.4 Multi User License Packs or Volume Site Licenses. You may 
use the Software on a computer network and/or allow concur-
rent use of the Software by more than one individual for personal 
or business use PROVIDED THAT You have obtained from iView 
Multimedia Ltd a Multi User License Pack or signed the Volume 
License Agreement which supplements this Agreement for the 
issue of single Site License Number(s). The maximum permissible 
number of concurrent users shall be specified by iView Multime-
dia Ltd in the License Pack or in the Supplement Volume License 
Agreement at the time of issue of the License Number(s).

� YOUR OTHER RIGHTS AND OBLIGATIONS
3.1 You may distribute copies of the original archive of the evalua-
tion version of the Software (which is locked) on any CD, Web Site, 
FTP Site, or other “download area” without permission from iView 
Multimedia Ltd PROVIDED THAT You do not charge or request 
donations for any such distributed archives of the evaluation 
version of the Software. You are prohibited from distributing any 
other versions of the Software without the prior written permis-
sion of iView Multimedia Ltd.
3.2 Your copy of the Software may include iView Multimedia Ltd’s 
freeware program, iView Catalog Reader. This is offered to You by 
iView Multimedia Ltd as freeware and may be copied, distributed 
royalty free on any CD, Web Site, FTP Site, or other “download area” 
without permission from iView Multimedia Ltd and used with-
out any restriction PROVIDED THAT You do not charge or request 
donations for any such distributed archives of the software. All 
definitions are as defined in this agreement. 
3.3 Save as expressly set out in this Agreement You may not copy, 
reproduce, publish, rent out, lease, modify, create derivative works 
from the Software nor may You remove any proprietary notice, 
labels, or marks on the Software. Unless permitted by law, You 
may not modify, adapt, reverse engineer, decompile, disassemble, 
create derivative works based on, or copy the Software.
3.4 You undertake not to export the Software or any part thereof 
to any country, person, entity or end user subject to any export 
restrictions applicable to You.

4 RESERVATION OF RIGHTS
4.1 To the fullest extent permitted by applicable law, iView Multi-
media Ltd and its licensors disclaim all other warranties and con-
ditions in respect of the software either express or implied, includ-
ing but not limited to any implied warranties of merchantability, 
non-infringement of third party rights and fitness for particular 
purpose. The duration of any statutorily required warranty period 

iView MediaPro End-User License Agreement, including iView Catalog Reader
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shall be limited to the term of the limited warranty.

� INTELLECTUAL PROPERTY RIGHTS
5.1 The Software is protected by copyright and other intellectual 
property laws and international treaties. Title to, ownership of, 
and all rights and interests in and to each and every part of the 
Software, (including all copyrights, trade marks, patent rights or 
any other intellectual property rights of whatever nature), and 
all copies thereof shall remain at all times vested in iView Mul-
timedia Ltd.

6 LIMITED WARRANTY
6.1 iView Multimedia Ltd warrants that the medium on which 
the Software is supplied, if any, shall if manufactured by or on 
behalf of iView Multimedia Ltd be generally free from errors of 
workmanship for a period of 30 days from purchase.
6.2 The Software is provided “as is” without warranty of any kind 
either express or implied. In particular iView Multimedia Ltd does 
not warrant that the operation of the Software will be uninter-
rupted or error free. iView Multimedia Ltd does not warrant 
guarantee or make any representations regarding the use, or the 
results of the use, of the Software in terms of accuracy reliability 
currentness or otherwise. You assume the entire risk arising out 
of the use or performance of the Software.
6.3 No oral or written information or advice given by iView Multi-
media Ltd its distributors or employees shall create any warranty 
and You may not rely on any such information or advice.

7 NO OTHER WARRANTIES
7.1 To the fullest extent permitted by applicable law, iView Multi-
media Ltd disclaims all other warranties and conditions in respect 
of the software either express or implied, including but not limited 
to any implied warranties of merchantability, non-infringement of 
third party rights and fitness for particular purpose. The duration 
of any statutorily required warranty period shall be limited to the 
term of the limited warranty set out above. You use the software 
entirely at your own risk.

8 EXCLUSION OF LIABILITY FOR CONSEQUENTIAL LOSS
8.1 Under no circumstances shall iView Multimedia Ltd or anyone 
else who has been involved in the creation, production, or deliv-
ery of the software be liable for any consequential or incidental 
damages whatsoever arising out of your use of or your inability 
to use the software, including without limitation, damages for loss 
of business profits, business interruption, loss of business infor-
mation, computer failure, work stoppage or any other damages, 
even if iView Multimedia Ltd has been advised of the possibility 
of such damages.

9 EXCLUSIVE REMEDY
9.1 The exclusive remedy for breach of this Agreement by iView 

Multimedia Ltd shall be, at iView Multimedia Ltd’s option, either:
9.1.1 the repair or replacement of the Software PROVIDED THAT 
the Software is returned to iView Multimedia Ltd with proof of 
License; or
9.1.2 a refund of the price, if any, which You paid to license the 
Software.

10 LIMITATION ON LIABILITY
10.1 iView Multimedia Ltd’s liability to you in contract or tort shall 
in no event exceed the actual price paid for the software or £5 
(five pounds sterling) whichever is the greater.

11 TERMINATION
11.1 In the event that You fail to comply strictly with the terms 
and conditions of this Agreement, this Agreement shall terminate 
forthwith without prejudice to any other remedies which iView 
Multimedia Ltd may have.
11.2 In the event that You wish to terminate this License agree-
ment You may do so at any time by ceasing to use the Software.
11.3 You hereby agree that, in the event of termination of this 
Agreement for any reason, You will forthwith destroy or irretriev-
ably delete all copies of the Software, including modified copies, 
in Your possession or control.

1� UPDATE POLICY
12.1 iView Multimedia Ltd may from time to time create updat-
ed versions of the Software and may, at its option, make such 
updates available to You.

1� GENERAL TERMS
13.1 Irrespective of the country in which the Software was acquired 
the construction, validity and performance of this Agreement shall 
be governed in all respects by English law and You agree to submit 
to the exclusive jurisdiction of the English courts.
13.2 If any provision of this agreement is found to be invalid by 
any court having competent jurisdiction, the invalidity of such 
provision shall not affect the validity of the remaining provisions 
of this agreement, which shall remain in full force and effect.
13.3 No waiver of any term of this agreement shall be deemed a 
further or continuing waiver of such term or any other term.
13.4 This agreement constitutes the entire agreement between 
You and iView Multimedia Ltd with respect to this transaction. 
Any changes to this agreement must be made in writing, signed 
by an authorised representative of iView Multimedia Ltd.

Should You have any questions concerning this Agreement, 
or if You desire to contact iView Multimedia for any reason, please 
write to: iView Multimedia Ltd,  30-40 Elcho Street, London, 
SW11 4AU, U.K.  Tel ++44 20 7223 8691; Fax: ++44 20 7223 8712 
Email: info@iview-multimedia.com. For ordering information, visit 
our Web site at: http://www.iview-multimedia.com.

iView MediaPro End-User License Agreement cont.
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